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Copyright © 2023 Telestream, LLC and its Affiliates. All rights reserved. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without written permission of Telestream, LLC. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream. Specifications subject to change 
without notice.

Telestream, Aurora, CaptionMaker, CaptureVU, Cerify, Content Manager, 
ContentCentral, Cricket, DIVA, DIVAdirector, DIVADocs, DIVAGrid, DIVANet, DIVAProtect, 
DIVASolutions, Episode, Encoding Intelligence, Episode, FLEXVU, Flip4Mac, FlipFactory, 
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reserved.
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MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 
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PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
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EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012|Server 2016|Server 2019|Server 2022, Windows 7, Windows 8, Windows 
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NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT 
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may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
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CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.
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Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 



Lightspeed Live Capture User Guide 5

Lightspeed Live Capture User Guide

ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
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neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: FCC Class A, EN 55022 Class A, EN 61000-3-2/-3-3, CISPR 22 
Class A

Electromagnetic Immunity: EN 55024/CISPR 24, (EN 61000-4-2, EN 61000-4-3, EN 
61000-4-4, EN 61000-4-5, EN 61000-4-6, EN 61000-4-8, EN 61000-4-11)

Safety: CSA/EN/IEC/UL 60950-1 Compliant, UL or CSA Listed (USA and Canada), CE 
Marking (Europe)
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California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.

Obtaining Support | Information | Assistance
Contact Telestream for support, information or assistance, as indicated below.

Resource Contact Information

Lightspeed Live Support Website: telestream.net/telestream-support/lightspeed-
live/support.htm 

Support Portal: https://support.telestream.net

Support Email. support@telestream.net

US Phone: 877-257-6245

International Phone: +1 530-470-2036

Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

All Licensing Website: telestream.net/telestream-support/lightspeed-
live/support.htm

License Email: license@telestream.net

Lightspeed Live 
Information | Assistance | 
FAQ | Forums | Upgrades

Website: telestream.net/telestream-support/lightspeed-
live/support.htm 

Support Email: support@telestream.net

Telestream, generally Website: telestream.net

Sales and Marketing Email: info@telestream.net

Telestream Reseller 
Support

If you purchased your product from a reseller, please 
contact your reseller for support.

International Reseller 
Support

Website: telestream.net

See the website for your regional authorized Telestream 
reseller.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document or other Telestream documents—or if 
you've discovered an error or omission, please email us.

https://www.telestream.net/telestream-support/lightspeed-live/support.htm
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
mailto:support@telestream.net
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
mailto:license@telestream.net
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
https://www.telestream.net/telestream-support/lightspeed-live/support.htm
mailto:support@telestream.net
http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
https://support.telestream.net
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Return Material Authorization (RMA) Procedure
If your Lightspeed Live Server requires service of any kind, regardless of whether you 
purchased the Lightspeed Live Server from Telestream or an authorized reseller, 
contact Telestream directly for a Return Material Authorization (RMA).

Caution: Except for the modular power supplies and disk drives, the Lightspeed 
Live Server is a sealed device, with no user serviceable parts inside. You should 
never open the top cover or attempt to upgrade or alter the server. Doing so 
exposes you to electrical hazard, may damage the unit, and may invalidate your 
warranty.

Please contact Telestream for all internal service of the server: 

• Email: support@telestream.net

• In the US, telephone: 1-877-257-6245

• From international locations, telephone: 1-530-470-2036.

Provide your organization name, and contact information, the serial number of the 
inoperative unit, and request a Return Material Authorization.

Before returning your Lightspeed Live Server, back up the entire contents of all server 
drives to protect against data loss. See Backing up a Lightspeed Live Server for details.

mailto://support@telestream.net
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LIve Capture User’s Guide

Introduction

Telestream’s Live Capture is an enterprise-class system hosted on a Lightspeed Live 
Server platform or a VM | cloud platform to deliver real-time, enterprise-class live and 
tape-based media capture for media and entertainment companies, corporations, 
government agencies, and educational facilities. 

Telestream recommends that you read this chapter first, to become familiar with Live 
Capture Servers and Live Capture, including licensing and platform specifications.

To install a Lightspeed Live Server in your facility, refer to Installing & Managing Your 
Lightspeed Live Server. You can also use this chapter to manage and monitor your 
servers.

Finally, turn to Configuring Vantage and Updating Live Capture to configure your Live 
Capture system and start capturing video. The Up and Running Checklist describes the 
initial Vantage configuration tasks you should complete first. 

Note: This guide uses different terms when referring to Live Capture platforms: The 
term Lightspeed Live Server refers to Telestream’s high-performance Windows server, 
whose components are selected specifically to host Live Capture. The term Live 
Capture server refers more broadly on any supported platform hosting Live Capture: A 
Lightspeed Live Server, or a VM | cloud platform.

Topics
■ Live Capture Overview

■ Live Capture Web Apps

■ Live Application Program Interfaces

■ Live Capture Single Server Licensing

■ Licensing a Live Capture Array

■ Lightspeed Live Server Overview

■ Lightspeed Live Server Specifications

■ Live Capture VM Server Requirements
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Live Capture Overview
Designed for demanding, enterprise-class broadcast and professional video capture 
applications, Telestream’s Live Capture offers premium features and exceptional 
performance. Live Capture excels at performing demanding video ingest from similar 
or mixed format sources, while simultaneously creating multiple high resolution and 
proxy files from any of its inputs.

Live Capture is flexible and scalable. Based on Lightspeed Live Server capabilities, Live 
Capture supports up to eight 3G HD-SDI inputs with active loop through for 
monitoring, or up to two UHD/4K inputs with active loop through for monitoring. 
When equipped with 12G SDI, it supports two HD SDI or UHD/4K inputs, but does not 
support active loop through.

Live Capture also supports IP sources—RTMP, MPEG2 Transport Stream, NDI, and SRT—
and ST 2110 (via text / HTML SDP files or NMOS)—when the Lightspeed Live Server is 
equipped with a 25/100Gb Ethernet NIC.

Lightspeed Live Capture is capable of capturing up to eight concurrent HD streams in 
select formats and codecs and two UHD/4K formats in select formats and codecs. Live 
Capture processes video in 16-bit space to preserve source quality and encodes it in 
multiple video formats, simultaneously creating high-resolution mezzanine H.264/AVC 
proxy files. Files are written directly to the Live Capture server’s local RAID storage or to 
external shared NAS | SAN storage, or AWS S3 Cloud storage.

Lightspeed Live Capture is configured, operated, and controlled via the Live Capture 
and Tape Capture Web apps, and several Live Application Program Interfaces are 
provided for integration and control by other systems. Optional editing, scheduling 
and SDI routing control via RouteMaster, and live playback web apps are also provided.

8 x SD/HD/3G SDI

2 x UHD/4K 3G SDI

4 x UHD/4K 12G SDI

On-Premises VM Lightspeed Live Server

Cloud VM Lightspeed Live Server

DAMs, SANs,

NAS & Archives

Editing Workflows:

Adobe | Apple | AVID
(Interplay Compatible)

TS | RTMP 

SRT | NDI | ST2110
Broadcast | Playout Servers

Live Feeds

VTR | Server

Cameras

LightSpeed Live Server

FTP | S3 | AsperaManual &

Scheduled

Recording

Log &

Capture

Live Play

Source

Manager

Live

Schedule Web 

Service 

API

IP Sources

SDI Sources - Lightspeed Live Server Only

On-Premises VM Lightspeed Live See Sed L

Cloud VM Lightspeed Live SeSe

LightSpeed Live Server
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More Choices, More Flexibility
Live Capture offers a variety of methods to ingest video: 24/7/365 scheduled recording 
of live feeds, RS-422-controlled VTR tape capture, manual recording including gang 
control, DAI (SCTE-104) triggering (headless; no operator intervention), recurring 
segment creation, and automated control through a simple Web Service REST API. 

Live Capture encodes captured video into MXF OP1a, QuickTime or Telestream TIFO 
format. To maintain closed captions and other ancillary data, Live Capture preserves it 
in MXF, QuickTime, TIFO and Avid proprietary containers.

Media Platform Friendly
Live Capture creates growing files that directly support a wide variety of 3rd party 
Media Asset Management (MAM) and Non Linear Edit (NLE) solutions including Avid 
Media Central Production Management, Avid Media Composer, Adobe Premiere, 
DaVinci Resolve, and Apple Final Cut Pro.

Fast, Parallel Open Media Processing
As a standalone system, Live Capture acquires SDI video from independent input 
channels or through IP connections. You can join multiple Live Capture servers 
together to create a Live Capture array under a common control interface. In addition, 
Live Capture is integrated directly with Vantage, enabling unlimited workflow 
possibilities via Vantage’s Telestream Media Framework.

Live Capture workflows support Open workflows. Open workflows enable transcoding, 
packaging, and deployment to occur in real time in Vantage, as the media is being 
captured. These advanced media processing workflows complete within seconds 
following the end of media capture.

You can also deliver Live Capture proxy (secondary) output in HLS | DASH format to 
Amazon S3 storage during file generation by the Capture action with a Push action 
immediately following, executing in Open mode.

File-Based Transcoding on Live Capture Servers
File-based transcoding directly on Live Capture servers is an optional, separately 
licensed feature. Transcoding options enable Vantage file-based transcoding when not 
in use capturing media, enabling you to utilize your Live Capture server for both live 
video capture and traditional file-based transcoding.

Note: Live Capture is integrated with Vantage Telestream Media Framework for 
ingesting live, live-linear and tape-based media for serializing media into files for 
processing in production, post-production and broadcast workflows. In the context of 
this guide, it is simply referred to as Vantage. 
If you are performing concurrent ingest and encoding—using Open Workflows 
(Transcode while Ingest workflows)—you must perform transcoding workflows on a 
separate Vantage server, not on the Live Capture Server where ingest is executing.
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When you’re ready to get started, proceed to the Up and Running Checklist.
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Live Capture Web Apps
Live Capture includes several client programs implemented as Web apps:

• Live Capture—The Live Capture Web app (Capturing Live Video) is implemented by 
the Telestream Live Service and enables you to capture live video streams from SDI 
or from IP-based sources, and save them as files.

• Tape Capture—For tape-based media, the Tape Capture web application (Capturing 
Tape Media), which is implemented by the Telestream Live Service, enables you to 
capture tape-based media, typically in conjunction with a VTR.

• Live Schedule Pro—Live Schedule Pro is an optional, separately licensed feature for 
automating 24x7 capture events using a calendar interface, and includes Route-
Master for SDI router control.

Live Schedule Pro is implemented in the Telestream Schedule Service, and enables 
you to create recording events you want captured for each source, and automati-
cally starts and stops capturing video on an event-by-event basis, with optional SDI 
router control. Live Schedule Pro has a separate installer and is installed inde-
pendently of other web apps.

• Live Play—Live Play is an optional, separately licensed product. The Live Play web 
app, implemented in the Telestream Playlist Service, is an enterprise-class software 
solution that provides flexible and scalable SDI video playback on Telestream’s 
Lightspeed Live Server. 

• Source Manager—Source Manager (Managing Video Sources), implemented in the 
Telestream Live Source Service, enables you to create, configure, and manage all of 
your video source inputs from a central web app.

• Group Portal—The Group Portal web app (User Administration) and also utilizes the 
Telestream Live Source Service. It enables you to create users with specific privileges 
for managing or monitoring servers in an array according to typical roles.

Live Capture is supported by these Telestream services:

• Telestream Live Source Service

• Telestream Cloud Service

• Telestream Schedule Service (when Live Schedule Pro is installed)

• Telestream RouteMaster Service (when Live Schedule Pro is installed)

The Vantage domain installed on a Live Capture Server includes these programs:

• Vantage Management Console

• Vantage Workflow Designer

• Vantage Workflow Portal

A Vantage domain for Live Capture also includes these Windows services:

• Vantage Analysis Service (requires optional licensing)

• Vantage Avid Service (requires optional licensing)

• Vantage Communicate Service
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• Vantage Live Service

• Vantage Metadata Service (requires optional licensing)

• Vantage Metric Service

• Vantage Monitor Service

• Vantage Signiant Service (requires optional licensing)

• Vantage SDK Service

• Vantage Transcode Service (requires optional licensing)

• Vantage Transport Service

You can’t install or execute other Vantage or Telestream services on a Live Capture 
Server without a specific license.
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Live Application Program Interfaces
These APIs enable you to monitor and control your Live Capture system within a 
broader, web services-based system or create your own customized monitoring 
system. You can also submit and monitor capture jobs in Vantage using the Vantage 
API.

■ Vantage API

■ Live Source API

■ Live Capture API

You can also create a web services-based system to control capture operations beyond 
the functionality or capability of Telestream’s Live Capture web applications, to meet 
your organization’s requirements.

Vantage API
The Vantage API is required for any workflow integration, in addition to other APIs you 
may require.

Vantage provides an SDK to expose the REST API, which is designed to enable third-
party programs to submit jobs to Vantage workflows, monitor and manage jobs, and 
access job’s metadata and their files, and perform other tasks in Vantage. The Vantage 
API is language independent and supports the use of REST, SOAP or WCF protocols.

The Vantage API Reference is published on the Telestream web site for registered 
Vantage users.

Live Source API
You can use the Live Source REST API for creating and configuring SDI and IP sources for 
use in Live Capture via an external program / system. The Live Capture API is 
implemented in the Telestream Live Source Service.

The Live Source API is described at 
http://<Server>|localhost:15000/help/index.html
where <Server> is the host name of the Live Capture server or keyword localhost when 
accessed locally.

Live Capture API
The Live Capture REST API enables you to automate and control Live Capture servers 
via an external program/system. The Live Capture API is implemented in the Vantage 
Live Service.

The Live Capture API is described at 
http://<Server>:17000 | 19000 | <Capture Action Port>/swagger/
help/index.html
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where <Server> is the host name of the Live Capture server or keyword localhost when 
accessed locally.

The default port for Web Service triggers is 17000; the default port for Recurring 
Segment triggers is 19000. The port number may change, based on the port number 
specified in the target workflow’s Capture action. If you are using multiple Capture 
workflows, you should configure each with a different port.
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Live Capture Single Server Licensing
This topic describes required and optional licenses for a single-server Live Capture 
system for all models of Lightspeed Live servers, as well as Live Capture installed on a 
VM | cloud platform.

To obtain licenses or obtain licensing information or assistance, see Obtaining Support | 
Information | Assistance.

Note: License files may contain one or more license policies, and there may more 
than one license file in a Vantage domain. The number of license files is immaterial; 
only the license policies within the file(s) are relevant. License installation is described 
in the Domain Management Guide.

You add Live Capture license files to the Vantage domain, where the license policies are 
extracted from the file(s) and stored in the Vantage database for utilization. 

You use the Vantage Management Console to add, view, and manage licenses. See the 
Vantage Domain Management Guide, which is available directly in the console, for 
assistance.

Required Live Capture License
A Live Capture license is required for all Live Capture systems.

Optional Live Capture Licenses
• Basic Single File Analysis (LSL-ANLZ-SW)—includes single-file analysis for curtains, 

letter-boxing, Telecine, black detection, slate/spot detection, macro-blocking, loud-
ness measurement with dialog detection and gating controls for compliance with 
CALM Act, ATSC A/85, BS-1770-2 and EBU R128, and more. Includes PSNR measure-
ment for two-file QC analysis. Does not include first year of Software Annual Main-
tenance and Support which must be ordered at time of purchase. Refer to 
Maintenance section for more information. Intended for use on Live Capture sys-
tems while no ingests are being performed.

• Extended Single File Analysis (LSL-ANLYZ-PRO-SW)—Includes all capabilities of 
Basic Single File Analysis, with additional capabilities for Dolby Atmos audio loud-
ness, Dolby Vision metadata extraction, Dolby E audio detection and analysis, com-
pliance checking, PDF reporting, and integration with MediaInfo for extended 
media properties. Intended for use on Live Capture system while no ingests are 
being performed.

• JPEG2000 codec option for Live Capture (LS-LIVE-CAP-J2K)—enables JPEG2000 SD/
HD recording up to 1080p60.

• MPEG2-TS with Manzanita Option for Live Capture (LS-LIVE-TS-OPTION)—providing 
support for MPEG2 Transport Stream container with Manzanita multiplexing. Sup-
ports Live Capture's MPEG-2 and x264 video codecs.
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• Avid Integration (LS-LIVE-AVID-OPT)—enables the creation of Avid-compatible 
MXF OPAtom and AAF media files for use directly in a standalone Media Composer 
edit system, or written in real time to Avid shared storage and checked-in into Avid 
Interplay. This option is available only for standalone or multiple channel Live Cap-
ture systems. Live Capture servers that are integrated into Vantage domains use the 
Vantage Avid Interplay Option (V-AVID).

• Vantage Metadata Conversion (V-METADATA-SW)—enables ability to transform 
XML files, create or populate metadata labels, and perform Web Services notifica-
tion in Web Services notification, Populate, Transform, Extract, Gather and Archive 
actions.

• Array Pro upgrade for Capture (LSL-ARRAY-PRO-UPG)—matches the Array Pro 
license for connection to Vantage since you can’t mix regular Array with Array Pro 
on Vantage domains. This allows Open Workflows that include Capture but start 
with Watch and Receive origin actions. This is required for workflows that update 
other systems using a typical Receive workflow—Receive > Populate > Notify. For 
example, Avid Interplay metadata and Edit While Capture in Media Creation 2022.2 
and later.

• Vantage Transcode (V-XCODE-SW)—includes Vantage Workflow Designer, SD & HD 
New Media, Edit, H.264 and MPEG-2 Transcoding Format support, FTP/Network 
folder workflow support, Enhanced Video Processing.

• Vantage Transcode Pro (V-XCPRO-SW)—includes Vantage Workflow Designer, SD & 
HD New Media, Edit, H.264 and MPEG-2, Broadcast Server and MXF transcoding for-
mat support, and FTP/Network folder workflow support. Allows creation of AAF 
files for Media Composer (without Interplay).

Live Capture Software Licensing
Live Capture Software Edition is hosted on a VM, and requires a Live Capture Single 
Channel license. It enables these features:

• Open workflow support in Vantage

• One active workflow per license for one concurrent capture channel.

Use of a Live Capture Single Channel license imposes these limitations:

• GPU (NVIDIA-based) encoding is not supported on CPU-only systems.

• Comprimato JPEG2000 encoding requires an additional license. (Comprimato 
JPEG2000 encoding typically requires higher capacity than other encoding.)

• If a single license is active, but multiple Capture workflows are active, you can not 
start a capture operation.

• Pass-through GPUs are supported, but not required. 
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Licensing a Live Capture Array
Note: License files may contain one or more license policies, and there may more 
than one license file in a Vantage domain. The number of license files is immaterial; 
only the license policies within the file(s) are relevant. License installation is described 
in the Domain Management Guide.

License files are added to the Vantage domain, where the license policies are extracted 
from the file(s) and stored in the Vantage database for utilization. You use the Vantage 
Management Console to add, view, and manage licenses.

• A Live Capture Software Ingest license includes a Vantage array license—one 
license per server. 

• All Vantage servers joined together with Live Capture servers also require an array 
license for each Vantage server. If you have a stand-alone Vantage domain and are 
joining it to a separate Capture server—creating an array, you require an array 
license for it.

The following examples illustrate the requirements for licensing Vantage domains 
including Live Capture servers, except for those systems purchased as a single server.

Single Server Vantage Domain Adding Live Capture
A single server Vantage domain is being joined to a Live Capture server—this requires 
two array licenses. For this system you order a single-server array license for the 
Vantage server. You receive a license file containing array licenses for both servers; one 
for the Vantage server and one for your Live Capture servers.

New Vantage Arrays Including Live Capture
Example 1: A new system consisting of two Live Capture servers and two Vantage 
servers in an array requires four array licenses. For this system you order a two-server 
array license for the Vantage servers. You receive a license file containing array licenses 
for all four servers; two for the Vantage servers and two included with your Live Capture 
servers.

Example 2: A new system consisting of five Live Capture servers and three Vantage 
servers in a Vantage array requires eight array licenses. For this system you order a 
three-array license for the Vantage servers. You receive a license file containing array 
licenses for all eight servers; three for the Vantage servers and five for your Live Capture 
servers.

Existing Vantage Arrays When Adding Live Capture
Example: You are adding Live Capture servers to an existing Vantage domain that 
already has array licensing. Thus, no additional array licensing is required. However, you 
should update the existing Vantage license file to include the additional Live Capture 
server.
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In a mixed Vantage/Capture array, you can’t host Transcoding services on the Capture 
servers, or failures of Capture jobs and other, non-capture Vantage jobs will occur. 
Remove the Vantage Transcode service from Live Capture servers via the Vantage 
Management Console. 
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Lightspeed Live Server Overview
Telestream’s Lightspeed Live Server (see Lightspeed Live Server Specifications), is a high-
performance, high-capacity Windows platform, specifically configured as a media 
processing platform to host Live Capture and Live Stream. Telestream offers several 
models of Lightspeed Live servers—in four and eight port configurations—to meet 
application demands and provide improved performance as technology improves.

As of this publication, Telestream offers the C2+, C4 and C5 models. Other models are 
supported, but are no longer available.

Note: The Lightspeed Live Server and Lightspeed Server are different hardware 
platforms. Lightspeed Live Server hosts Telestream’s Live products, including Live 
Capture; Lightspeed Server hosts Vantage domains.

User guides and other documentation are provided on flash drive. The same guides are 
also published on the Telestream web site.

https://www.telestream.net
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Lightspeed Live Server Specifications
This table summarizes the Lightspeed Live Server platform’s major features.

Components Description

Operating System Windows Server 2016 | 2019

RAM ECC DDR4 (speed and amount vary by model)

CPU Dual Multi-Core CPUs

GPU 1 GPU

OS Drives 1 SATA SSD drive for Windows OS (top right-most slot)

1 optional OS SSD drive configured in RAID 1 (bottom right slot)

Storage Drives SATA SSD or SAS hard drives
(capacity quantity and size vary by model)

SAS Controller Supports up to 8 SAS3 or SATA3 media drives

PCIe Option Slot 1 half-height PCIe 3.0 x8 slot or 1 full-height PCIe 3.0 x16 slot 
(model-dependent)
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SDI Video Input/
Output

Gen 1| C2 (Discontinued): One 4-port DIN 1.0/2.3 3G SDI card 
plus LTC port, for four SH/HD or one QuadLink UHD Processor; 
affinities should be balanced, and assigned affinity value 1.

C2+: One 4-port DIN 1.0/2.3 3G SDI card plus LTC port and REF 
synch port, for four SH/HD (2-in and 2-out) or one QuadLink 
UHD Processor.

C3 (Discontinued): One 8-port DIN 1.0/2.3 3G SDI card plus LTC 
port for eight SH/HD or 2 QuadLink UHD. Processor affinities 
should be balanced. With Preferred Processor set to Automatic, 
SDI 1 | 3 | 5 | 7 are assigned affinity value 1 and SDI 2 | 4 | 6 | 8 are 
assigned affinity value 2 to maintain a deterministic balance.

OR

One 4-port BNC video card for 2 12G SDI UHD in and 2 out, REF 
synch port.

C4: One 8-port DIN 1.0/2.3 3G SDI card plus LTC port for eight 
SH/HD or 2 QuadLink UHD. Processor affinities should be 
balanced. With Preferred Processor set to Automatic, SDI 1 | 3 | 5 
| 7 are assigned an affinity value of 1 and SDI 2 | 4 | 6 | 8 are 
assigned an affinity value 2 to maintain a deterministic balance.

OR

One 4-port BNC video card for 2 12G SDI UHD in and 2 out, REF 
synch port.

OR

One dual port Mellanox ConnectX-6 25/100Gb card.

C5: Dual 8-port 3G SDI. One half-height 8-port card and one full-
height 8-port card plus LTC port and REF synch port. Cards are 
bonded together to provide 8 SD/HD or 2 QuadLink UHD in and 
out with confidence monitoring.

C5 cards are identified as 0 and 1, and referenced in web apps 
with both the card number and port, as SDI 0:1 or SDI 1:5 for 
example. All SDI ports are permanently configured in loop 
through mode. SingleLink Loop Thru ports 0:1-0:4 loop to ports 
0:5-0:8 on card 0 and 1:1-1:4 loop to ports 1:5-1:8 on card 1, or 
QuadLink Loop Thru port 0:1 loops to 0:2 and 1:1 to 1:2. 

USB 3.0 2 front plane, 2 back plane USB ports

Ethernet Four 10G Ethernet 10Base-T ports (back plane)

C5: 2 RJ45 1G Ethernet ports (back plane, lower) and 2 x 10Gbe 
SFP+ ports

Components Description
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System Power
The chassis features redundant hot-swappable dual digital power supplies that 
automatically sense the input voltage between 100v to 240v, and operate at that 
voltage. Power cords plug directly into the power supply units at the back of the 
chassis, and the Power On/Off (0/1) button on the front energizes the unit. A green light 
indicates that the power supply is operating. When a power supply fails or is 
disconnected, an amber light on the power supply illuminates and an alarm sounds. 

Drives
The chassis supports up to eight SAS hot-swappable 2.5" disk drives. The drive bays on 
the left (viewed from the front) support SAS3 media drives, four of which are included 
as standard. You can configure these eight storage drives for RAID 0, 1, 5 or 10 (RAID 5 
set at the factory). The two additional bays on the right support only SSD/SATA drives. 
The top right bay is reserved for the Windows OS drive, and the bay below it is available.

When replacing or adding hard drives, replace with exact manufacture and model of 
drive. Drives vary by model; see Obtaining Support | Information | Assistance for details.

Cooling System
The system cooling design features eight 4-cm counter-rotating fans located in the 
middle section of the chassis. Fan speed is controlled by the IPMI system management 
software to respond to fluctuations in system temperature.

Dual air shrouds direct air flow to the CPUs and other components that require cooling. 
The power supply module also includes a cooling fan.

SDI Video Cards
SDI video cards are installed in one or more PCIe card slots.

Ethernet-based 
ST 2110

C2+ | C4: optional 25/100Gb Ethernet NIC with 2 SFP28 ports for 
ST 2110 processing with SMPTE 2022-7 fall-back. 

When installed, you can’t install an SDI video card.

VGA Monitor 1 VGA monitor port

AC Power 2 redundant AC inputs, 100-240 Volts, 4.5-9.5 Amps, 50-60 Hz.

RS-422 4-port RS-422 VTR interface kits (Capture only). Optional, 
purchased separately. See Connecting VTR Systems.

Operating 
Environment

10 degrees C to 35 degrees C, 8-90 percent humidity (non-
condensing)

Components Description
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Note:  For C2+ and C4, an optional, 2-port 25/100Gb Ethernet NIC enables ST 2110 
capture. The C2+ and C4 supports either an SDI card or a 25/100Gb Ethernet card, but 
not both in the same server.

Each of these cards provide one port for analog Linear Time Code (LTC) for use across all 
SDI input signals. As of October, 2022, the 4 and 8-port cards have an added REF synch 
port for synchronized SDI playout (see Making Data and Signal Connections).

• 4-Port 3G SDI Card (C2 | C2+; discontinued)—provides four SingleLink 3G SDI 
ports enabling four SD / HD signals or one QuadLink UHD signal. Provides one LTC 
port. For details, see 4-Port 3G SDI Card (Discontinued).

• 4-Port 12G SDI Card (C4; discontinued)—provides four UHD 12G SDI ports with 
BNC connectors, enabling two UHD input signals and two output signals. Provides 
one LTC port. Active loop through is not supported on a server equipped with a 
12G card. For details, see 4-Port 12G SDI Card (Discontinued).

• 8-Port 3G SDI Card (C4 | C5; discontinued)—provides eight SingleLink 3G SDI 
ports with BNC connectors, enabling eight SD / HD signals or two QuadLink UHD 
signals. Provides one LTC port. For details, see 8-Port 3G SDI Card (Discontinued).

• 8-Port 3G SDI Card with Ref and LTC (C4 | C5)—provides eight SingleLink 3G SDI 
ports with BNC connectors, enabling eight SD / HD signals or two QuadLink UHD 
signals. Provides one LTC port and one REF port. For details, see 8-Port 3G SDI Card 
with Ref and LTC Connectors.

• Dual 8-Port 3G SDI Cards with Ref and LTC (C5)—one half-height, and one full- 
height card, provides sixteen SingleLink 3G SDI ports with BNC connectors across 2 
cards, enabling eight input SD / HD signals and eight output signals or two UHD 
input signals and two output signals. Both cards provide an LTC port; the full-height 
card provides a REF port. For details, see 16-Port (dual 8 port) 3G SDI Cards with Refer-
ence and LTC.

Ethernet Network Interface Cards
On servers C1 through C4, four 10G Ethernet back plane ports are provided for network 
connectivity and video playback.

On the C2+ and C4, an optional 2-port, a Mellanox ConnectX-6 25/100Gb Ethernet NIC 
with Rivermax Media Library for ST 2110 capture may be utilized. In servers equipped 
with this card, SDI cards are not supported.

On the C5, the two bottom Ethernet ports (RJ-45) are 1G ports. The top two Ethernet 
ports (with SFP28 connectors) support 10G Ethernet.
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SDI Source Video Formats
Live Capture supports the following SDI source formats, at indicated frame rates:
 

* Image division and 3G level are detected automatically based on VPID data. If VPID 
data is not present or is incorrect, image division must be manually set. In the Source 
Manager web app, display the Configure Source panel (when Video Mode is specified 
as QuadLink Video) and set Quad Link Image Division to 2SI. See Configuring SDI Sources 
for details.

SDI Input Audio
• S16-channel 24-bit Little Endian SDI embedded, 48 kHz synchronous

Input Reference
• SD/HD—Reference is derived from an internal free-run clock on each SDI input. 

• QuadLink UHD—Reference is derived from SDI 1.

Output Reference
• SD/HD—Reference is derived from internal free run clock or external Bi-Level or Tri-

Level (TLS) reference source. See Using External Reference (REF) for SDI Playout for 
details.

Source Rate 23.98 24 25 29.97 30 50 59.94 60

SD NTSC 525i ■

SD PAL 625I ■

HD 720P ■ ■ ■

HD 1080p ■ ■ ■ ■ ■

HD 1080PsF ■ ■ ■ ■ ■

HD 1080i ■ ■ ■

UHD 3840x2160p
2SI/Square Division

■ * ■ * ■ * ■ * ■ *

UHD 
3840x2160PsF
Square Division

■ ■ ■

UHD 
3840x2160PsF
Square Division

■ * ■ * ■ * ■ * ■ *

4K 4096x2160PsF
Square Division

■ ■ ■
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Note: All 16 channels of audio for UHD are provided on SDI 1 and SDI 5 (model-
dependent). 
Sources in YCbCr 444 or RGB 444 color space are not supported. Only YUV 422 color 
space is supported.

GPU
The on-board GPU accelerates video processing and media creation. Using the GPU in 
combination with Lightspeed Live’s powerful dual CPU processors enables capturing 
media from multiple live sources. 

Expansion Card Slots
Each Lightspeed Live Server provides optional full- or half-height PCIe cards, installed 
by Telestream. 

In order to ensure optimal product performance and warranty coverage, ensure that 
Telestream products are used in accordance with the following product policy. It is 
critical that this policy be adhered to when using add-in cards:

• Add-in card(s) are to be installed by Telestream, or an authorized agent, at or before 
commissioning.

• You can only use Telestream-qualified add-in cards. For the current list, refer to the 
Lightspeed Live Server product sheet on the Telestream.net web site. Using 
untested or unknown add-in cards voids the product warranty.

Note: Except for externally removable power supplies and disk drives, the Lightspeed 
Live Server has no user-serviceable parts. To maintain your warranty, any repair or 
additional PCI card installation and any service inside the sealed top cover must be 
performed by Telestream or an authorized Telestream service technician.

RS-422 VTR Interface Kit Option
The optional RS-422 VTR Interface Kit (4-port and 8-port versions) provides the ability to 
connect up to four or eight VTR units to the Lightspeed Live Server, and allows a VTR to 
be remotely controlled by the Lightspeed Tape Capture web application to facilitate 
conversion of tape-based media into digital video files.

http://www.telestream.net/lightspeed-live/techspecs.htm
http://www.telestream.net
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Front Panel
The Lightspeed Live Server has a removable front bezel. Remove the bezel to access the 
system interface buttons and LEDs, drives, and front USB ports. 

Front Panel Features
The front bezel provides visibility of the system monitoring LED indicators and allows 
pinhole access to the recessed power button. This graphic illustrates the front bezel 
and below, the bays exposed when the bezel is removed:

LEDs (left to right)
• System Overheat | FAN Fail | UID

• Network Activity (NIC1)

• Network Activity (NIC2)

• Hard Drive Activity

• Power

Power On/Off Button

The power button is directly below the LEDs. Press the power button to perform a 
normal power up/power down cycle or a hardware reboot (hold the button down for 4 
seconds). A reboot abnormally terminates connected clients and systems and should 
be done only in the event of an unrecoverable system error. Under normal conditions, 
you should close all web apps and client programs and shut down the Vantage domain 
and log out of Windows before cycling power.

UID Button (hidden)

On Lightspeed Live servers with the bezel shown above, the UID button (which is 
mounted on the front panel immediately to the left of the power button), is hidden by 
the bezel. To utilize the UID button, first remove the bezel. The UID button alternately 
turns on and off the blue front and rear panel UID LED (far left), used to locate a 
particular unit among many units in a rack or server room.

On Lightspeed Live servers utilizing the former bezel, the button is accessible without 
removing the bezel.

LEDs On/Off Button

2 USB 3.0

SSD/SATA OS Drive

2 or 4 drives (model 
dependent)

4 optional bay drives Optional SSD or SATA 
drive bay

UID Button
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USB Ports

Two USB 3.0 ports for general use are located below the LEDs and buttons.

Drives

The top right-most drive bay houses the SSD/SATA Windows OS drive, and the drive 
beneath it is an available SATA drive bay. These drives have their own controller, 
separate from the storage drives.

To the left of the OS drive are 8 SAS media storage drive slots containing the 4 standard 
and 4 optional media drives. These drives are configured for RAID 5 and have their own 
controller separate from the OS drive.

Rear Panel Ports and Connectors
These are the rear panel ports and connectors:

• Two redundant AC power connectors—connect to a 10-amp or greater AC source

• Four 10Base-T Ethernet LAN ports—connect as required to LAN

• C5 only—Two 1G Ethernet LAN Ports and two 10Gbe SFP+ Ethernet ports

• Two USB 3.0 ports—connect as required to keyboard, mouse, or other serial device. 
When used for RS422 VTR control, use of a hub is not permitted.

• One IPMI-dedicated Ethernet port, which should not used for other purposes

• One VGA monitor port

• One COM control port (not used)

• One 3G SDI card with 4 | 8 ports

OR

• One 12G SDI card with 4 ports

OR

• C2+ | C4—One Mellanox ConnectX-6 25/100Gb Ethernet NIC 

• C5 only—Two 3G SDI card with 16 ports total.

Note: On supported servers, one SDI card or one 25/100Gb NIC is permitted—SDI 
and Ethernet NIC cards can not be installed in the same server.

• One analog LTC port

• One External Ref port on selected cards manufactured after October 2022.

On supported servers, you can order additional factory -installed PCIe cards in the PCIe 
expansion slots. For details of each backplane component/connector, see Making Data 
and Signal Connections.



Introduction
Lightspeed Live Server Specifications

38

LIve Capture User’s Guide

SDI Video Connections
Each Lightspeed Live Server includes one or more of several models of SDI video cards. 
Two cards are supported in Live Capture. For an overview of cards by server, see SDI 
Video Cards.

Note: On a C4 server, you can optionally install a 2-port 25/100Gb Ethernet NIC in 
place of the SDI card.

4-Port 3G SDI Card with Ref and LTC Connectors
The 4-port 3G SDI card has 6 DIN 1.0/2.3 connectors with 6 DIN 1.0/2.3 to BNC adapter 
cables (shown here right side up):

Note: The 4-port SDI card is inserted upside down into the backplane at the bottom 
right corner. Refer to imprinted labels (1 2 3 4) for SDI connection, R for Reference 
cable connection and LTC for LTC cable connection. The RS-422 port is unused.

• 4 SDI Ports (1-4): SD/HD 3G x 1080 video formats; audio 16-channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): TLS reference input

• Linear Time Code (LTC): LTC timecode input

Ref connector

LTC connector
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8-Port 3G SDI Card with Ref and LTC Connectors
The 8-port 3G SDI card has 10 DIN 1.0/2.3 connectors with 10 DIN 1.0/2.3 to BNC 
adapter cables:

 

Note: Refer to imprinted labels (1 through 8) for SDI connection, R for Reference cable 
connection and LTC for LTC cable connection.

• 8 SDI Ports (1-8): SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): TLS reference input

• Linear Time Code (LTC): LTC timecode input

4-Port 3G SDI Card (Discontinued)
The 4-port 3G SDI card has 5 DIN 1.0/2.3 connectors with 5 DIN 1.0/2.3 to BNC adapter 
cables (shown here right side up):

Ref connector

LTC connector

R connector 
for LTC
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Note: The 4-port SDI card is inserted upside down into the rear panel at the bottom 
right corner. Refer to imprinted labels (1 2 3 4) and R for proper cable connection. The 
RS-422 port is unused.

• 4 SDI Ports (1-4): SD/HD 3G x 1080 video formats; audio 16-channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): LTC timecode input

8-Port 3G SDI Card (Discontinued)
The 8-port 3G card has 9 DIN 1.0/2.3 connectors, which you can convert to BNC with the 
included DIN 1.0/2.3-BNC converter cables. For UHD, SDI-1 through SDI-4 and/or SDI-5 
through SDI-8 (model-dependent), you can use BNC connectors to support Ultra HD 
input. 

The UHD signal is QuadLinked—connected to all four ports (SDI-1 through 4 or SDI-5 
through 8 depending on the model). All other resolutions use one port per input:

 

Note: Refer to imprinted labels (1 through 8) and R for proper cable connection.

• 8 SDI Ports (1-8): SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): LTC timecode input

R connector 
for LTC
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4-Port 12G SDI Card (Discontinued)
The 4-port 12G card has 5 BNC connectors:

 

Note: Refer to imprinted labels (1 through 4) and R for proper cable connection.

• 4 SDI Ports (1-4): 12G x UHD1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous for 2 input operation. Active loop-through is not 
supported.

• Input Reference (R): LTC timecode input

R connector 
for LTC
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16-Port (dual 8 port) 3G SDI Cards with Reference and LTC
Two 8-port 3G cards, bonded. Each provides 9 DIN 1.0/2.3 connectors with 9 DIN 1.0/2.3 
to BNC adapter cables and is used for 4 input (1-4) and 4 output (5-8) on each card. LTC 
is provided on both cards; a REF synch port is provided on the full-height card and is 
bonded to the other, use in both cards, for synchronized SDI playout (see Using External 
Reference (REF) for SDI Playout and Making Data and Signal Connections).

In this dual-card implementation, the half-height card in the center bay is referred to as 
card 1 in web apps; card 0 is the full-height card in the right-hand bay.

8-Port 3G SDI Card with LTC

This half-height 8-port 3G card is installed in the top center bay on the C5 server, with 4 
inputs (1-4) and 4 outputs (5-8). It has 9 DIN 1.0/2.3 connectors with 9 DIN 1.0/2.3 to 
BNC adapter cables, plus a 9 DIN 1.0/2.3 connector for LTC:

 

Note: Refer to imprinted labels (1 through 8) and R for proper cable connection.

• 8 SDI Ports: SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI embed-
ded, 48 kHz synchronous. 1-4 in; 5-8 out

• Input Reference (R): Provides LTC timecode input

8-Port 3G SDI Card with LTC and REF

This full-height, 8-port 3G card is installed in the bottom right bay on a C5 server 
manufactured after October, 202, with 4 inputs (1-4) and 4 outputs (5-8). It has 9 DIN 

R connector for LTC
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1.0/2.3 connectors with 9 DIN 1.0/2.3 to BNC adapter cables, plus a 9 DIN 1.0/2.3 
connector for LTC and one for REF:

Note: Refer to imprinted labels (1-8) and R and LTC for proper cable connection.

• 8 SDI Ports (1-8): SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous. 1-4 in; 5-8 out.

• Input Reference (R): LTC timecode input.

• Linear Time Code (LTC): LTC timecode input, bonded to other card.

R connector for LTC
LTC connector for 
timecode reference
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25/100Gb Ethernet Connections
On C2+ and C4 servers, a 25/100Gb Ethernet NIC card may be installed in place of the 
SDI card. It provides support for ST 2110 video, using two ports: 
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Live Capture VM Server Requirements
You can host Live Capture Software-only on supported virtual machine platforms 
which meet the minimum Vantage 0 resource requirements intended for Live Capture 
operation.

Compressed IP sources are supported; hardware-based SDI and ST 2110 sources are not 
supported.

You should qualify your Vantage platform for expected concurrency for your workflow 
configurations before putting the platform into production—monitoring CPU, 
memory, disk throughput and GPU usage (if applicable). A safe operating range is 60 to 
80 percent peak utilization.

Topics
■ General VM Requirements

■ VMWare Server Requirements

■ AWS EC2 Server Requirements

General VM Requirements
In addition to vendor-specific requirements, the VM must be configured to meet the 
general requirements of a VM platform being utilized to host Vantage, as specified in 
the Vantage Virtual Domain Management Guide, which is available at Telestream.net.

Suggested Guidelines
• CPU requirements of 24 core, single or dual socket may be increased as needed for 

more resource intensive scenarios—conducting multiple concurrent recordings, 
UHD capture, or resource-intensive transcoders such as long GOP x264 based 
broadcast formats, or JPEG2000 archival, for example.

• If the VM is a dual socket system but the system is licensed for only one recording 
instance, system CPU resources may be better utilized by disabling the Live source 
channel’s Assign Processor control.

• One Capture action per workflow is allowed.

• Live Capture operates differently on systems without GPU emulation. If a sup-
ported GPU is not detected by the Live Capture installer, AVC- and HEVC-based for-
mats for both primary and secondary outputs are disabled in Capture workflows. 

• To force GPU emulation, select the Enable GPU decoding option during installation. 
The tested GPU is P4000 Quadro with v471.43 drivers on Windows 2019.
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VMWare Server Requirements
VMWare ESXI Enterprise, versions 6.7-8.01 are supported and you can scale it up to four 
concurrent channels per VM. Dedicated, pass-through NVIDIA GPU’s are supported but 
not required for most media formats. 

This table summarizes the requirements of a VMWare platform being utilized to host 
Live Capture for single-channel HD capture.

AWS EC2 Server Requirements
This table summarizes the requirements of an AWS EC2 platform being utilized to host 
Live Capture SW for single-channel HD capture.

Components Description

VMWare VMWare version 6.7, 8.0.1

RAM 16GB minimum; 32 GB+ recommended. 
Vantage consistently uses significant RAM 
for media transcoding. Telestream 
recommends that some or all memory 
resources be dedicated (reserved) in the 
infrastructure system.

OS Volume 6 GB minimum allocated for Vantage service 
installation.

Media Storage RAW Capacity 1TB SSD vmdk or greater

Media RAID Type (default) RAID 0

Ethernet NIC 10GbE suggested

(see https://kb.vmware.com/s/article/
1001805)

1Gb+ low-latency management connectivity 
and access to the Vantage MS SQL database 
instance. Networking infrastructure must 
allow for high-speed access to shared 
storage.

DNS Each instance must be addressable via a 
forward-lookup DNS record matching the 
Windows host name. Virtual instances must 
be reachable via this DNS record within 60 
seconds of instantiation
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Components Description

RAM 96GB. Vantage consistently uses significant 
RAM for media transcoding. Telestream 
recommends that some or all memory 
resources be dedicated (reserved) in the 
infrastructure system.

OS Drive 100GB SSD or greater

Media Storage RAW Capacity 1TB SSD EBS or greater

Media RAID Type (default) RAID 5
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Installing & Managing Your 
Lightspeed Live Server

Lightspeed Live Server models include the C2 (4 port), C2+ with added REF port, C4 (8 
port), and C5 (dual 8-port) models for hosting Live Capture.

Installing your Lightspeed Live Server included mounting it in an equipment rack, 
making video, network and power connections, and configuring it for operation. 
Detailed, step-by-step instructions are presented here for each of these tasks.

Other responsibilities include OS management, maintaining the server, and monitoring 
a Lightspeed Live Server during operation. These topics apply to all server models 
unless otherwise noted.

Note: For Live Capture configuration and management, see Capturing Live Video. For 
Vantage configuration for utilization with Live Capture, see Configuring Vantage and 
Updating Live Capture.

Topics
■ Installing a Lightspeed Live Server

■ Renaming a Lightspeed Live Server

■ Managing the Windows Operating System

■ Maintaining a Lightspeed Live Server

■ Setting NMOS Logging Levels

■ Managing Live Capture Logging



Installing & Managing Your Lightspeed Live Server
Installing a Lightspeed Live Server

50

LIve Capture User’s Guide

Installing a Lightspeed Live Server
This topic provides instructions for unpacking a Lightspeed Live server and installing it 
safely and securely in a computer server rack, and making the required connections.

If you purchased the optional RS422 VTR Interface Kit, you should make plans for co-
installation and VTR connection in the rack in conjunction with the Lightspeed Live 
Server. For complete instructions on installing the RS422 VTR Interface Kit and 
connecting a VTR, see Connecting VTR Systems. 

WARNING: Only trained and qualified personnel should be allowed to install, 
replace, or service this equipment.

Caution: Except for replaceable power supplies and hard drives which may be 
accessed from the outside, the Lightspeed Live Server is a sealed device, with no 
user-serviceable parts or user-accessible expansion slots. You should never open 
the top cover or attempt to upgrade or alter the server. Doing so exposes you to 
electrical hazard, may damage the unit, and may invalidate your warranty. If you 
have hardware or software problems with your Lightspeed Live Server, see 
Obtaining Support | Information | Assistance to obtain service.

Note: Before proceeding, collaborate with your network administrator to determine 
computer and network setting requirements.

■ Unpacking the Server

■ Rack-Mounting Your Lightspeed Live Server

Unpacking the Server
The Lightspeed Live Server arrives packed in a heavy-duty, cardboard box with foam 
padding surrounding the device to protect it. During unpacking, inspect the container 
and the contents for damage. In the event of damage, report it immediately to the 
freight carrier and to Telestream Support.

The server is heavy. Unpack the server on a strong, well-balanced table that can 
support the full weight of the server and shipping container without tipping.

Inside the box are the server, optional components such as rack rails, DIN 1.0/2.3-to-
BNC cables, and printed and flash-drive documentation (a DVD is available by request). 

https://telestream.net/telestream-support/overview.htm
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Rack-Mounting Your Lightspeed Live Server
The Lightspeed Live Server is designed to fit into a standard 19-inch (483 mm) 
equipment rack with support front and rear, using supplied rack rails and rear support 
extensions.

Assembling the Rails
The inner rail extensions install on each side of the chassis as shown.

Align the extension holes with the hooks on the side rail and slide the extension 
forward to engage the hooks until the quick release bracket snaps into place. For added 
stability, you can secure the extension with a screw.

Assemble the outer rails by sliding the front and rear sections together. 
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Installing Outer Rails into the Rack
Next, install the outer rails into the rack as shown in this figure: 

Proceed to the appropriate topic for your rack—round hole or square hole.

Installation in Round Hole Rack

If your rack has round threaded holes, first remove the aluminum block at the end of 
the rail via the 2 screws, as shown here:

1. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack.

2. Extend the rear of the rail to align it with the holes on the rear of the rack (D). 

3. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack. 

Remove these two screws to 
remove the block.
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Installation in Square Hole Rack
1. Align the square pegs on the front of the rail with the square holes in the front of 

the rack (C). 

2. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack.

3. Extend the rear of the rail to align its square pegs with the square holes on the rear 
of the rack (D). 

4. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack. 

Caution: To prevent the server from falling and becoming damaged, be sure the 
rails are solidly in position and ready to support the full weight of the chassis. 
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Installing the Server in the Rack
When selecting a position in a rack to place the server, be sure to allow a minimum of 
30 inches clearance at the back of the server for sufficient cooling airflow and servicing.

To install the server, follow these steps:

1. Slide the inner rail extensions forward into the front of the outer rails.

2. Support the chassis and align the back of the chassis with the front of the rails.

3. Push the chassis backward, sliding it into the rack rails, until the chassis clicks into 
the locked position.

Caution: To prevent the server from falling and becoming damaged, be sure to 
insert it securely in the rack before you remove support.
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Removing the Server from the Rack
To remove the server from the rack, press the outer rail latch shown in the figure above 
to release the chassis.

Slide the chassis forward off the outer rails and out of the chassis.

Making Data and Signal Connections
This topic describes the Lightspeed Live Server data and signal connectors and how to 
connect to them. Follow the order of connections given here, with the server powered 
down, make the following data and signal connections at the back of the server unit:

• Connect input devices (keyboard and mouse) to the USB connectors (optional).

• Connect a monitor to the VGA connector (optional).

• Make built-in Ethernet LAN connections to provide network connectivity.

• If a 25/100Gb Ethernet NIC is installed, connect to your 25/100Gb media LAN via 
SFP28 connectors.

• Connect your server to your IPMI network via the MGMT Ethernet port—Telestream 
strongly encourages using the IPMI interface to your management network for out-
of-band management and troubleshooting.

• Connect SDI video sources to the connectors on the SDI cards using the supplied 
DIN 1.0/2.3-to-BNC SDI cables.

• Optionally, on supported cards, connect an analog LTC timecode source to the con-
nector marked with LTC (rightmost) on the SDI card. This port is configured for Lin-
ear Timecode (LTC) encoded with SMPTE 12M timecode data.

Note: This input is for analog LTC only and is not intended for use as a synch 
reference.

• Optionally, for C2+ | C4 (manufactured beginning October 2022) | C5 servers, con-
nect a REF synch source to the connector marked with an R (leftmost) on the SDI 
card. 

• Optionally, connect the RS422 VTR Interface Kit to a USB port. See Connecting VTR 
Systems. 



Installing & Managing Your Lightspeed Live Server
Installing a Lightspeed Live Server

56

LIve Capture User’s Guide

First-Generation (Gen 1) Rear Panel—4-Port Card (Discontinued)

C2 (Discontinued) | C2+ Rear Panel—2-Port (2 Deactivated) 3G SDI Card

C2+ Video Card Backplane

C2+ Lightspeed Live Servers equipped with Corvid 44, 88, and 12G cards manufactured 
beginning October 2022 have both LTC and Reference input ports on the backplane. 
Visually examine the card’s backplane to verify that your server is so equipped:

This enables you to use Reference input to sync SDI playout and to use the second port 
for LTC when in capture mode.

To utilize Reference in this manner, ensure that you have connected an analog LTC 
timecode source to the BNC connector marked with LTC, and you have connected a CB/
TLS Synch source to the R (leftmost) port on the SDI card.

AC power Connectors

1 PCIe half-height 3.0x8 expansion slot for 
Telestream approved cards only

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM
Unused

LTC

SDI 4-port card

GPU 

4 DIN 1.0/2.3
SDI ports

AC power connectors

SDI 4 port card - 4 DIN 1.0/2.3 - 2 SDI live & 2 
inactive or loop-through outputs

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM LTC
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C3 (Discontinued) | C4 Rear Panel—8-Port 3G SDI Card

C4 Video Card Backplane

Lightspeed Live Servers equipped with Corvid 44 and 88 3G cards manufactured 
beginning October 2022, have both LTC and Reference input ports on the backplane. 
Visually examine the card’s backplane to verify that your server is so equipped:

This enables you to use the standard Reference input to sync all of your SDI outputs and 
enables you to use the second port for LTC when in capture mode.

To utilize Reference in this manner, ensure that you have connected an analog LTC 
timecode source to the BNC connector marked with LTC, and you have connected a CB/
TLS Synch source to the R (leftmost) port on the SDI card.

C4 Rear Panel—4-Port 12G SDI Card

C4 Video Card Backplane

Lightspeed Live Servers equipped with Corvid 44 and 88 3G cards have both LTC and 
Reference input ports on the backplane. Visually examine the card’s backplane to verify 
that your server’s SDI card is so equipped:

AC power connectors

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM LTC

SDI 8-port card - 8 DIN 1.0/2.3 SDI ports

AC Power Connectors

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM LTC

SDI 4-port card - 4 DIN 1.0/2.3 SDI ports
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This enables you to use the standard Reference input to sync all of your SDI outputs and 
enables you to use the second port for LTC when in capture mode.

To utilize Reference in this manner, ensure that you have connected an analog LTC 
timecode source to the BNC connector marked with LTC, and you have connected a CB/
TLS Synch source to the R (leftmost) port on the SDI card.

C3 (Discontinued) | C4 Rear Panel—8-Port 3G SDI Card

C5 Lightspeed Live Server Rear Panel—Dual 8-Port Card Set

In this dual-card implementation, the half-height card in the center bay is referred to as 
card 1 in web apps; card 0 is the full-height card in the right-hand bay.

Power Requirements and Connections
After the server chassis has been physically installed and all data and signal 
connections made, connect the two redundant AC power cords to the back of the 
chassis and to an AC power source. Be certain to observe the following AC power and 
connection requirements and all applicable electrical codes.

The Lightspeed Live Server is rated at 100-240 VAC, 50-60 Hz, up to 10 amps. Take the 
following precautions to ensure a safe power connection:

• Make certain that the power source circuit can supply voltage within the specified 
range and current of at least 10 amps without becoming overloaded. 

• Counted together, the server and other devices connected to the same power 
source must not exceed the total capacity of the power source circuit. 

When power is connected, press the Power On/Off (0/1) button on the front of the 
chassis to turn the server on. To turn power off at any time, press the Power On/Off 
button again.

AC power connectors

4 onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM LTC

SDI 8-port card - 8 DIN 1.0/2.3 SDI ports

AC power connectors

4 onboard Ethernet 
LAN ports—2 10G 
upper; 2 1G lower

IPMI Ethernet port
(dedicated)

2 USB VGACOM

SDI 8-port card - 8 DIN 1.0/2.3 SDI ports

Card 1: SDI 8-port card - 8 DIN 1.0/2.3 
SDI ports with LTC port

Card 0: SDI 8-port card - 8 
DIN 1.0/2.3 SDI ports with 
LTC port and REF port
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Power and General Cautions and Warnings
Observe these precautions when connecting power and operating the server:

Caution: Telestream recommends connecting computer equipment to AC power 
through an uninterruptible power supply (UPS) with surge protection. 
Fluctuations in commercial supply voltage can damage unprotected electronic 
equipment. A high quality surge suppressor may be substituted if a UPS is not 
available, but it may not provide adequate electrical spike protection.

WARNING: Only trained and qualified personnel should be allowed to install, 
replace, or service this equipment.

Hazardous high voltage electricity is present on the backplane when the system is 
operating. To prevent possible injury or death, use caution when servicing.

This product relies on the building's installation for short-circuit (over-current) protection. 
Ensure that the protective device is rated not greater than 250 Volts, 20 Amps.

Ensure a proper earth ground connection to the ground conductor in the AC power plug. 
Failure to do so could present a severe electric shock hazard that could result in injury or 
death.

When installing the product, use the provided or designated connection power cables. 
Using any other cables could cause a malfunction or a fire. 

The fans might still be spinning when you remove the replaceable power supply from the 
chassis. Keep fingers, screwdrivers, and other objects away from openings in the housing.

Power supplies and other components can get very hot. Use caution when touching 
possibly hot components during operation and directly after unplugging.

This unit has two power supply connections. Both connections must be removed to 
completely de-energize the unit.
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Renaming a Lightspeed Live Server
Lightspeed Live Capture is a special implementation of Vantage, and the Vantage 
domain/array name is always the same as the host name of the server (or the server 
that hosts the Vantage domain database in an array).

When Windows is installed, it automatically names the computer with a random name, 
beginning with WIN- and a series of alphanumeric characters. For example: WIN-
S08Kh3N2EHG. To rename your Lightspeed Live Server, complete these tasks to ensure 
that the Vantage database is also updated with the new name:

Note: The name must be 15 character or less.

To complete this procedure, your Windows user must have permission to rename the 
computer, or you must get assistance from your Windows administrator. 

Be sure to schedule renaming during a maintenance window when no jobs are 
running, as renaming the Vantage domain interrupts all Vantage services in the domain 
(During a rename, Windows services on the server are automatically renamed as well).

To rename a Lightspeed Live server, follow the steps outlined in the Vantage Domain 
Management Guide > Renaming a Vantage Domain. 
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Managing the Windows Operating System
Windows Server 2019 is installed on C2+, C4, and C5 Lightspeed Live Servers 
manufactured beginning February 2022. Windows Server 2016 may be optionally 
installed, at the request of the customer.

See microsoft.com for OS specifications.

Topics
■ Activating Windows with the Microsoft Activation Key

■ Applying Microsoft Updates

■ Default Windows User ID and Password

■ Web App Ports and Windows Firewall Settings

Activating Windows with the Microsoft Activation Key
A sticker on the top surface of the Lightspeed Live Server lists license numbers. The 
Physical Key number is the OEM license number for Microsoft Windows. If you re-install 
the OS, use this key to activate Windows again. The key contains five groups of five 
digits each. For example: YFG8H-TDD97-6BR4G-F88PF-XPF45J.

Applying Microsoft Updates
The Lightspeed Live Server ships with the Windows operating system set to check for 
updates, but it does not automatically download or install them. Downloading and 
installation of critical operating system updates is the responsibility of each customer 
(see your system administrator).

Default Windows User ID and Password
When the Lightspeed Live Server starts, log in with this Windows user account:
:

Web App Ports and Windows Firewall Settings
The Lightspeed Live web applications use certain TCP ports that should not be blocked. 
These web apps use the following ports by default; some of which you can change:

• Live Capture—port 8083, 8084, and 8086.
By default, selects any available port between 1024 and 65534 for the web app’s 
Live Preview display. 

• Tape Capture—port 8086

User Administrator

Password telestream!1

https://microsoft.com


Installing & Managing Your Lightspeed Live Server
Managing the Windows Operating System

62

LIve Capture User’s Guide

• Source Manager—port 8090

• Live Schedule Pro—port 443 and 6500

• RouteMaster—port 7777

• NDI Access Discovery—port 5960.

If you use Windows Firewall, be sure these ports are open on the Lightspeed Live Server 
and across your network.

Note: For a complete list of Vantage ports that are used and should not be blocked, 
see the Vantage Domain Management Guide > Port Requirements.

To open the Windows Firewall on the Lightspeed Live Server or other Windows 
computer, go to Start > Control Panel > Windows Firewall > Allow a program or feature 
through Windows Firewall > Allow another program.

Scroll through the list of programs, and click Add for each of these: 

• Lightspeed Live Capture

• Source Manager

• Vantage Management Console | Vantage Workflow Designer | Vantage Workflow 
Portal (Capture only) 

Click OK to close the programs list. The added programs display in the firewall list and 
you can check which networks they can use. Then close the Control Panel.
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Maintaining a Lightspeed Live Server
These topics describes common server maintenance tasks that you may need to 
perform from time to time.

■ Performance Tuning a Lightspeed Live Server

■ Setting Your NVIDIA GPU to TCC Mode

■ Backing up a Lightspeed Live Server

■ Managing and Monitoring Lightspeed Live Servers

■ Installing New or Replacement Media Hard Drives

■ Rebuilding the Lightspeed Live Storage RAID

■ Replacing a Power Supply
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Performance Tuning a Lightspeed Live Server
The following configurations are set at the factory to ensure best performance of your 
Lightspeed Live Server. The settings are supplied here in the event they have been 
changed and you want to restore them to their original factory settings. (For details, 
consult your System Administrator or a Telestream Field Sales Engineer).

1. In Performance Options, set these Windows Performance options:

a. Navigate to Start > Control Panel > System > Advanced system settings > 
Settings button > Visual Effects tab.

b. Check Adjust for best performance.



Installing & Managing Your Lightspeed Live Server
Maintaining a Lightspeed Live Server

65

LIve Capture User’s Guide

c. Select the Advanced tab.
d. Check Background services for Vantage transcoding service nodes and the 

domain’s Microsoft SQL database node. Select Programs for editorial systems and 
Vantage client applications that are not running other Vantage services. 

e. Select the Data Execution Prevention tab:
f. Check Turn on DEP (Data Execution Prevention) for essential Windows programs 

and services only.

g. Click OK in both dialogs to save your changes.
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2. Set User Account Control (UAC):

a.  Navigate to Start > Control Panel > User Accounts > Change User Account 
Control Settings. Set as low as safely possible, considering your exposure to 
Internet viruses and malware. Click OK to save your changes.

3. Set Power Options to High Performance with Sleep disabled:

a. Navigate to Start > Control Panel > Power Options.
b. Check the High Performance plan. 
c. Check Change plan settings, and set Turn off the display to Never. 
d. Check Change advanced power settings, and set all critical functions so that they 

are always ON (this usually means setting them to never turn off ). Click OK to save 
your changes and close the dialog.

e. Click Save Changes on the Edit Plan Settings window.

4. Disable (turn OFF) any real-time software applications and processes, such as the 
following, that could adversely affect disk I/O performance or use excessive CPU: 

– Real-time virus scanning of media files as they are being captured.

– Automatic software updates that can preempt real-time services.

– Real-time file indexing.

5. Disable all unnecessary Windows services in Start > Control Panel > Administrative 
Tools > Services (consult your System Administrator).

6. Turn OFF all firewalls (including third party firewalls) and packet filtering, which 
may cause unpredictable performance:

a. Navigate to Start > Control Panel > Windows Firewall > Turn Windows Firewall on 
or off, select Turn off Windows Firewall.

If you choose to use firewalls, open them for the applications installed on the Light-
speed Live Server.

7. You may increase network throughput by increasing buffer size in your network 
adapter. Set your Network Adapter’s transmit and receive buffers to 1024:

a. Navigate to Start > Control Panel > Network and Sharing Center > Change 
Adapter Settings > Local Area Connection > Right-click and select Properties.

8. Disable any screen savers:

a. Navigate to Start > Control Panel > Personalization > Screen Saver and select 
(None).

9. Disable disk indexing:

a. Right click on Start and select Disk Management from the pop-up menu. 
b. Right-click each disk and select Properties. 
c. In the General tab uncheck Allow files on this drive to have contents indexed in 

addition to file properties, unless you want some drives to be indexed.
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Setting Your NVIDIA GPU to TCC Mode
The NVIDIA GPU on Lightspeed Live servers must run in TCC mode, as opposed to 
default WDDM mode: The NVIDIA GPU in TCC mode disables Windows graphics and is 
used in headless configurations, whereas WDDM mode is required for Windows 
graphics. 

When you update the NVIDIA driver, you must reset it to TCC mode to operate properly.

You can run a script to set TCC mode. The script is in the current version’s folder. For 
example: C:\V3.4-CP8.0.1-UP4-Live3.4\Installers\Nvidia\P4000 Win 
2012.

Alternatively, perform the task manually—follow these steps: 

1. Open a Command window and execute vnvidia-smi:
cd C:\Program Files\NVIDIA Corporation\NVSMI\

nvidia-smi -q

2. nvidia-smi prints the NVSMI Log. 

From the results, verify that the Driver Model indicates WDDM, not TCC. If TCC is 
reported, the mode is correct and you can end this task. 
Provided that WDDM is reported, locate and copy the GPU UUID—for example:
GPU UUID : GPU-4951a582-6b45-cca6-5a1c-a647130d00b1

3. Change the GPU mode to TCC by executing this command:
nvidia-smi -i GPU-4951a582-6b45-cca6-5a1c-a647130d00b1 -dm 1

using the GPU UUID from the previous result.

4. When the driver mode changes to TCC, you’ll be prompted to restart the server.

If you’re not prompted, determine the error and retry.

5. When the server restarts, run cmd.exe and execute this command again to verify 
that the NVIDIA GPU is operating in TCC mode:
cd C:\Program Files\NVIDIA Corporation\NVSMI\

vnvidia-smi -q

TCC mode is set properly, as indicated in the Driver Model section of the log:
Driver Model

     Current : TCC

     Pending : TCC

6. Close CMD and continue return to normal operations.

Backing up a Lightspeed Live Server
In order to protect your Lightspeed Live Server from data loss, Telestream highly 
recommends that you create an image of the Operating System drive (C:\) drive 
immediately upon taking delivery of your server and that you perform periodic back-
ups of all critical data on the server. 
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Third-party disk image products are available (for example, Acronis and Clonezilla) for 
creating a restoration image that you can use to restore the Lightspeed Live Server’s 
operating system drive to its original state. Using programs such as these, along with 
regular backups, you can restore your server back to its original shipping state with all 
of your critical data.

Consult your IT/Systems administrator for details on creating restoration images and 
performing a periodic backup of your Lightspeed server’s critical data.
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Managing and Monitoring Lightspeed Live Servers
IPMI View Management software provides remote network management of your 
Lightspeed Live Servers using IPMI messages over Ethernet LAN or a dedicated IPMI 
LAN. If the Ethernet connectors are used to connect to storage, you can use the IPMI 
LAN connector to create an IPMI network among your servers. 

To download the IPMI View application and user guide, go to this web location: 
supermicro.com/en/solutions/management-software/ipmi-utilities. 

Tasks you can perform using IPMI View include (see IPMI View User’s Guide for details):

• Discover Lightspeed Live Servers on the IPMI network (requires IPMI LAN)

• View system event logs

• Check current sensors and monitor history of fans, voltages, temperature, and 
power supplies

• View firmware revision levels

• Perform various kinds of shutdowns and resets

• Blink the UID LED to locate a particular unit in the rack or server room

• Set fan speed

• Manage LAN configuration, SNMP configuration, and RS232 modem

• Manage users, passwords, and privileges

• Set up paging of users in the event of malfunctions

• Establish Text Console Redirection or KVM Console Video Redirection for remote 
system control via text display or full graphic display

• Access virtual media 

• Set up server management groups

• Update firmware.

For detailed instructions about using any of these system management features, 
consult the IPMI View User’s Guide.

https://supermicro.com/en/solutions/management-software/ipmi-utilities
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Installing New or Replacement Media Hard Drives
Follow these steps to replace a hard drive or install a new one. Drives may be removed 
or replaced with power on. See Drives for new or replacement drive specifications.

1. Remove the front bezel from the chassis.

2. Press the release button on the right front of the drive carrier.

3. Use the drive carrier handle to pull the carrier out of the chassis.

4. Remove the drive or dummy drive from the carrier by removing the four M3 screws 
from the underside of the carrier. Retain the screws.

5. Insert the new drive into the carrier with the PCB side down and the connector 
facing the back of the carrier. 

6. Secure the drive to the carrier with the four M3 screws retained from removal. 
Gently tighten but do not over tighten the screws, which could cause damage.

7. Slide the drive carrier into its bay with the drive facing up until it seats firmly in the 
rear connector.

8. Push the handle closed flat against the front of the carrier to secure the drive.

9. Replace the front bezel on the chassis, and go to the next topic to rebuild the RAID.
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Rebuilding the Lightspeed Live Storage RAID
The LSI Storage Authority utility program—which you start from the shortcut or from 
C:\Program Files\LSI\LSIStorageAuthority\startupLSAUI.bat on the Lightspeed Live 
Server—enables you to rebuild the storage RAID if necessary, such as when you add a 
new drive, or you want to change drive configurations. 

Replacing a Power Supply
The Lightspeed Live Server includes two user-replaceable, redundant, hot-pluggable 
power supply modules. They automatically sense the input voltage between 100v to 
240v, and operate at that voltage. Power cords plug directly into the power supply units 
at the back of the chassis. A green light indicates that the power supply is operating. 
When a power supply fails or loses power, an amber light on the power supply 
illuminates and an alarm sounds.

If either of the power supply modules fail, the other module supports the full load and 
allows the system to continue operation without interruption. The PWR Fail LED 
illuminates and remains on until the failed unit has been replaced. Replace with the 
same model. Order replacement units from Telestream. Contact Telestream Customer 
Support (Obtaining Support | Information | Assistance) to order parts.

Replacing the Power Supply
1. Unplug the AC power cord from the failed power supply module.

2. Push in the locking tab at the back of the module to release it.

3. Pull the unit straight out of the chassis. 

Caution: The power supply may be very hot when first unplugged and could 
cause burns. Handle carefully by the edges and do not touch hot components.

4. Insert the new unit into the chassis, pushing it in until it clicks firmly in place.

5. Reconnect the power cord.

AC power supplies
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Setting NMOS Logging Levels
For Lightspeed Live Capture Servers operating in an NMOS environment, you can set 
the Capture server’s NMOS Receiver logging levels as desired. Follow these steps:

1. Open the C:\Program Files\Telestream\Live Source Server\NmosNodeConfig.json file in 
a text editor.

2. Change the logging level—the first line of the NmosNodeConfig.json file to an 
integer value between -40 (most verbose) and +40 (least verbose—only fatal 
messages). The default value is 0, which is a median level of verbosity.

For example: "logging_level": 40,

3. Save and close the file.
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Managing Live Capture Logging
Live Capture’s log files can provide valuable information about Live Capture operations, 
including the Capture action, Tape action, and capture and tape recording jobs. 

Log files are intended for use by Telestream Customer Service to troubleshoot 
problems. Consider obtaining the log files before contacting Customer Service 
(Obtaining Support | Information | Assistance) so that you can email them to Telestream 
as part of the support process.

Topics
■ Accessing and Zipping Up Live Capture Log Files

■ Managing Log File Logging Levels

Accessing and Zipping Up Live Capture Log Files
By default, service logs are saved to C:\Program Files (x86)\Telestream\Vantage\Live\.

If a service is run as a domain user, they saved to a user-specific path, in this pattern: 
C:\Users\<Service_Account_Name>\AppData\Roaming\Telestream\ where <Service_Ac-
count_Name> is the name of the domain user.

If a service is run as Local System, log files are stored in the service’s Capture Component 
folder (there may be more than one). For example: C:\Program Files 
(x86)\Telestream\Vantage\Components\Capture.7.1.5.999999). 

Lightspeed live and tape capture log files on a job-by-job basis are written to 
C:\Windows\System32\config\systemprofile\AppData\Roaming\
Telestream\Capture\.

Zipping Up System Log Files
You can zip up and copy Live Capture system logs to your computer for archival 
purposes, for review, or in preparation for use in a customer service case.

To zip up log files, launch the Source Manager web app (http://[host]:8090/ (default)). In 
the More  Menu, select Download System Logs. 
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This creates a zip file on the Live Capture server and copies the zip file to your default 
Downloads directory (for example, C:\Users\<UserID>\Downloads\support.zip). The first 
file is named support.zip. The name includes a numeric suffix (support (n).zip) when 
multiple files are downloaded in the same folder. 

When the file has downloaded, the file is displayed in a panel at the bottom of the 
browser window. Click the file’s menu for options or click Show All (far right) to open 
the Downloads folder. Close the panel when done. You can open the zip file and 
examine the logs or forward the file to Telestream Support with a request for 
assistance.

Support Log Files
These log files are included in the zip file:

• Devices.csv

• EventLog-Application.evtx

• EventLog-System.evtx

• export.xml

• Processes.csv

• LiveRegistry.csv

• Services.csv

• SNMPLogs/

• Stats.txt

• versions.csv

SNMPLogs Folder

The SNMPLogs folder contains logging data from the Telestream Live Source Service:

• SourceService-[date].log.txt—Log records of activity with the sources. This includes 
loss of signal, change of format, sources being added, or sources being removed.

• LiveService-[date].log.txt—Log records of encoder failures and service startup, etc.

• packagingLog

• traceLog

SNMPLogs\traceLog Folder

The SNMPLogs\traceLog folder contains trace logs for the sources. 

• [488]-LiveSource-<YYYY-MM-DD>-log.txt (where 488 is an example PID)

• SDI 1-LiveSource-<2023-04-28>-log.txt

• HalleyComet_TS-[7792]-ChannelEncode-2023-04-26-log.txt

• Slate-LiveSource-2023-05-15-log.txt

• SRT Source-LiveSource-2022-11-21-log.txt
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Managing Log File Logging Levels
You can change the level of detail (and volume) of information written to log files by 
editing settings in the configuration files. 

Accessing Logging Configuration Files
Logging is implemented using NLog version 4.7. For details about using NLog to 
configure log file parameters, refer to https://github.com/NLog/NLog/wiki/.

Live and Tape Capture Jobs. These configuration files are in the Live Capture 
ComponentPac folder that supports Capture and Tape action recording, and the Push 
action (there may be more than one ComponentPac installed). The configuration files 
for logging live capture and tape recording processes are:

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\Capture-
Record.exe.config—specifies the live capture process logging levels.

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\TapeRe-
cord.exe.config—specifies the tape process logging levels.

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\TapeS-
titch.exe.config—specifies the tape process logging levels when the Vantage Tape 
action is configured with the Stitch Clips control enabled, where multiple tapes are 
used in a single job.

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\Capture-
Record.exe.config—specifies the live capture process logging levels.

• C:\Program Files (x86)\Telestream\Vantage\Components\Capture.<Version>\Capure-
Push.exe.config—specifies the tape process logging levels.

Note: The Vantage Live Service does not utilize NLog.

There is usually no requirement to modify this configuration file, except under 
guidance of a Telestream support engineer. 

Live Preview in Source Manager. The configuration file for logging the Live Preview 
process, which displays video in Source Manager, is:

• LivePreview.exe.config—C:\Program Files\Telestream\Live Source Server\LivePre-
view.exe.config.

Telestream Live Source Service. The configuration file for logging the Live Source 
process is:

• LiveSource.exe.config—C:\Program Files\Telestream\Live Source Server\Live-
Source.exe.config.

Caution: Before making changes to configuration files, make backups by 
copying the existing files and saving them in a safe location. 

https://github.com/NLog/NLog/wiki/Tutorial#log-levels
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Note: After you make changes to the configuration file, you should restart the 
services to apply the change.
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Configuring Vantage and 
Updating Live Capture

Live Capture requires Capture workflows in Vantage to serialize incoming live SDI and 
IP sources, encoding them into files. You’ll need to configure Vantage to inter-operate 
with Live Capture, and to create workflows that execute under control of Live Capture. 
You’ll also need to know how to use labels and variables between systems, and deal 
with network complexity including firewalls, UNC paths, and scaling Capture systems.

Note: Before you start using Live Capture, specific configuration is required. The Up 
and Running Checklist describes the initial configuration tasks.
If you aren’t familiar with Vantage, browse the Vantage User Guide directly in Vantage 
Workflow Designer and the Vantage Domain Management Guide in the Vantage 
Console. Configuration details about Live Capture actions are provided directly in 
each action’s inspector, including detailed information about containers and codecs.

Topics
■ Overview

■ Up and Running Checklist

■ Previewing Sources and Finding Workflows

■ Using Live Stores for Capturing Files

■ Creating Labels and Variables for Use in Workflows

■ Updating Live Capture Software

■ Restarting the Telestream Live Source Service

■ Firewalls and Blocked Ports Limit Functionality

■ Creating a UNC Path for Resource Locations

■ Configuring Various Actions on Arrays

■ Scaling Live Capture with Multiple Servers

■ Providing Capture Sources Unique Names

■ Best Practices for Capture Array Design

■ Using Web Applications in a Capture Array

■ Using NetBIOS Host Names

■ Correcting Connection Errors in Web Apps

■ Clearing Browsing Data after Updating Vantage or Live Capture
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Overview
Configuring Vantage for use with Live Capture includes setting up certain features and 
creating Vantage Capture/Tape workflows to capture media and save it as a file. These 
one-time configuration tasks are required in your Vantage domain before you can use 
Lightspeed Live Capture.

The program used to perform configuration tasks is the Vantage Management Console, 
which typically has an icon on the desktop of the Vantage server or other computer 
utilized with Vantage (a node, in Vantage parlance). Later in this chapter you’ll learn 
how to use the console to perform the tasks. 

Workflows are designed and managed using another Vantage program—Vantage 
Workflow Designer—which is also launched from a desktop icon. We will guide you 
step by step in creating and activating a simple Live Capture workflow that detects your 
sources, encodes them, and places your captured files into a storage location.

Once a Live Capture workflow is activated, you’re ready to start capturing. Capture 
control is manually performed using the Lightspeed Live Capture web application. 
User-written programs utilizing the Lightspeed Live Capture API can also be used to 
control capture operations.
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Up and Running Checklist
Each Lightspeed Live Capture server is delivered with Live Capture and the Vantage 
Media Processing Platform (often referred to simply as Vantage in this guide) installed.

This checklist includes all of the configuration tasks you should complete to get your 
Live Capture system up and running on premises, whether you perform the work 
yourself or a Telestream Customer Service representative or Field Engineer performs 
the work for you. (Follow the links to the how-to topics for step-by-step instructions.)

Installing your Server...
Install and Connect your Live Capture Server—First, install your Lightspeed Live 
Server in a rack, make all physical connections, and add it to your Windows domain. See 
Installing & Managing Your Lightspeed Live Server.

Or, install Live Capture on your VM | cloud platform.

Note: Do not perform the remaining tasks in this checklist until you have installed 
your Live Capture Server. For support, see Obtaining Support | Information | Assistance.

In the Vantage Management Console...

Note: To learn how to perform any of these tasks, display the panel you want to use 
and click the question mark (?) button in the upper right corner of the console to 
display the topic in the Vantage Domain Management Guide.

Note: To launch the Vantage Management Console, you can use the desktop icon.

1. Add Your Capture License to Vantage—Choose Licenses (in the left panel) to 
display the Licenses tab and add the Capture license to the Vantage domain, which 
is located on the desktop in the License folder.

2.  Restart Vantage Client Programs—Restart the Management Console, and any 
other Vantage programs that may be running.

3. Enable User Administration—Configure Vantage for user management:

a. Choose Settings & Options in the left panel. On the General tab, check Enable 
user administration to enable it (required). 

b. Check Use Windows Active Directory for Users to add and maintain Vantage 
users from your network’s Active Directory instead of creating them manually in 
Vantage. (The server must part of a domain—if its in a Windows workgroup, this 
feature is unavailable).

4. Enable Open Workflows—Also in the General Tab, check Enable Open Workflows. 
Open Workflows enables serial actions in a workflow processing the growing 
output of a Capture or Tape action concurrently, reducing total workflow time.
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Note: Open Workflows is an optional, licensed feature, which you can enable in your 
Vantage domain. If your Live Capture system is joined to a Vantage domain, all Open-
capable actions in Capture and Tape workflows (those utilizing Capture or Tape 
actions) can operate in open mode, regardless of whether Vantage is specifically 
licensed to support open workflows or not.

5. Create User Accounts—Each user may optionally have their own Vantage user 
account; it is not a requirement. 

Note: User accounts can also be used to control access to the Management Console, 
Workflow Designer, Workflow Categories, and Channel Groups. Or, they can prevent 
users from competing for the same resources.

6. Configure Service Logons—By default, all Vantage and Telestream services are 
configured to use the Local System account. This account only provides access to 
files on the local Vantage domain server. 
If Vantage requires access to input or output folders on other servers (which is 
likely), you should create a user account for Vantage in your Windows domain, and 
grant access to the Vantage user account on the target server. All services must use 
the same account. Attempting to run them in different accounts results in failures.

You can configure Vantage services to log on with specific accounts in the Vantage 
Management Console or in Windows via the Services MSC. 

Telestream services must be updated directly via the Services MSC, because it is not 
a Vantage service; thus, its not listed in the Management Console. 

Note: For a full discussion of Windows authentication and service user account 
requirements, see the Vantage Domain Management Guide as well as these Vantage 
Installation Guide topics: Windows Authentication Guidelines and Setting the Vantage 
Windows Log On ID for Services. 

During workflow creation, you also must specify Open Workflows at both the work-
flow and the action level:

• Workflow Level— in Workflow Designer’s workflow details panel above the action 
selector panel, check the Open Mode option.

• Action Level—on each action, right-click and choose Workflow Mode > Open.

7. Create a Vantage Live Store—Choose Storage > Vantage Stores to create at least 
one Vantage Store (Live). Create a Live Store on the Vantage server’s local D drive in 
a Windows folder you choose or create: See Using Live Stores for Capturing Files for a 
detailed discussion and configuration details.

8. Create Network Folders | Vantage Folders—This is optional, based on your 
workflow requirements for network server file access. 

a. Network Folders—If you plan to access network servers for input or output files, 
create/identify each location. The location should be capable of the I/O required 
for sustained reading/writing of live media. This may be a folder on the 
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Lightspeed Live Server’s D drive (media drive) or a NAS/SAN. In the Capture and 
Tape web apps, you can direct the Primary and Secondary outputs to one of 
these Vantage Address Book folders.

b. Vantage Folders—Now, create Vantage folder address records in the Vantage 
Address Book to identify locations by name—Vantage Folders make it easy to 
specify the location during workflow design. Select Storage > Vantage Folder 
Address Book and add Vantage Folders.

Note: Telestream recommends that you create one Vantage Folder initially; you can 
create others as required for your workflows.

9. Authorizations—Optional; if Windows credentials are required for Vantage 
services when they access network locations in another Windows domain or 
workgroup, create Authorization records for the services to use as necessary: Click 
Settings & Options, display the Authorization tab and create authorization records. 

10. Create a Channel Group’s Nexus—Vantage uses the concept of a nexus generally, 
to organize and identify related resources and enable client applications to filter 
them. In the context of Live Capture, these resources are Vantage workflows. When 
you create a Live Capture workflow, you can associate it with a specific Channel 
Group. There is a unique nexus for each capture action—Capture and Tape.

In Capture web apps, you select one of your channel groups to display only those 
Vantage workflows in this group. Next, you choose a workflow in the channel group 
to use for the task you’re currently performing.

At least one nexus is required. The type of nexus you create depends on the web 
apps you plan to use.

Open Workflow Design Items > Nexus Definitions in the left panel to display the 
Nexus Definitions panel and create at least one Channel Group nexus: 

– Live Capture workflows (using a Capture origin action) require a Capture nexus 
and jobs are submitted (capture operations are started) directly from the Capture 
web app. 

– Tape Capture workflows (using a Tape Capture origin action) require a Tape 
Capture nexus and jobs are submitted (capture operations are started) directly 
from the Tape Capture web app.

For testing, create a nexus named Capture Nexus.

11. Restart the Vantage Live Service—To apply these settings for use in Capture, 
restart the Vantage Live Service: Display the Services tab and choose Live. Place it in 
maintenance mode (click the yellow down arrow in the toolbar) and then return it 
to Online, by clicking the green arrow. 
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In Source Manager...
Open the Chrome program and perform these configuration steps on each Live 
Capture server:

1. Start the Source Manager web app (http://localhost | <Remote Host Server 
Name>:8090).

2. Rename the SDI sources if required, then configure them (for details, see 
Configuring SDI Sources).

3. Create and configure IP sources if any are required. See relevant topics.

4. Create and configure ST 2110 sources if any are required—see Creating and 
Configuring ST 2110 Sources.

In Vantage Workflow Designer...
You should create and configure at least one workflow for each Live Capture 
application you plan to implement (Live Capture | Tape Capture).

Note: Only one Tape or Capture action is allowed in a Live Capture workflow. Multiple 
Tape/Capture actions in a single workflow is not supported.

For testing purposes, create a Live Capture workflow and configure it as described here. 
The simplest workflow has a single Capture action and uses a manual trigger, in order 
to activate a recording from the Live Capture Web App.

1. Create a new workflow, named Live Capture Test.

2. Add a Capture action from the Live category.

3. Open the Inspector and configure the following:

• Source: Select any live source you have connected to the Capture server.

• Channel Group: Capture Nexus (created earlier).

• Trigger: Manual

• Primary Output: QuickTime

• Nickname: Original

• Output Location: Vantage Store > LiveStore (created earlier).

4. Save and close the inspector.

5. Activate your workflow so that you can utilize it in Live Capture. In the Monitor 
Status tab, the Live Capture workflow you’ve activated should be listed, and state 
should indicate In Process.

See Creating Live and Tape Capture Workflows for prototype workflows.
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In Live Capture...
Now, you’re ready to test the system... follow these steps:

1. Open Chrome and go to http://localhost | <Remote Host Server Name>/Vantage.

2. Locate your target Vantage domain, enter the default user ID Administrator (no 
password) to log in.

3. In the Vantage web portal, open the Live Capture web app.

4. Select your nexus.

5. Click Live Capture and note that there is an active channel for the workflow that 
you activated.

6. Begin capturing video. The active feeds display a preview thumbnail in the 
Channels panel of the Live Capture web app (http://localhost/Vantage/
LiveCapture.../channels/). You can activate Live Capture workflows configured with a 
manual trigger or a recurring segment trigger directly from this window.
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Previewing Sources and Finding Workflows
The Capture Inventory panel in the Vantage Management Console (VMC) enables you 
to display a preview of a Capture source, and to identify workflows which are 
configured to use a particular source. All SDI sources on a Lightspeed Live Capture 
system are automatically added to the Capture inventory list.

Note: Source configuration is performed using Live Source Manager (see Managing 
Video Sources). 

Select Capture Inventory in the left panel to display the Capture Inventory panel:

Note: If all input sources are not displayed after installing and starting Live Capture, 
restart the Live Capture Server. Then, check the Capture Inventory panel again for the 
list of sources. The list should be populated with all input sources after all Live Capture 
servers have been restarted. 

Previewing Sources
To preview a source thumbnail and details, click the Preview button in the Capture 
Inventory toolbar. The preview image is updated once per second.
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Finding Workflows
To determine which workflows are configured to use a specific source, click the Find 
Workflows button  in the Capture Inventory toolbar. 

The console displays a list of associated workflows:
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Using Live Stores for Capturing Files
You use a Vantage Live Store as a managed output location for Primary and Secondary 
Capture output. Live stores in Vantage are only used by Capture workflows, and are the 
only type of store that you can use in Capture | Tape workflows. 

WARNING: To ensure that Vantage Live Stores manage captured media in real 
time—including deleting expired media in a timely manner by deleting files to 
preserve disk space—it is very important that Live Stores are configured 
correctly. Failure to do so may result in running out of storage and failure of 
Capture workflows in real time.

Live Stores in Vantage refer to locations that automatically recycle expired media to 
preserve disk space in real time, improving overall system efficiency.

Note: This is a practical overview of using Live Stores from the Capture perspective. 
The creation, configuration, and management of stores, including as shares, is 
described in the Vantage Domain Management Guide. See the Vantage Domain 
Management Guide > Managing the Vantage Domain.

Each Live Store identifies a specific server and directory path (folder). Live Stores should 
be created on a Capture server’s D drive or on a server with the I/O capacity to support 
real-time write operations for best efficiency and overall system effectiveness. You can 
also create Live Stores on NAS or SAN storage systems. 

Note: For Network Attached Storage systems (NAS), the cardinal rule is to always create 
stores using UNC paths when you have a Capture array.

■ Creating a Live Store in Vantage

■ Identifying Live Stores with a UNC Path

■ Executing Transport Actions Using Local & UNC Paths

■ Managing Live Storage Disk Space
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Creating a Live Store in Vantage
Live Stores are created using the Vantage Management Console:

To create a folder for the Live Store, perform these tasks:

1. On each Live Capture server, In Windows Explorer, navigate to the D drive and 
create a local path and folder for this Live Store. Name it LiveStore, for example. 
Alternatively, use a SAN/NAS. 

2. Select the LiveStore folder you just created and update the folder’s properties: Share 
the folder, add authorized users—your Vantage Services users—and set read/write 
privileges, and set security permissions as appropriate. 

Note: In an array, the location must be a local driver letter or UNC network path and 
the Alias must be a UNC path to the same location or recycling is rendered inoperative. 
Otherwise, the Capture action must be configured with Run On rules to ensure that 
the local drive is always used on each Capture server in the array.

3. Make certain that Vantage and Telestream services are using appropriate Windows 
user accounts for accessing network locations—see Up and Running Checklist, Step 4.

Click to 
display the 
Vantage 
Stores panel

Click to create a 
new Live Store

Alias must be a UNC path to the 
same location on the local server

Location—local 
path or UNC to 
same location.

Name the store to 
identify the server.

Type must be Live.
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Identifying Live Stores with a UNC Path
To ensure that Live Stores are accessible to Vantage and Telestream services, specify the 
Location as a drive letter or UNC path, whether they are local or on a SAN/NAS. A UNC 
path is also required when you are using the Capture web apps hosted on an IIS server 
other than the Capture server.

Follow these steps to create and configure a Live Store:

1. Choose Storage > Vantage Stores in the left panel. The Vantage Stores panel lists all 
of the stores (two types—File and Live) in the Vantage domain. Click the New 
Vantage Store icon and specify the Location and Alias. Be sure to select Type: Live. 
For configuration details, display the Help topic (?) in the Management Console.

For example, for Capture servers LSL-01, LSL-02, and LSL-03, create these stores:

1. In the Live Store Alias field, add a UNC path (NOT a drive letter) pointing to the 
same path as specified in Location.

2. Create authorization records in the Vantage Management Console > Settings and 
Options > Authorization tab for each Live Store UNC path. Then put all Vantage 
services into Maintenance Mode and exit them again to apply the change.

3. When creating workflows, be sure to assign Capture actions to the Live Store 
corresponding to the Capture server where the action is executing. For example, 
assign Capture actions on LSL-01 to the LSL-01 Live Store (\\LSL-01\d\livestore).

Executing Transport Actions Using Local & UNC Paths
If a Live Store is only defined as a local path, then the Vantage Transport service (which 
executes Transport actions) executing Copy or Move actions in a workflow must also 
run locally—on the same server as the Vantage Live Service, which executes the 
Capture, Tape, and Push actions. While they may not be necessary, Run On rules are 
often added to make sure that Transport actions always execute locally.

However, if a Live Store also specifies a UNC path that is accessible to all servers in a 
Vantage domain, then the Transport service may run on any server in the array, 
assuming the domain is configured to use the Transport service authorized access to 
the UNC path. Details are presented in the Vantage Domain Management Guide.

Live Store Name Location
Store 
Type Alias

LSL-01 Local Live Store D:\LiveStore Live \\LSL-01\d\livestore

LSL-02 Local Live Store D:\LiveStore Live \\LSL-02\d\livestore

LSL-03 Local Live Store D:\LiveStore Live \\LSL-03\d\livestore
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Managing Live Storage Disk Space
Capture systems can consume significant disk space during operation. In order to 
maintain adequate disk space, Vantage enables you to manage Live Capture server 
storage automatically and manually.

In typical usage, Vantage’s job expiration is an automatic, continual means of 
controlling storage space. In addition, Vantage enables you to manually delete files 
from Live Capture server managed storage, via the Vantage Management Console. This 
is particularly useful when your Lightspeed servers are mobile—being shut down 
between capture events—for transport. 

For example, when a live music concert/event is performed, Live Capture is set up and 
started immediately prior to the start of the event, when recording begins. Then, after a 
two or three hour event, the Capture system is shut down and repacked for transport. 

This shutdown may result in multiple channels of 2-3 hours of recording on disk. 
Because the Capture system was shut down for shipment shortly after capture was 
complete, there was no time for the expiration rules to clean up storage.

Rule-based Space Management
You can set up rules to govern automated file deletion parameters you set up on 
selected Live Stores. 

In the Vantage Management Console Settings & Options > Storage Management tab, 
create rules that govern file deletion. 

Next, in Storage > Vantage Stores, select a store, and specify the rule that applies using 
the Automated Cleanup menu.

Workflow and Job-based Space Management
Workflow and job-based storage space management enables you to configure your 
workflows so that Vantage continually monitors jobs by age, and delete their 
associated files. 

You can set up the following automatic space reclamation options:

• Workflow Expiration—in Workflow Designer, enable this setting for your workflow 
in its settings panel) (see Viewing and Specifying Workflow Details in the Workflow 
Designer User’s Guide) to automatically delete files ingested or created by the job, 
as part of the binder deletion process.

• Expire Failed Jobs—in the Vantage Management Console Settings & Options > Gen-
eral panel (see Enabling and Disabling Expiration of Failed Jobs in the Domain Man-
agement Guide), enable the Expire Failed Jobs setting when you want failed jobs to 
be expired using the same expiration rules as jobs that complete successfully. Oth-
erwise, they do not expire automatically, and binders (and file resources) are pre-
served until deleted manually.
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Manual Space Management
You may need to override the automatic space management settings on occasion, and 
perform manual cleanup. 

Using the Vantage Management Console, you can manually delete files at any time. You 
can delete all files in Live Stores, and you can also delete Live Store files by age and by 
percent of free space. 

Manual deletion is achieved using either of these options (Storage > Vantage Stores—
right click on the target store and select Storage Cleanup or Quick Cleanup> 

• Storage Cleanup—immediately deletes all files in selected stores (Quick Cleanup for 
multiple stores) or Advanced Cleanup by date or by percent of free store space.

• Quick Cleanup—immediately deletes all files in the target store. Click OK to con-
tinue.
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Creating Labels and Variables for Use in Workflows
You can add labels and variables to the Tape action and Capture action and you can 
view and update their values in the Tape Capture, Live Capture, and Live Schedule Pro 
web applications.

Labels and variables are created and managed in Vantage. After creating a label or 
variable, you can use them in your workflows as required. For more details, click the ? 
icon or display the User’s Guide from the Help menu.

This graphic displays the Metadata Labels panel in the Vantage Management Console 
where you create and update them.

In the console, add labels using Workflow Design Items > Metadata Labels. You can also 
add variables in Vantage Workflow Designer: select Items > Variables.

Updating Vantage and External Systems with Variables
You can attach one or more variables to an event, and then, on a job-by-job basis, 
provide unique values for the variable. In the Vantage workflow, you can also save the 
variables as part of a label, along with the other workflow output in a catalog, for use in 
other workflows or for use externally, in other systems. 

Or, you can create a workflow to update metadata in external systems using variables. 
For example, you can modify your Capture workflow to enable the Update Workflow 
and provide a target workflow to trigger after each job. Now, create the target workflow 
with a Receive action (so it can be triggered) and then use Populate and Notify actions 
for example, to transfer new values to an external system.

Updating Vantage and External Systems with Metadata
You can attach one or more labels to an event, and then, on a job-by-job basis, provide 
unique values for the fields in the label. In the Vantage workflow, you can also save the 
label along with the other workflow output in a catalog, for use in other workflows or 
for use externally, in other systems. 
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Or, you can create a workflow to update metadata in external systems using variables. 
For example, you can modify your Capture workflow to enable the Update Workflow 
and provide a target workflow to trigger after each job. Now, create the target workflow 
with a Receive action (so it can be triggered) and then use Populate and Notify actions 
for example, to transfer new values to an external system.
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Updating Live Capture Software
You should only update Live Capture when you are directed to do so, as instructed by 
periodic Telestream service bulletins. You can download the Live Capture installer from 
Telestream’s support web site (see Obtaining Support | Information | Assistance).

Updating Live Capture Web Apps on Windows Workstations
To install/update Live Capture web apps on a Windows computer (other than Live 
Capture servers), IIS is required. If IIS is already installed, you must create a 
configuration that supports Vantage Web Applications.

See Installing and Configuring Vantage Web Applications in the Vantage Installation 
Guide or the Domain Management Guide for details. An easy way to access the Domain 
Management Guide is to open the Vantage Management Console and click the ? in the 
upper right corner of the main window.

The following helpful topics are in the Vantage Installation Guide and the Domain 
Management Guide:

• Server Hardware Requirements 

• Vantage Web Applications OS 

Note: Log into the Telestream Live Capture Support Portal and download the Live 
Capture installer before proceeding with these tasks to update Live Capture.

Note: After installing a Vantage or Live Capture ComponentPac update, clear the 
browsing data in your browser in order for web applications to operate properly. See 
Clearing Browsing Data after Updating Vantage or Live Capture for detailed information.

Follow these steps to install or update Live Capture web apps:

1. Copy the installer directly to the target computer or place it on a network server 
that you can access from the target computer.

2. On systems running Live Schedule, you must uninstall Live Schedule before 
uninstalling Vantage Web Applications. This is required—if you don’t, Live Schedule 
will not function after the update.

3. Uninstall the current Vantage Web Applications using the Windows Apps & 
Features Control Panel.

4. Run the Live Capture Installer and select the Vantage Web Applications Setup 
installer and proceed according to the installer directions.

https://dynamic.telestream.net/downloads/login.asp?prodid=lightspeed-live-capture&message=login
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Updating Live Capture
Use these topics to update Live Capture to the current version on your Lightspeed Live 
Server or install it or update it on other supported platforms.

Note: Log into the Telestream Live Capture Support Portal and download the Live 
Capture installer before proceeding with these tasks to update Live Capture.

All of the required files for each release are in the Installer folder, located in their 
respective folders:

• AJA Drivers and Firmware

• Live Capture Installer

• Nvidia Driver

• USB-Serial Drivers

• Vantage Updates

NVidia/AJA Driver and Firmware Installation Steps
If a new version of the NVIDIA Graphics and GPU driver is required:

1. Uninstall the NVIDIA Graphics Driver via the Windows Apps & Features Control 
Panel.

2. Install the driver for your Lightspeed Live server using the installer in 
Installers\Nvidia\. Using the Advanced options > Clean Install is recommended.

3. After updating the NVIDIA driver, be sure to reset your GPU to operate in TCC mode 
(see Setting Your NVIDIA GPU to TCC Mode).

If a new version of the AJA driver for Corvid-based SDI capture is required:

1. Uninstall AJA NT2V Drivers from Windows Apps & Features Control Panel

2. Install new AJA driver from the installer located in the Installers\AJA Drivers and 
Firmware\Driver\ folder.

If a new version of AJA firmware is required:

1. Open cmd.exe and change the directory to Installers\AJA Drivers and 
Firmware\Firmware\.

2. Identify the BIT (~.bit) file appropriate for your Corvid hardware.

3. On a single Corvid card system run ntv2firmwareinstaller -p 
[corvid_xxx.bit] where xxx is the version number.

4. For a system with multiple Corvid cards, direct the target of the update with the -d 
argument. For example: 
ntv2firmwareinstaller -d0 [corvid_xxx.bit]

ntv2firmwareinstaller -d1 [corvid_xxx.bit]

5. Power down the system and restart it, to enable the system to initialize the cards 
with the new firmware.

https://dynamic.telestream.net/downloads/login.asp?prodid=lightspeed-live-capture&message=login
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Update the Live Capture software:

1. On systems running Live Schedule, you must uninstall Live Schedule before 
uninstalling Vantage Web Applications. This is required—if you don’t, Live Schedule 
will not function after the update.

2. Uninstall Telestream Live Capture using the Windows Apps & Features Control 
Panel.

3. If a new Vantage Update pack is required, run the installer from the 
Installers\Vantage Updates folder.

4. Install the new version of Telestream Live Capture from the Installers\Live Capture 
Installer folder and follow the steps in the installer.

5. On the Installer Options panel:

– Disable Automatic Registry configuration—The installer creates these settings 
automatically. Generally this setting should be left disabled, but you can enable 
it if the installer will be making the required changes prior to installation.

– (Software Only Capture) Enable GPU Encoding—This is for VM-based Live 
Capture systems. When checked, the installer enables GPU support on the target 
system if it detects a GPU. If no GPU is detected, you can enable this setting to 
force GPU support. Note: if GPU emulation on the VM is not supported or not 
correctly configured, this will cause Capture jobs to fail.

– Clean Install—Enable to reset the Source Manager etcd database to default 
values. Note: Performing a clean installation of Live Capture deletes all Live 
Source settings and you must recreate them.

6. Restart the Live Capture server.

Updating | Installing Live Capture Software
This topic describes updating or installing Live Capture on your Live Capture server. 

For Live Capture Software licensing requirements, see Live Capture Software Licensing.

For supported platforms and minimum platform requirements, see Live Capture VM 
Server Requirements.

All of the required files for each release are located in the Installer folder:

• Live Capture Installer

• Vantage Updates

• Driver and firmware installation
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Installation Steps
To update the Live Capture software:

1. Install Vantage if required—see the Vantage Domain Management and Installation 
Guide on the Telestream web site.

Configure the installer to install these services:

– Vantage Analysis Service

– Vantage Avid Service

– Vantage Cloud Service

– Vantage Transcode Service

– Vantage Communicate Service

– Vantage Metadata Service

– Vantage Monitor Service

– Vantage SDK Service

– Vantage Transport Service

2. If a new Vantage Update pack is required, run the installer from the Vantage 
Updates folder.

3. Install Live Capture using the installer in the Live Capture Installer folder and follow 
the steps in the installer.

4. On the Installer Options panel:

– Disable Automatic Registry configuration—The installer creates the required 
registry settings automatically. Generally this setting should unchecked so that 
the registry settings are created, but you can enable it if you are making the 
required registry settings prior to installation.

– (Software Only Capture) Enable GPU Encoding—This is for software-based Live 
Capture systems—VM | cloud, for example. The installer automatically enables 
GPU support on the target system if it detects a GPU. If no GPU is detected, you 
can enable this setting to force GPU support. 

Note: Note: if GPU emulation on the VM is not supported or not correctly configured, 
this causes Capture jobs to fail.

– Clean Install—Enable to reset the Source Manager etcd database to default 
values. 

Caution: Clean installation of Live Capture deletes all Live Source settings.

5. Click OK to perform the installation per your settings.

6. Restart the server.

https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/8-1/Vantage-Domain-Management-Guide.pdf
https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/8-1/Vantage-Domain-Management-Guide.pdf
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Restarting the Telestream Live Source Service
If you changed server settings to join an array or change port numbers, the Telestream 
Live Source Service should be stopped and restarted to operate under the new 
settings.

For a single Live Capture server, stop and restart the Live Source Service.

To restart Capture servers in an array, follow these steps on each server in the array:

1. On each server except the Vantage database server, open the Services control 
panel and stop the Telestream Live Source service.

Note: In Task Manager, make sure that the processes supported by the services have 
also terminated before continuing. It may take a minute for source processes to 
terminate before you can start the Vantage Live Service again. You may need to 
manually terminate the Live Source process.

2. Now, restart the Live Source Service. 

3. Shut down and reboot the Vantage domain server.

The sources from all Live Capture servers should now display in the Live Source 
Manager web app.

Firewalls and Blocked Ports Limit Functionality
If you have firewalls and/or blocked ports you may not be able to access each of the 
Live Capture servers in an array. The servers display, but, for example, you may not be 
able to configure Channel settings or view the sources.

Telestream recommends that you disable the Windows Firewall on all computers that 
communicate with or support Telestream and Vantage services. The default Windows 
Firewall configuration blocks access to a Vantage server from other Vantage 
components, such as other Vantage servers or workstations running Vantage client 
software. 

For details about firewalls and port usage in Capture, see Web App Ports and Windows 
Firewall Settings. For information about firewalls in Vantage, also see Firewall Guidelines 
in the Vantage Domain Management Guide. 

Creating a UNC Path for Resource Locations
When multiple Live Capture servers are joined together, you should specify the 
Resource Location for assets as a UNC path. This allows different servers to access the 
assets used for segment materials. See Using Live Stores for Capturing Files for details.
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Configuring Various Actions on Arrays
A Live Capture license includes a Vantage array license. When a Live Capture workflow 
executes, the Capture (an origin) action process executes on the local Live Capture 
server. However, other Vantage services—such as Vantage Transport and Deploy 
services—can run on any server that has the required resources for the service.

You can optionally implement Run on Rules to ensure that all Transport or Deploy 
actions run on the same server performing the capture to simplify workflows. See the 
Vantage User’s Guide for information about Run on Rules. 

When Capturing to a Live Capture Local Media Drive

When you are using a Capture action to capture directly to a Live Store that is 
configured to write to a local drive, Vantage auto-generates Run on Rules for the 
workflow actions following the Capture action that operate on the output of the 
Capture action to execute directly on the same Capture server. You may also set up 
manual Run on Rules to make this limitation clear in the workflow.

If you specify that the capture output is to be written to a UNC folder, Run on Rules are 
not generated, and subsequent actions which operate on the capture output may be 
executed anywhere, unless you establish Run on Rules to the contrary.

For actions that do not immediately follow the Capture action, best practice is to set 
Run on Rules that instruct processes for actions other than Capture to run on the Live 
Capture server where the media resides. See Configuring an Action’s Run on Rules in 
the Vantage User Guide for more information.

When Capturing to Shared External Storage

When you are capturing to a shared external storage location, such as a NAS or SAN 
with Capture as part of a larger Vantage array, you can execute the transport actions on 
any server with available resources. In this case, Run on Rules are not required. Your 
system automatically chooses an available service on any server that can execute the 
required action.

See Scaling Live Capture with Multiple Servers for information about setting up a Vantage 
array for Live Capture. See also Using Live Stores for Capturing Files for more details.
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Scaling Live Capture with Multiple Servers
Your Lightspeed Live Capture server is factory-configured as a standalone Capture 
system, including a Vantage domain (Vantage services, client applications, and the 
Vantage database). If you plan to create an array with multiple Live Capture servers, or 
add Live Capture servers to a Vantage array, you can do this in two ways: 

• For Capture-only systems, join all Live Capture servers together by creating an array 
that utilizes a single Vantage domain database. 

• For Capture systems that utilize other Vantage services and workflows, such as 
Transcoding and Analysis, add your Live Capture servers to the existing Vantage 
array.

Best Practices for Connecting Multiple Capture Servers to a 
Vantage Domain
Vantage database and Live Capture web application traffic can affect Live Capture 
server performance. Therefore, either as a Capture-only Vantage array or a single-server 
Vantage domain, Telestream recommends that the Vantage database and IIS hosting 
the Live Capture/Vantage web applications run on a dedicated server. See images 
below and Best Practices for Capture Array Design.

Further information regarding running the database and IIS on non-Live Capture/
Vantage servers is located in the Vantage Domain Management Guide. 

It is also highly recommended that the process of creating a Vantage domain with Live 
Capture servers be performed as part of the installation and commissioning phase.

Note: When two or more Live Capture servers are combined into an array or joined to 
an existing Vantage domain, only those ComponentPacs that are installed on the 
server hosting the Vantage database are utilized. 
Verify that all of the required ComponentPacs are installed on the Vantage database 
host.
The Vantage Transcode Service should be un-installed from Live Capture servers, 
using the Vantage Management Console. To preserve optimum live capture 
performance, you should not perform additional Vantage transcoding on Live Capture 
servers. 

https://telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf


Configuring Vantage and Updating Live Capture
Scaling Live Capture with Multiple Servers

100

LIve Capture User’s Guide

Joining Capture-Only Systems
You can join two or more Lightspeed Live Capture servers together to form a multi- 
server Live Capture-only system. This allows for common configuration, management, 
and capture control.

  

To join Lightspeed Live Capture servers together, follow these steps:

1. Select one of your Lightspeed Live Capture servers to act as the Vantage domain 
database server. The domain database server hosts the domain database and has 
all the services running on other Lightspeed Live Capture servers added to it via the 
Vantage Management Console. 

2. Add all services running on your Lightspeed Live Capture servers to the Vantage 
domain, using the Vantage Domain Management Console. See the Vantage 
Domain Management Guide for details on adding services.

3. Add the appropriate multiple-server Vantage license to the domain. See the 
Vantage Domain Management Guide for details on licensing. 

To configure, manage, and control your Lightspeed Live Capture system, connect the 
Vantage Management Console, Vantage Workflow Designer, and Lightspeed Live 
Capture web applications to the domain named with the same name as the database 
server selected in Step 1, above.

Also see, Configuring Various Actions on Arrays. 
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Existing Vantage Array—Adding Live Capture Servers
Joining Lightspeed Live Capture servers to a Vantage array allows Vantage workflows to 
begin with a Capture origin action that is connected to other Vantage actions and 
services, such as general transcoding, IPTV/VOD transcoding, analysis, third party 
application control, delivery options, or other service/action types.

   

Adding Services

The Lightspeed Live Capture server hosts Vantage services, so adding these services to 
an existing Vantage array is no different than adding any other Vantage service running 
on a separate server to a Vantage array. 

Important Note: Joining Live Capture services to an existing Vantage array requires 
specific Vantage array licensing. See the Vantage Domain Management Guide for 
details.

To add Lightspeed Live Capture services to a Vantage array, follow these steps:

1. Verify that the Lightspeed Live Capture services are running, all Vantage Services 
are running on the server, and no jobs are being processed in the local, factory-
installed All-In-One domain.
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2. Verify that you have configured the other (non-Lightspeed) Vantage domain server 
with the array, and is running. Refer to the Vantage Domain Management Guide > 
Installing a Vantage Distributed Domain, for more details.

3. Verify that the Lightspeed Live Capture server is on the same network as the 
Vantage array, with sufficient network permissions and access. Refer to the Vantage 
Domain Management Guide > Network Requirements, to configure your network. 

4. Start the Vantage Management Console, and select the new Vantage array.

5. Add the services on the Lightspeed Live Capture server to the new Vantage array, 
just as you would do with any Vantage services running on any Vantage server. 
Refer to the Up and Running Checklist for configuring services with appropriate 
Windows user accounts.

6. Apply the appropriate Vantage array license onto the system running the Vantage 
domain database. See the Vantage Domain Management Guide for details on 
licensing.

Also see Configuring Various Actions on Arrays.
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Providing Capture Sources Unique Names
It is a requirement that each capture source has a unique name when multiple Live 
Capture servers are part of an array. You should change the default source names to 
make them unique and identifiable in the scope of the array. 

By default, Source names are named SDI [1 through n], where n is 4 or 8 depending on 
server. For example, SDI names for a 4-channel server are:

SDI 1 | SDI 2 | SDI 3 | SDI 4

If you change source names using the Source Manager (Managing Video Sources), keep 
in mind that all sources in an array must be uniquely named so you can easily 
distinguish sources on one server from sources on another.
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Best Practices for Capture Array Design
The best practice for using multiple Live Capture server systems (an array) is to install 
and run the Vantage domain database and IIS on a dedicated server, separate from the 
Vantage and Live Capture servers. See the Vantage Domain Management Guide for 
details on installing a Vantage database and IIS.

When clustering two or more Live Capture and Vantage servers together, best practice 
is to use a separate server designated as the IIS web server to host the Live Capture web 
application. Ideally, the web host should be separate from the Vantage domain 
database since both IIS and SQL can consume a considerable amount of system 
resources. 

The following are two example systems utilizing a dedicated Vantage database and IIS 
web server.

Capture-only System

 

In this example, the Vantage domain database and IIS are installed together on a 
dedicated server. This prevents database and web server resources consumption from 
affecting the Live Capture servers.
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Capture Array—Separate Vantage Database and IIS Web Servers

In this example, the Vantage domain database and IIS are each installed on dedicated 
servers. 

 

Since this is a large system, containing six Vantage systems and three Live Capture 
servers, hosting the database and web server separately from all other servers running 
Vantage services is recommended to prevent overhead resource consumption from 
affecting the Live Capture and Vantage servers.

For additional information on best practices for Vantage and Vantage databases, refer 
to the Vantage Domain Management Guide and the Planning and Setting Up Your 
Vantage Database publication on the Telestream web site.
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Using Web Applications in a Capture Array
When you have multiple Capture servers in an array, where the Vantage database and 
web server reside on specific server(s) in the array, the Vantage client applications and/
or the Live Capture web application must be configured to connect to the appropriate 
server. 

Configuring Vantage Client Applications for Multiple Servers 
Since the database in a Vantage array is located on a single, dedicated server, the 
Vantage client applications must point to that database. Do this by selecting the 
database server in the Select Vantage Domain dialog in each Vantage client program.

Using Vantage Desktop Client Applications

First, install the Vantage Management Console and Vantage Workflow Designer client 
applications on any Windows system on your network. To use these client applications, 
you must change the Vantage Domain so they connect to the server that is running the 
Vantage domain database. 

Select Change Vantage Domains from the File menu of each client application to open 
the Select Vantage Domain dialog.

Note: To learn more about the Vantage Management Console or Vantage Workflow 
Designer, click the ? icon to display the topic for the feature that you are using. Or, use 
the Help menu to open the searchable Vantage User Guide for general help.

Using the Live Capture Web App to Manage Multiple Servers
To use the Lightspeed Live Capture web application with multiple servers, first install 
the Vantage web applications on the server hosting the IIS Web Service. 
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To open the Lightspeed Live Capture web application, use the following URL:

http://<IIS Web service Host Name>/Vantage

... where <IIS Web service Host Name> is the DNS name of the computer hosting 
the IIS Web Service.

Vantage displays the Select Vantage Domain dialog:

In the Name or OP field, enter the server hosting the Vantage domain database and 
click OK to log in. 
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Using NetBIOS Host Names
You can use a Vantage array without an external name server, when NetBIOS is enabled 
in the database server and all nodes.

Configure the following settings in all servers to enable NetBIOS:

1. Open the Control Panel and select Network and Sharing Center.

2. Select the Change Adapter Settings option to open Network Connections.

3. Right-click on the network connection to change and select Properties. The 
Properties dialog displays:

4. Select TCP/IPv4 and click the Properties button. The TCP/IPv4 dialog displays:
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5. Configure the IP Address, unique for each server.

6. Configure the Subnet Mask, Default Gateway, and the DNS server address settings. 
Use the same addresses for each server. 

7. Click the Advanced button. The Advanced TCP/IP Settings dialog displays:

8. Select the WINS tab, then select Enable NetBIOS over TCP/IP. 

9. Click OK in all dialogs to save the configuration.

10.  Reboot the server you just configured, then configure all other servers. 
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Correcting Connection Errors in Web Apps
When using Live Capture web applications on a workstation and connecting to a 
Capture server via the network, you may experience connection problems if you aren’t 
using DNS. For example, you may see a No Event message instead of video thumbnails. 

To facilitate connections on servers | workstations that do not utilize external DNS:

• Capture arrays require connections using host names, not IP addresses

• If external DNS is not available, host name resolution should be configured as 
described.

Update the hosts file on the computer you’re using to run the web apps. This procedure 
describes how to correct this problem for Mac OS and Windows workstations.

Updating the hosts File on Mac OS
On a Mac OS computer, add the server IP address and host name to the ~/etc/hosts file 
and save it. Perform the following steps:

1. Open the Terminal application—go to Application > Utilities and double-click 
Terminal.app.

2. Enter sudo nano/etc/hosts and press Return.

3. Enter the administrator password for the computer and press Return.

4. Place the cursor after all of the text in the window and type the IP address of your 
Live Capture server. For example: 102.54.94.97

5. Press the Tab key, then type the host name of the Live Capture server. For example: 
CaptureServer1

6. Hold down the Control and 0 keys and press Return. 

7. Press Ctrl-x to exit.

8. Flush your DNS table by executing sudo killall -HUP mDNSResponder in Terminal.

9. Quit the Terminal application. 

Updating the hosts File on Windows
On a Windows computer, add the IP address and host name to the hosts file and save it. 
Perform the following steps: 

1. In File Explorer, navigate to: C:\Windows\System32\drivers\etc. 

2. Open the hosts file in Notepad.

3. On a new line, enter the IP address of your Live Capture server.

For example: 102.54.94.97

4. Press the Tab key and enter the host name of your Live Capture server.

For example: CaptureServer1

5. Save the file and close Notepad.
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Clearing Browsing Data after Updating Vantage or 
Live Capture

After a Vantage version upgrade or ComponentPac update is installed on your Live 
Capture server or other Vantage domain being used in conjunction with Lightspeed 
Live Capture, you should clear the browsing data in your browser in order for the 
Lightspeed Live Capture web applications to operate properly. 

Follow these steps to clear the browsing data:

1. In Chrome, select Clear browsing data... from the More menu to display the Clear 
browsing data dialog.

2. Select The beginning of time from the Obliterate the following items menu, then 
check Cookies and other site and plugin data and Cached images and files.

3. Click the Clear Browsing Data button,
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Managing your Web Apps

Effective use of your Live Capture web apps requires a supported web browser, 
learning how to launch each web app and connect to a Live Capture server, and how to 
use the apps effectively in a networked environment and deal with changes in your 
network such as changing a Vantage domain name.

Topics
■ Web Application Browser Requirements

■ Efficient Use of Capture Web Apps

■ Launching Lightspeed Live Web Applications

■ Launching the Source Manager Web App

■ Changing the Vantage Domain Name
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Web Application Browser Requirements
Vantage and Live Capture web applications are implemented for execution in Microsoft 
IIS. Java Script and cookies must be enabled to use Capture web applications properly.

Capture web apps are implemented for viewing in the Chrome browser, version 
113.0.5672.93 or greater. Other browsers are not supported. Chrome is installed by 
default on Live Capture servers and configured to operate properly. Windows is 
configured to permit Chrome to update automatically.

You can use Chrome on any workstation or other computer, regardless of the operating 
system, that supports Chrome.

For optimal viewing of Live Stream web app, set your monitor size to 1920 x 1080 or 
greater.
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Efficient Use of Capture Web Apps
When a user is logged into the Capture web applications, the web app consumes 
network and server resource cycles, particularly while viewing multiple channels. When 
viewed, each channel connects a thumbnail and preview stream to that instance of the 
web application. Multiple users connected to the web application can degrade its 
performance. Therefore, care must be taken to ensure that the Live web apps do not 
consume resources unnecessarily when not being used. 

WARNING: Windows IIS allows for a limited set of web socket connections to 
applications. Over an extended period, if Capture web apps are opened in 
multiple browsers, the web server and browser may exceed the connection limit. 
This results in thumbnails and previews not displaying in the web apps. To avoid 
this situation, close any browser connected to the Live Capture Portal that are 
not being used.
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Launching Lightspeed Live Web Applications
Note: This topic applies to all Live web apps except the Source Manager web app. For 
details on launching Source Manager, see Managing Video Sources. 

Most Lightspeed Live web apps are launched from Vantage’s web portal, which 
requires logging in to Vantage. Logging in to a Vantage domain from a web application 
is a bit different than logging in from a Vantage Windows client application, such as 
Workflow Designer. 

To start Live Capture | Tape Capture | Live Schedule Pro web applications (or other 
Vantage client web apps), do the following:

1. Display the Vantage web portal—open Chrome and enter one of these URLs:

http://<IISServerName>/Vantage where <IISServerName> is the DNS name of 
the IIS server—by default, the same as the Vantage domain server

OR

If you’re running Chrome directly on the server which hosts Vantage, enter 
http://localhost/Vantage.

Vantage displays its web portal (also referred to as the Vantage home page). 
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Note: If you don’t know your Vantage domain’s server name (by default, the server 
where the Vantage domain database is hosted), contact your Vantage administrator / 
IT department.

2. Click on the panel for the web app you want to launch.

3. If you’re prompted to log in to Vantage, enter your credentials.

Note: If you’ re not authorized to log in, contact your Vantage domain administrator.

The apps that display in the Vantage web portal vary depending on your licenses. Click 
the web app you want to use. 

The first time you open the Live Schedule Pro web app, you must use the Vantage web 
portal (http://localhost | <host name>/Vantage/). This creates a cookie for a persistent 
connection to the Vantage Live Service. Opening the Schedule web app for the first 
time directly via the URL bypasses this process, resulting in the error No client 
connection to Live server.

Note: If you are logging into a web app from another workstation on the network, 
you may encounter a connection error: No client connection to Live server. Clear your 
browser cache and retry, determine if the Vantage Live Service is running and 
accessible, or go to http://<host name>/Vantage to display the Vantage web portal, 
and launch your web app there. Also, verify that the web app’s port isn’t blocked by a 
firewall (Firewalls and Blocked Ports Limit Functionality).
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Launching the Source Manager Web App
The Source Manager web app (see Managing Video Sources) is installed on every 
Lightspeed Live Capture server.

To start the Source Manager web app and log in, enter http://localhost:8090/ | http://
<Remote host name>:8090/ in your Chrome browser. 

Note: Unlike Capture, Tape, and other web apps, Source Manager does not utilize the 
Vantage web portal (Launching Lightspeed Live Web Applications) for launching or for 
managing user credentials. You can modify Source Manager user credentials using the 
Group Portal (see User Administration).

When you are accessing Source Manager locally (Chrome is running on the same Live 
Capture server as Telestream Live Source Service), use the keyword localhost. If you are 
accessing Source Manager remotely (Chrome is running on a computer that is not a 
Live Capture server), use the Live Capture server’s host name.

Source Manager displays the login panel:

Enter your user name and password. The default user name and password is admin/
live!. Users are defined using the Groups Portal web app (User Administration).

Logging Out of Source Manager
To log out of Source Manager, click the User icon in the toolbar at the top right corner of 
the window at the far right edge of the Source Manager title bar. Source Manager logs 
you out and immediately displays the Log In panel.

To log back in, enter your user name and password. The default user name is admin and 
the default password is live!, and it can not be altered. You can create additional users in 
the Group portal (see User Administration).
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Changing the Vantage Domain Name
If you have changed your Vantage server's host name (by default, it is used to name 
your Vantage domain), you should verify that the Lightspeed Live Capture web 
application is using the new domain name. The currently-connected domain name 
displays in the upper right corner of the web app:

If it is not connected to the correct domain, change the domain with these steps:

1. Click on Change Domain. 

2. Click OK to log out.

3. Click Search in the dialog that displays.

4. Select the correct domain, and click OK.

5. Enter the user name and password to log into the target domain. 
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Capturing Live Video

The Live Capture web application enables you to set up and configure SDI and IP-based 
sources and channels to capture live video streams via schedules or by gang recording. 
It also provides real time data, content previews, and status information on capture 
operations.  You can also use the Vantage Job Status Views web app to monitor capture 
jobs.

Topics
■ Using the Live Capture Web App

■ Using Triggers to Control Channel Recording

■ Recorded File Location and Format

■ Using the Vantage Job Status Views Web App

Note: For details on launching web apps and other general web app topics, see 
Managing your Web Apps.
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Using the Live Capture Web App
These are the key tasks you perform in the Live Capture web app:

• Configure and manage channels: information, previews, and status

• Monitor a channel group’s status

• Configure labels, variables, and recordings

• Start and stop channel recording. Control the operation of each channel manually 
by an operator or automatically—via web services, SCTE-104 (automatic—no oper-
ator intervention), Live Schedule Pro, or recurring segment triggers.

This figure represents a typical Live Capture web app interface, a panel selector to the 
left, and the Channel Preview panel with the selected channel’s (far left—note the blue 
bars, top and bottom) preview and details to the right:

Channels 
Preview Panel

Display and 
Information Panel

Selection Panel Title 
Bar

User 
Logout

Change 
Domain

About 
Menu

Vantage 
Web Portal

Channel 
Cards
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Title Bar
The title bar at the top of the Live Capture web app provides these options: 

 

Selection Panel
The Selection panel—on the left edge of the window—where you can select among 
your channel groups, and view capture status, and channels.

 Channel Groups—Click Channel Groups to select a group from the list of available 
groups. This is the first selection you must make. See In the Vantage Management 
Console... to create at least Channel Group. 

 Status—Click Status to display the Job Status panel, which shows the status and 
jobs of all active workflows contained in the selected channel group. (See Channel 
Status Panel).

 Channels—Click Channels to display the Channel Previews and Display panels 
(see Channels Preview Panel).

Home—Click to open the Vantage web applications menu. 

User Name—Displays the current user name. Click and select 
Log Out if you want to log in as a different user.

Vantage Domain—Displays the Vantage domain to which you 
are connected. Click and select Change Domain to open the 
dialog to select a different Vantage domain.

Preferences—Displays the Preferences dialog, where you can 
set up recording confirmation preferences (see Setting Recording 
Confirmation Preferences).

About—Displays the About panel, and links to the user guide 
(this document), and application and support information. 
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Channels Preview Panel
When you select Channels, the Channel Previews panel displays a thumbnail of video 
on a channel card. One channel card is displayed for each active Live Capture workflow. 
Information, settings, and options are presented that are specified in each workflow. 

• The selected channel card, indicated by blue bars on the top and bottom, plays in 
the Display and Information panel to the right. 

• Use the toolbar and menus to control channel ganging—triggering multiple 
recordings at once, channel filtering, and recording settings.

• Each channel displays a channel name and displays a thumbnail of incoming video.

• Each channel displays a gray trigger type, a yellow gang/ungang button, a red and 
green Recording | Ready (Stopped) bar, and a yellow queued job bar.

• The More button provides access to menus for each channel. 

• The bottom right corner displays Record/Stop and Record Options buttons for one-
button recording and easy access to recording settings.

Channel Previews panel components are described in detail in the following topics:

■ Channel Previews Toolbar

■ Configuring Single-Channel and Custom-Ganged Recording

■ Channel Controls

■ Channel Options

■ Viewing a Channel’s Recording History

■ Display and Information Panel

■ Loss of Signal Behavior

■ Limited Bandwidth Behavior

Channel Cards
Selected Channel Card 
displays blue bars

This panel displays red in real 
time in the event of a failure.

Toolbar

Video status and 
timecode panel

Start and Stop 
recording buttons

Customize recording 
button

Gang button
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Channel Previews Toolbar
The Channel Previews toolbar displays several icons, each of which displays a set of 
commands or settings:

 Record All—Click Record All to record the currently-ganged channels. Record All 
operates in two different modes depending on whether time-shift has been enabled in 
the workflow. (See the Capture action help topic for details about time-shift.) Frame-
accurate gang recording may not be not reliable without using time-shift.

Effect of time-shifting for manual trigger workflows (does not apply to recurring 
segment workflows):

• When Time-Shift is disabled in the workflow, all channels start recording immedi-
ately with no attempt to synchronize the start timecode.

• When Time-Shift is enabled in the workflow, the system attempts to synchronize 
all of the selected channels to the same start timecode before starting recording. 
When recording starts, some portion of the frames in the time-shift buffer are 
added to the start of the recorded file (going back in time to included frames from 
the past). As a rule, add 10 seconds of time-shift for each ganged channel. For 

Gang Record 
All button

Gang Stop 
All button

Gang Channel 
menu

More buttonFilter button Name Filter 
Value button
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example, in a group capturing 12 channels (4 per server) each channel should be 
given 10 seconds of time shift (4 channels X 10 seconds per channel = 40 seconds 
per server). Buffer limits vary based on server, RAM, and media metrics. See Deter-
mining the Time-Shift Buffer Duration for details. 

Caution: When you are gang recording with Time-Shift, you should configure all 
channels with a valid timecode, connected to inputs with identical frame rates 
and set to the same timecode source. Otherwise, channels may fail to start.

 Stop All—Click Stop All to immediately stop recording all ganged channels in the 
channel group that have not been filtered out. 

 Gang Record menu—Select Gang Record to display a panel in which you can 
control gang recording. Gang recording allows you to trigger recording on multiple 
channels simultaneously without necessarily triggering all channels. 

Use this menu to turn gang recording on or off for all channels (Gang All/Ungang All), 
start/stop gang recording (Record Ganged), and set up customized gang recording to 
specify which channels are ganged (Record Ganged Custom). 

Frame-accurate gang recording is not reliable until you have a time shift of at least 10 
seconds applied to a channel, 15 seconds is better.

See Record All above for details about how Time-Shift affects gang recording. 

 Sort—Sort channel cards by Name | Source | Trigger. You can also drag & drop 
channels.

 Filter—Filter by typing portions of the workflow name to see only the channels 
that contain the typed characters. Use * as a wildcard character. 

 Global Metadata menu—Contains standard Variables and Custom Defaults.

Select Set Variables to set common variables for all channels. For example if you set a 
bound variable in Set Variables, the value for that variable is used in every recorded 
channel it is associated with, except when explicitly set in a workflow's Variable dialog.

Select Set Custom Defaults to specify a default base name for all channel files, and 
default global primary and secondary output locations. 

Values entered and saved in the Global Metadata menu are persisted in memory as 
long as the browser remains open. If no persisted value is present (for example, a new 
variable is assigned to a workflow that has just been activated), the default value 
configured in the Vantage Management Console is used. 

Note: Variable and label data entered while a channel is in the waiting state are 
applied to a job at the time the job is queued for recording. Variable and label data 
entered while a job is in a recording or pending state is applied to the next job 
queued.
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Configuring Single-Channel and Custom-Ganged Recording
Click Record Ganged - Custom  or click the Custom Record  button on the 
target channel to display the Record dialog and optionally, select which channels to 
include in the record operation and the settings to use for all channels. 

Channel Name(s)—For each Manual Trigger or Recurring Segment Trigger, displays 
the name of the workflow channel and the name of the input for that channel. The 
channels—for ganged recording—that are checked are included in the record 
operation.

Primary Output Location—Select a Vantage folder address book entry for the 
destination of the primary output, or use the default location specified in the Capture 
action workflow.

Secondary Output Location—Select a Vantage folder address book entry for the 
destination of the secondary output, or use the default location specified in the 
Capture action workflow. The secondary output must be enabled in the Capture action 
for each channel included in the record operation for this to be active.

Base Name—Enter a name for the Base Name token. This name displays in the job 
name and is only used in the output media filename pattern when the Base Name 
token is added in the Filename Pattern Editor in the Capture action for this channel. The 
Base Name entered is applied to all channels selected for recording. To add the Base 
Name token, see Configuring Primary and Secondary Outputs.
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Timed Recording—Enable Timed Recording so you can set start, stop, and duration 
times and options. Timed Recording is not active for channels configured to use Using 
Recurring Segment Triggers. 

• Start (Timecode)—If all selected channels have a common timecode, the values of 
Start are automatically entered. You may enter any desired timecode. 

Setting Start Timecode to a value that is less than 60 seconds in the past results in a 
recording starting immediately. For example, if the current timecode is 02:30:00;20 
and a start timecode of 02:30:00;18 is used in the job, recording begins immediately 
at the current timecode of 02:30:00;20.

Setting Start Timecode to a value that is more than 60 seconds in the past results in 
a job to be scheduled for recording in 24 hours. For example, if the current time-
code is 02:30:00;20 and a start timecode of 02:29:00;18 is used, recording begins at 
02:29:00;18 the next day (nearly 24 hours later).

• Stop (Timecode)—Specifies the timecode when recording should stop.

• Duration—When you enter a Start and Stop timecode, the resulting duration is 
automatically displayed. When Record Duration (see below) is enabled, the dura-
tion entered here is used. 

• Record Duration—When enabled, capture recording ignores the Stop timecode 
and stops when the Duration you specify is reached. When disabled, recording 
stops when the Stop timecode is reached, and the Mark-OUT frame is not included 
in the captured file.

• Ignore Discontinuity—When Ignore Discontinuity is enabled, recording ignores 
any timecode discontinuity if detected. When not enabled, recording stops when a 
timecode discontinuity is detected. See Timecode Break Recording for details.

Caution: When you enable Ignore Discontinuity, Live Capture suppresses time 
code errors—they are not displayed in the web app to alert you of a potential 
problem. If there are time code discontinuities on the tape, recording continues 
without interruption or warning.
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Channel Controls
Channel cards provide information and controls for each channel that has an active 
workflow. Here is a typical representation:

Trigger Type—Indicates the type of trigger that controls the channel:

Name—Shows the source name.

Thumbnail—Displays a still image of the channel input, updating about once every 3-
5 seconds (depending on server usage load). 

Timecode—Displays the current channel timecode.

 Gang Recording—Toggles gang recording for the channel. Yellow indicates it is 
on, and gray is off. You can only use channels configured with Manual | Recurring 
Segment | Web Service (when Manual Override is enabled) triggers in gang recording. 

 Icon  Trigger Type

 Manual Trigger

 DAI (Dynamic Ad Insertion) Trigger

 CalDAV Calendar Trigger

 Web Service Trigger

 Recurring Segment Trigger

Trigger Type

Thumbnail

Timecode

Current State

Channel Options: Labels, Variables, 
Recordings

Custom Record Options

Gang Record On/Off

Job Information—
displays red for failure.

Channel (Vantage Capture Workflow) 
using this stream

Source name or ganged source names 
(configured in Source Manager)

Record
Start |Stop

ST 2110 Only—Primary/secondary 
channel status: green live; red failure
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Current State—Indicates the current channel recording state by color and message:

• Green—Indicates the channel is ready to record, with a message of Ready (Manual, 
Recurring Segment, and DAI), Listening... (Web Service), or Awaiting... (CalDAV Cal-
endar).

• Yellow—In a transition state and preparing to record or stop.

• Red—Recording is occurring. The elapsed duration of the recording is displayed. A 
blue progress bar indicates the current recording progress. 

 Channel Options—Opens the Channel Options menu. See Channel Options. 

 Queued Job Information—Displays in yellow; the number displayed 
indicates how many jobs are queued to start. Click to display the Recordings panel, 
which displays information about the current, queued, and previous recordings. See 
Viewing a Channel’s Recording History.

 Failed Job Information—Displays in red when the associated job has failed 
due to a downstream error condition. Remains red until a new job is started; the 
number displayed indicates how many jobs are queued to start. Click to display the 
Recordings panel, which displays information about the current, queued, and previous 
recordings. See Viewing a Channel’s Recording History.

 Record/Stop—Click Record to start recording for the channel. If recording 
confirmation is enabled (Setting Recording Confirmation Preferences), Live Capture 
displays a confirmation dialog. When recording, click Stop to end recording. You can 
also start recording an event in the Event calendar—click on the event’s start icon (see 
Starting an Event Immediately).

Note: In Live Capture SW, if you have more than one active Capture workflow with a 
single Live Capture Software Only license (Live Capture Software Licensing), you can’t 
start recording. Only activate one Capture workflow or obtain more licenses.

 Record Options—Click Record Options to display the Record Options panel for 
the channel. See Configuring Single-Channel and Custom-Ganged Recording. 
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Channel Options
Select the  icon on a channel card to display the Channel Options menu.

Labels—When you are using labels in the Capture workflow for the channel, click to 
display the Configure Labels panel and adjust Label settings. The definition and 
contents of labels depends on the metadata labels you create and define in the 
Vantage Management Console and enable in the Capture action. You can use labels in 
downstream Vantage actions or transformed into text or XML for out-of-band delivery. 
To add labels to a Capture action, see Expected Labels.

Note: If label parameters are modified in the Vantage Management Console, the 
changes must be applied to the workflow’s Capture action so that they are updated in 
the Live Capture web app. 
To apply label updates:
    1. Put the workflow into edit mode and open the Capture action inspector.
    2. In Expected Labels, disable the target label(s); then re-enable them.
    3. Save the action and reactivate the workflow. 
Now, the updated label(s) displays the correct information in Live Capture.

Note: Variable and label data entered while a channel is in the waiting state are 
applied at the time the job is queued for recording. Variable and label data entered 
while a job is in a recording or pending state are applied to the next job queued.

Variables—Configuration parameters bound to variables during Capture action setup 
or via the Add Variables menu in the Capture action are displayed in the Customize 
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Parameters panel. You can turn selected variables on or off, enter configuration 
variables or adjust specific settings.

Any variable values entered and saved are persisted in memory as long as the browser 
remains open. If no persisted value is present (for example, a new variable is assigned 
to a workflow that has just been activated), the default value configured in the Vantage 
Management Console is used. 

Note: All variable values are passed to downstream workflow actions where they can 
be analyzed or used in your entire workflow.

Recordings—Displays the Recordings panel, which displays information about the 
current, queued, and previous recordings. See Viewing a Channel’s Recording History 
following.

Viewing a Channel’s Recording History
The Recordings panel provides information about the selected channel—queued, in-
process, stopped, or completed—and enables you to copy the output path to your 
clipboard for use in other applications, such as a web browser or video player. 

Note: Status details for Vantage Capture workflow can also be found in the Job Status 
Views web app. See Using the Vantage Job Status Views Web App. 
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You can not use multiple Capture actions in a workflow—when you attempt to add a 
second Capture action, Workflow Designer displays an error message, preventing from 
doing so.

The Recordings panel displays information in columns, described here:

Capture State—Indicates the real time state of the capture process (represented by 
the Capture action itself ) for this channel’s recording job:
 

Vantage Job State—Indicates the real time state of the capture workflow’s job in 
Vantage (which is set by the state of all actions in the workflow):

Icon Recording State

The current recording is complete.

In an idled state, either queued for or 
stopping recording.

Recording is in progress.

Recording has failed.

Icon Job’s Workflow State

The workflow’s job completed successfully.

The job is waiting or in progress.

The job has been stopped by the user.

The job failed. Check the Job Status View for 
details of failed jobs. See Using the Vantage 
Job Status Views Web App.
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Name—Displays the job name. The name varies for different trigger types and may 
include information such as base name, workflow name, or capture start time entries.

Duration—The duration that was specified to record, or the final duration. The Start 
Name—Displays the job name. The name varies for different trigger types and may 
include information such as base name, workflow name, or capture start time entries.

Duration—The duration that was specified to record, or the final duration. The Start 
and Stop timecode may also be displayed.

Primary Output—The primary output file name and location path. Click the  icon to 
copy the output path to your clipboard. You can paste the copied path into Windows 
File Explorer, then log into the Live Capture server to open the file with an appropriate 
application.

Secondary Output—The secondary output file name and location path. Click the  
icon to copy the output path to your clipboard.

Customization—Custom settings that apply to the channel.

Display and Information Panel
The Display and Information panel plays video and audio of the currently selected 
channel and provides channel status and other information, as shown in this example:

 

Workflow Name—Displays the channel workflow name.

Timecode

Primary Output

Preview display

Secondary Output

Preview Banner

Audio meters 
and controls

Workflow Name

Video/audio 
details

Capture workflow 
variables

Title bar color 
indicates current 
state—see table 
below.
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Primary and Secondary Filename Pattern and Output Location—Displays the 
location where the output file is saved and shows the filename pattern set for the 
channel. 

Preview Banner—The preview banner (directly above the Preview display) indicates 
the name of the workflow and the current state of the channel. When in the record 
state, it displays the elapsed time and a blue progress bar indicating the duration of the 
recording that has been captured.

Preview Display—Displays the content of the selected channel. 

Source File Selections—Displays which of these variables have been enabled in the 
Capture workflow.

Audio Meters and Controls—Displays audio levels for all audio channels. The Preview 
Display can play just one channel pair at a time. Toggle a channel pair on to hear the 
audio for that pair. A level display bar shows variations in the audio level with green, 
yellow, and red indications and a decibel scale. Includes up to eight audio pairs.

Timecode—Displays the current timecode. 

Video/Audio Details—Displays video resolution, frame rate, bit depth, number of 
audio channels, and whether captions are present.

Loss of Signal Behavior
If LOS is detected on an input at start-up and the state doesn’t change, then:

The thumbnail and preview displays the LOS Video Test Pattern with LOS overlay 
indicating that the input channel is currently in an LOS state. The input is set to a 
default, un-configurable frame rate and resolution. Starting a Capture recording when 
the input is in this state results in a job failure with an LOS error.

If LOS occurs after the input had good active video and channels associated with 
this input are not currently recording, then:

If Freeze on LOS is enabled the thumbnail and preview show the last frame of good 
video; otherwise, if Freeze on LOS is disabled the thumbnail and preview show the LOS 
Video Test Pattern. In either case the thumbnail and preview display an LOS overlay. The 
frame rate and resolution of the input is that of the previous active video. Starting a 

Preview Banner Current State

Ready for recording to be initiated—displays 
the Vantage Domain and the source name.

In a transition state, either queued up to 
record or stopping recording.

Recording is currently underway.
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Capture recording when the input is in this state results in an immediate job failure 
with an LOS error.

If LOS occurs after the input had good active video and channels associated with 
this input are currently recording, then:

If Freeze on LOS is enabled, the thumbnail and preview show the last frame of good 
video; otherwise, if Freeze on LOS is disabled, the thumbnail and preview displays the 
LOS Video Test Pattern. In either case the thumbnail and preview display an LOS 
overlay. The frame rate and resolution is that of the previous active video.

• Jobs that are recording with Ignore Lost Frames disabled in the workflow stop 
immediately. If the system is so configured, a new recording starts when the signal 
is regained. Enabling Ignore Lost Frames should not be necessary in most cases.

• Jobs that are recording with Ignore Lost Frames enabled continue capturing for 
their scheduled duration, and contain the frozen frame/color bar frame(s) or active 
video if it returns. When enabled, all input-related error messages are ignored with-
out warning and capture continues. 

Limited Bandwidth Behavior
If more than one second of preview data is buffered, a message displays, advising that 
the available resources are limited and audio is turned off in order to play video in the 
preview: “Preview is degraded due to resource limitations. See User Guide for details”. Likely 
causes of the problem include network bandwidth or CPU/GPU over-saturation (not to 
exceed 75%; less than 60% is recommended). Taking actions to reduce the load on the 
network and processors may resolve the issue. 
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Channel Status Panel
When you select Status in the left panel, the Channel Status panel displays the current 
state of each channel in the current channel group, including current recording job 
status, and the previous job history. See the descriptions below for display details and 
Viewing a Channel’s Recording History for Recordings panel details.

Channels—The status display left column lists the channels in the channel group. Both 
the name of the channel and its description are shown. The trigger type appears beside 
the name.

Jobs—The status display middle column shows the current (pending or in-progress) 
job for each channel. The job's name, scheduled duration, and current progress counter 
are displayed.

Labels—The Labels icon displays the Labels panel, which shows labels and associated 
values generated by the channel workflow.

Variables—The Variables icon displays the Variables panel, which shows variables and 
associated values used by the channel workflow. 

Captured Files—Primary and Secondary file outputs are listed. To quickly access 
captured files you can click the file name and path in the right-most column. The 
Captured Files panel displays. Click the  icon to copy a file output path to your 
clipboard. You can paste the copied path into your Windows File Explorer, then log into 
the Live Capture server to open the file with an appropriate application. 

Channels Jobs FilesLabels/Vars Change 
Domain

FiltersUserRecordings
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Filtering Job Status
 Channels—Select to filter the channel list by typing a portion of the 

channel name to see only the channels that contain the typed characters.

 Jobs—Select to filter by typing portions of the job name to see only the 
jobs in each channel that contain the typed characters. 

You can also select sorting options for additional refinements. 

Click X to clear the 
settings
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Setting Recording Confirmation Preferences
Use the Preferences panel to enable and disable start and stop recording confirmation 
preferences. Recording confirmation only applies to manual recording; it is ignored 
when recording is started by any other means.

To display the Preferences dialog, select the Live Capture’s More icon (to the far right in 
the title bar) > Preferences:

 

Starting Recording Confirmation
To display a confirmation dialog when you start recording, check the Prompt for 
Confirmation Before Starting Recordings control:

When you click the record button, Live Capture displays a confirmation dialog:

 

Live Capture won’t start recording until you click Confirm. If you click Cancel, the 
recording is canceled and no Capture job is started.

Stopping Recording Confirmation
To display a confirmation dialog when you stop recording, check the Prompt for 
Confirmation Before Stopping Recordings control.

When you click the record button to stop, Live Capture displays a confirmation dialog:

 

Live Capture won’t stop recording until you click Confirm. If you click Cancel, the 
recording continues uninterrupted.
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Using Triggers to Control Channel Recording
The trigger type that is specified in a Vantage Capture workflow’s Capture action 
determines the method by which channel recording is controlled—manually, by an 
operator, or automatically via DAI or a web service, for example. For information about 
selecting triggers and their options in a Capture action, see Configuring Trigger Settings.

Topics
■ Using DAI Triggers

■ Using Manual Triggers

■ Using Recurring Segment Triggers

■ CalDAV Calendar Trigger

■ Using Web Service Triggers

Using DAI Triggers
The DAI (Dynamic Ad Insertion) trigger enables automatic recording to start and stop 
based on incoming SCTE-104 markers contained in the VANC data stream of the 
workflow’s SDI input. Recording begins when a Start Program marker is detected and 
stops when an associated Stop Program marker with an Event ID that matches the Start 
Program’s ID is detected. Channels set to DAI trigger are presented in a read-only status 
unless Allow manual stop is checked in the Capture action to expose a manual stop 
button in the web app. 

The following steps explain how to set up a DAI trigger. Steps shown here may vary 
according to your requirements:

1. In Workflow Designer, create a Live Capture workflow and configure the Capture 
action to use a DAI trigger.

2. Load the rules XML file (example shown below) into the DAI configuration (using 
Select Rules File) and make other DAI configuration selections. The file must 
include program start and end triggers and the UPID (identifier) of an ad to insert.
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3. Use the Vantage Management Console > Variables panel to create a variable to 
extract the UPID value from the program triggers in the rules. (Using the UPID to 
populate a variable is optional.)

4. Use the variable in the Filename editor to capture the UPID value as part of the 
output base file name. (Using the UPID to populate the filename from a variable is 
optional.)

When the workflow operates correctly, the SCTE triggers in the source create a new job 
at the expected frame, the job stops at the expected frame, and the name of the 
inserted file matches the associated segmentation UPID.

The following example—the triggers element—illustrates a typical rules set:
<triggers>
<rule>
<description>Default Start - Program Start</description>
<captureaction>Start</captureaction>
<ignoreeventids/>
<extracttovariable variablename="segmentation_upid_name">
segmentation_upid</extracttovariable>

<scte104>
<multiple_operation_message>
<time_signal_request_data>
<pre-roll_time>0</pre-roll_time>

</time_signal_request_data>
<insert_segmentation_descriptor_request_data>
<segmentation_type_id>16</segmentation_type_id>

</insert_segmentation_descriptor_request_data>
</multiple_operation_message>

</scte104>
</rule>
<rule>
<description>Default Stop - Program End</description>
<captureaction>Stop</captureaction>
<ignoreeventids/>
<scte104>
<multiple_operation_message>
<time_signal_request_data>
<pre-roll_time>0</pre-roll_time>

</time_signal_request_data>
<insert_segmentation_descriptor_request_data>
<segmentation_type_id>17</segmentation_type_id>

</insert_segmentation_descriptor_request_data>
</multiple_operation_message>

</scte104>
</rule>

</triggers>
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Note:  SCTE-104 rules files may be complex. If you require assistance, contact 
Telestream Support (Obtaining Support | Information | Assistance) or your Telestream 
Sales Engineer for details on configuring them.

See Configuring Trigger Settings for specific DAI Trigger settings and details. You can also 
get help from Telestream Support in putting together workflows to enable DAI triggers.

Using Manual Triggers
The Manual start trigger enables you to control channel start and stop operation in the 
Live Capture web app. Click Record to display the Record panel so you can select 
settings for the record operation. You can also select the Record All option in the top 
bar of the Channel Previews panel to start the record operation for multiple channels. 

See Configuring Single-Channel and Custom-Ganged Recording for descriptions of the 
Record panel controls.

Using Recurring Segment Triggers
The Recurring Segment trigger enables you to capture files of the duration specified in 
the Capture action’s Recurring Segment control. Durations from 5 minutes to 8 hours 
are permitted. You can control when to start recording in the Live Capture web app by 
manually starting capture, via the API, or in Live Schedule Pro by adding an event, 

https://telestream.net/telestream-support/lightspeed-live/support.htm
www.telestream.net/telestream-support/lightspeed-live/support.htm
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unless the Capture action’s Begin Recording on Workflow Activation control is also 
enabled—in which case, recording starts as soon as you activate the workflow.

Note: For events in Live Schedule Pro, the recurring segment trigger workflow that 
you use should not have Start Recording on Activation enabled, and the optimal 
choice for the recurring segment scheme used in the workflow is Timecode. 
Events for a recurring segment trigger workflow do not indicate a Queued state—it 
transitions directly from Waiting to Recording at the start of the event. 
If any or all segments fail, Live Schedule Pro will not indicate the failure. 
Event recording does not start or stop on the exact boundaries as set by the event; 
typically the offset is in the realm of seconds. Add an extra minute to the event 
duration to ensure the full range of the event is recorded.

WARNING: If the video and timecode are not synchronized, time code 
discontinuities can occur. To avoid time code anomalies such as unexpected 
discontinuities and repeated time codes, always sync the incoming SDI frames 
with your chosen time code source. Failure to do so can cause recordings that 
stop abruptly or do not stop as expected.

The first and last segments captured may be shorter than the specified duration, 
depending on when the recording start and stop commands are initiated. 

In the Capture action, you can choose the method by which the duration is calculated, 
depending on your requirements.

The Timed Recording option doesn’t apply to recurring segments. See Configuring 
Single-Channel and Custom-Ganged Recording for Record panel controls.
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CalDAV Calendar Trigger
A CalDAV Calendar trigger enables you to record based on events in a CalDAV-
compatible calendar. Channels that are set to CalDAV Calendar trigger are displayed in 
a read-only status view in the Live Capture web app. For configuration details, see 
Configuring Trigger Settings.

Note: The CalDAV Calendar trigger is specifically for use with CalDAV calendars. It 
should not be used with events created in Live Schedule Pro. For details, see topics in 
the Scheduling Live Capture Sessions chapter in the Live Schedule Pro User Guide. 

Using Web Service Triggers
Use a Web Service trigger to perform live video capture using commands from the Live 
Capture REST API. You can queue up a maximum of 16 Web Service Trigger jobs per 
Live Capture host server at any one time. 

Channels set to Web Service trigger with Allow Manual Control disabled are presented 
in a read-only status view in the Live Capture web app. If Allow Manual Control is 
enabled, manual controls and web service data is present on the channel’s thumbnail 
card, allowing for full manual control (see Channel Controls for additional details). For 
more information see Configuring Trigger Settings. See Live Capture API. 
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Recorded File Location and Format
When recording is active, Live Capture output files are transcoded and written to the 
Live store or the path specified in the Live Capture action under Output Location in the 
Primary Output or Secondary Output. To set the output locations see Configuring 
Primary and Secondary Outputs. In addition, you can use the Push action to deliver 
proxy media to AWS S3 storage in real-time.

To access the recorded files from the Live Capture web app, see Viewing a Channel’s 
Recording History and Captured Files under the Channel Status Panel heading in this 
chapter.

Selecting Output Encoders and Format
The Primary Output and Secondary Output in the Capture action enable you to select 
the container format and the video and audio encoders to use for the captured output. 
You can create multiple output configurations, and allow an operator to choose which 
one to use for a given capture session. See Configuring Primary and Secondary Outputs 
for more information. 

Delivering Secondary (Proxy) Output to AWS S3
You can add a Push action to a Live Capture workflow immediately following the 
Capture action, to deliver Live Capture proxy (secondary) output to Amazon S3 object 
storage when executing in Open mode.

The primary use case is for delivering Capture action secondary proxy output (HLS | 
DASH) files to remote object storage. All segments and manifest/playlist files are 
pushed to S3 as soon as they are written or updated during Capture job execution.

Deleting Captured Files
It is important to configure the Live store correctly to ensure that captured files are 
deleted when jobs are deleted or expired. Otherwise, obsolete recordings build up in 
the Live store, possibly filling up storage unnecessarily. For details about Live store 
configuration, see Identifying Live Stores with a UNC Path. 
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Using the Vantage Job Status Views Web App
Job Status Views is a web application that enables basic Vantage job monitoring and 
management via a web browser. You can use Job Status Views to access job 
information and manage jobs in your Vantage or Live Capture domain from anywhere 
on the LAN, or via the Internet if you provide access to your Vantage domain.

The Job Status Views web app is ideal for use when you don’t have access to Workflow 
Designer, but want to monitor your jobs. 

You can use the Job Status Views web application to do the following:

• Display information about submitted jobs, including any errors that have occurred

• Sort and filter job entries

• Highlight and identify jobs in different states

• Troubleshoot job processing issues and view error messages.

The views that you see in Job Status Views are defined by Vantage administrators, who 
control which job information displays and which job control functions (such as the 
ability to delete a job) are allowed. 

Views may be public or private and are configured in the Vantage Management 
Console. Public views are available to everyone, and private views are for use by 
specified Vantage users. See Configuring Vantage and Updating Live Capture.

Displaying Vantage Job Status Views
To use the Job Status Views web App for Vantage or Live Capture or Tape Capture, click 
the Home button in the title panel to display the Vantage web portal.

Click the Home button to display 
the Vantage web app
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On the Vantage web portal, click the Job Status Views button.

The Vantage Job Status View web app displays in your browser.

Using the Vantage Job Status Views Web Application
The following shows an example of information provided in the Job Status Views web 
application, this example is set to display All Workflows.

Open Job Status 
Views
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If no job status information displays in Job Status Views, you should make sure that this 
feature has been enabled in the Vantage Management Console. Open the Vantage 
Management Console and select Application Configurations > Job Status Views. Check 
the Enable option, shown in the red circle in the image below, then click the Save icon.

Configuring Job Status Views Information
The information displayed in Job Status Views, and public or private access 
permissions, is configured in the Vantage Management Console. For details on 
customizing the Vantage Job Status Views see the Configuring Job Status Views topic in 
the Domain Management Guide on the Telestream web site.

message URL https://telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Capturing Tape Media

The Lightspeed Tape Capture web app enables you to capture media stored on tape. 
Using Live Capture, you can set up and control VTRs, create clip logs, and capture the 
clips, encode the media and save it as media files. You can also record whole tapes 
using Tape Capture. You can perform tape capture from most VTRs and video sources 
that support SDI I/O and RS422 control.

Note: Because Tape workflows require access to RS422-controlled tape devices, you 
can only use Live Capture systems hosted on a Lightspeed Live Server. Use on Cloud 
platforms or VM platforms is not supported.

This chapter describes the Lightspeed Tape Capture web application, and how to use it.

Topics
■ Pre-requisites to Using Tape Capture

■ Tape Capture Overview

■ Configuring a VTR Connection

■ Tape Capture Controls and Status

■ Checking on Job Status

■ Using the Tape Capture Web App

■ Resolving Tape Capture Error Messages

Note: For details on launching web apps and other general web app topics, see 
Managing your Web Apps.

Telestream recommends reviewing Pre-requisites to Using Tape Capture to ensure your 
system is configured properly before using Tape Capture.
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Pre-requisites to Using Tape Capture
Before you can use the Tape Capture web application to capture tape-based media, you 
must meet certain criteria:

• Your Lightspeed Live Server must be connected to a VTR or other compatible tape 
source. See Connecting VTR Systems.

• Your VTR-based SDI sources must be set up. See Configuring a VTR Connection.

• You should enable user administration and create Vantage accounts for each user. 
See Configuring Vantage and Updating Live Capture for instructions. 

• You should create at least one tape capture workflow in Vantage (workflows with a 
Tape action) and activate it. See Creating Tape Capture Workflows.
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Tape Capture Overview
These are the key features of Lightspeed Tape Capture:

• Complete tape log and capture functionality in an HTML 5 browser client

• Logging multiple tapes and marking clips to be extracted from tape

• Captures clips from tapes into output media files with selectable container/codec

• Support for metadata labels and variables

• Full VTR transport controls with standard keyboard shortcuts

• Audio meters with 8 selectable stereo pairs

• Full user account controls for administrators and general users

• Source input locking to prevent users from competing for the same source.

The Tape Capture web application is organized in several panels:

Title Panel—Displays the home button, Vantage domain and user name, controls to 
change domains, access the About menu, and to log out or log in.

Selection Panel—Select Channel Group and Workflows or shows Status View.

Workflow/Status Panel—Shows workflows (if selected) or job status (if selected).

Clip Log Panel—Shows and controls tapes, clips, and media.

Preview Player Panel—Plays video, displays audio (8 stereo), provides VTR controls.

Clip Log Panel Preview PlayerSelection 
Panel

Workflow/
Status User

Vantage Domain
About 

Vantage 
Web Portal
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Configuring a VTR Connection
To configure Tape Capture for VTR access, use the Source Manager web app (see 
Managing Video Sources) to set up your VTR-based SDI sources. 

Follow these steps to configure the VTR connection (if you have additional VTRs, 
configure and save each SDI source connected to a VTR):

1. Make sure the VTR is properly installed and operating, and connected to one of the 
SDI ports on the Lightspeed Live Server. See Connecting VTR Systems for details.

2. Switch the VTR to the appropriate remote mode for operation via RS422 control.

3. Open the Source Manager web app (Launching the Source Manager Web App) and 
select the SDI source you want to use for the VTR connection (SDI 1 input—here 
named LLPM SDI 1—shown selected):

The source you select should match the terminal number to which the VTR is con-
nected on the RS422 interface box. For example, when it is connected to channel 1 
(CH1) on the RS422 interface box you should select SDI 1 input in Source Manager.

When you select a source, its preview panel displays on the right.

5. Click the Edit button in the details panel toolbar to display the Configure Source 
dialog, and select RS422 from the Timecode Source menu.

6. Make changes to other settings as appropriate for your application.

7. Click Save to update the source configuration.

Toolbar
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Checking VTR Connection Status
Activate your tape capture workflow in Workflow Designer, and display the Monitor 
Status panel—the workflow’s origin action (Tape) should display this status: Initializing: 
VTR connected:

When the VTR connection is successful, use the Tape Capture web app to set recording 
parameters and control the VTR to play out the media from tape. When you play out 
the tape, the specified Tape workflow will start a job, capture the SDI stream and 
serialize it into the specified file.

Troubleshooting the VTR Connection
A problem that you may encounter is that the time code source is not set to RS422 in 
the source settings (see Step 5, preceding). If the time code source isn't set to RS422 the 
tape capture web app displays the Initializing: VTR not connected error in the Status 
field.

If you have an active tape capture workflow running in Vantage, but its Monitor Status 
displays Initializing: VTR not connected, solve the problem using these steps: 

Note: After performing each step above, in Workflow Designer, check the workflow’s 
Monitor Status panel again, to see if the Status has changed to Initializing: VTR 
connected.

1. Make sure that the RS422 interface box is correctly installed, all adapters and cables 
are properly connected to the Lightspeed Live Server, and the VTR is powered up. 
See Connecting VTR Systems for instructions.

2. Check that the source of the Capture action matches the RS422 port to which the 
VTR is connected. For example, when using SDI 1 input for the Lightspeed Live 
Server in the Capture action you must connect to Channel 1 (CH1) on the RS422 
interface box. See Connecting a VTR to the Lightspeed Live Server for details.

3. Check that the RS422 interface box’s serial ports are shown in the server’s Device 
Manager. Open the Windows Device Manager and toggle open the Ports (COM & 
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LPT) devices. When properly connected, the ports of the RS422 interface box 
displays as USB Serial Port (COM3) through USB Serial Port (COM6) as shown here:

4. Check the properties for each USB port to verify that its settings are correct:

Bits per Second—9600

Data Bits—8
Parity—None
Stop Bits—1
Flow Control—None

5. In Advanced... confirm that Latency Timer (msec) is set to 1. For details on adjusting 
this setting, see Configuring RS-422 Port Latency Time. 

6. Verify that the SDI input associated with the VTR is connected to a live SDI video 
source.

7. If the VTR is not connecting after performing these steps, try replacing cables. 

When the VTR connection is successfully initialized, use the Tape Capture web app to 
set recording parameters and control the VTR to capture the media from a tape.
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Tape Capture Controls and Status
The Tape Capture web application provides controls, options, and status information to 
perform clip log and whole tape capture operations.

Selection Panel
The Selection panel at the far left enables you to view Channel Groups, Status View, and 
Workflows panels.

 Channel Groups—Click the Channel Groups button to select a channel group. 
This is the first selection you must make. See Step 10 in the Up and Running Checklist > 
In the Management Console topic. 

 Status—Click Status to open the job status view panel.

 Workflows—Click the Workflows button to display the active Vantage workflows 
in the selected channel group. 

Channel Groups
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Checking on Job Status
Click the Status button  in the menu to display the status of tape capture channels/
jobs.

Filtering Job Status (Far Right)
 Channels—Select to filter the channel list by typing a portion of the 

channel name to see only the channels that contain the typed characters.

 Jobs—Select to filter by typing portions of the job name to see only the 
jobs in each channel that contain the typed characters. You can also select sorting 
options for additional refinements. 

Channels—The status display left column lists the channels (workflow) in the channel 
group. 

Recordings—Click to display the channel recording list.

Job Status—Displays the current (pending or in-progress) job for each channel. The 
job's name, scheduled duration, and current progress counter are displayed.

Labels—The Labels icon displays the Labels panel, which shows labels and associated 
values generated by the channel workflow.

Variables—The Variables icon displays the Variables panel, which shows variables and 
associated values used by the channel workflow. 

Click X to clear the 
settings

Channels Job Status FilesLabels/VarsRecordings Filters
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Captured Files—Primary and Secondary file outputs are listed. To quickly access 
captured files you can click the file name and path in the right-most column. The 
Captured Files panel displays. Click the  icon to copy a file output path to your 
clipboard. You can paste the copied path into your Windows File Explorer, then log into 
the Lightspeed Live Server to open the file with an appropriate application. 

For details see the Vantage Job Status Views web app and Using the Vantage Job Status 
Views Web App. 

Using Vantage Tape Workflows
Click the Workflows button to display the active Vantage workflows in the selected 
channel group. Select a workflow to display its details:

This panel enables you to view sources, mark clips, and capture the media using this 
workflow, and view details about its configuration.

To create and use clip logs, the Log Panel displays the clip log for the selected tape 
source and enables you to add new tapes and select them. You use this panel to 
capture tape-based media in two ways: Capture the whole tape, or create and add clips 
to a log that you want to extract from the tape, and use the clip log to capture clips to 
media files.

Vantage Workflow—The Vantage workflow that is assigned to execute this capture 
displays in the tile bar. To select another workflow for this capture operation, use the 
Workflow panel (see Checking on Job Status).

Vantage 
Workflow Customize Parameters 

Clip Log Capture

Whole Tape Capture

Current Clip panel

Tapes panel Clips panel

Set Clip Order 
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For details about capturing the whole tape and capturing clips, see Capturing Media.

To use the Log Panel, use the default tape or add a tape and select it in the Tapes list, 
use the Preview Player and the current clip in the Clip Log to mark in and mark out the 
clip start and end points, and click Log to enter the clip into the log. Repeat as required, 
and when ready to capture the clips, click Capture. See below for control details. 

Note: To edit a timecode, click on any time unit and change its value, and tab 
between units. Press Enter to return focus to the entire timecode and retain changes. 
Press Escape to exit timecode edits without saving changes.

Clip Panel
Clip Name—Place the cursor in this field and enter a clip name.

 Use Current Preview Frame—Click to use the preview frame as the thumbnail.

 Remove Thumbnail—Click to remove the thumbnail image from the display.

 Mark In—Click to update the Mark In point to the tape’s current timecode position, 
or manually enter the timecode. Click the right arrow button  to cue the machine to 
the previously set mark in point.

 Mark Out—Click to update the Mark Out point to the tape’s current timecode 
position, or manually enter the timecode. Click the right arrow button  to cue the 
machine to the previously set mark out point.

Duration—The duration is calculated as the out time minus the in time. Enter a new 
duration in the timecode fields to change the duration. The out timecode changes to 
match and the in timecode remains the same.

When entering timecode in the In | Out | Duration fields, click on a pair of numbers and 
use the tab key to advance to the next pair of numbers in the timecode.

 Duration Lock—The lock feature allows manual editing when locked, but prevents 
the duration from changing automatically. When locked (lock top closed), duration 
always remains the same even though in and out times change. When unlocked (lock top 
open), duration can change automatically with changes to in or out times. Manual duration 
entries are always allowed whether locked or unlocked.

Click to disengage the lock and allow duration changes. Entering a new in timecode 
changes the duration timecode but leaves the out timecode unchanged. Conversely, 
entering a new out timecode changes the duration timecode but leaves the in 
timecode unchanged. 

Click again to engage the lock to protect the duration. Duration always stays the same 
unless entered manually. If you change the in timecode, the out timecode adjusts to 
match the new in time and the locked duration. If you change the out timecode, the in 
timecode adjusts to match the new out timecode and the locked duration. 
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 Metadata—Click the metadata button to open the Configure Labels dialog to 
access and modify metadata contained in any Label added to the Tape action. 

The contents of the metadata depends on the metadata labels you created in the 
Vantage Management Console and added to the Tape action. You can use labels in 
downstream Vantage actions or you can transform them into text or XML for out-of-
band delivery. To make labels see Configuring Vantage and Updating Live Capture, Step 
7. To add labels to the Tape action use the Expected Labels option, see Creating Tape 
Capture Workflows. 

Clip Logging
 Log—The Log button commits the current clip to the Clip Log using the 

associated mark in and mark out points, duration, label metadata, clip name, and 
thumbnail. Clips are associated with the currently selected tape name.

EDL File Import and Export
 Import—The import button imports a CSV-formatted clip list that was previously 

created and exported to a file. The imported file populates the Clip Log. 

You can import clips from a CSV file using the following format:

[Tape Name], [Clip Name], [Mark In], [Mark Out]

Example EDL (Edit Decision List) in CSV format: 

Tape 1,Clip 1,00:11:45:00,00:12:13:00

Tape 2,Clip 2,00:14:15:00,00:16:20:00

 Export—Use the export button to export the current Clip Log to a CSV clip list file 
that you can re-import again later. Exported lists are named [workflowname].csv (using 
the associated Vantage workflow name) and are exported to the default download 
folder specified by the Chrome browser. You can see and set the default folder in 
Chrome > Settings > Advanced Settings > Downloads.
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Capturing a Whole Tape
Capture a Whole Tape—To capture all of the media on a tape, click the Whole Tape 
Capture button. Tape Capture automatically creates a single clip with mark in and mark 
out timecode values that instruct Tape Capture to record the entire tape from the 
beginning to end and save it as a file, as configured in the Tape action of the target 
workflow.

Tape Capture displays the Capture Whole Tape dialog:

Configure these controls and click Capture:

Whole Tape Capture

Tape Name—(Default: Whole Tape Capture) When capturing to a QuickTime | 
QuickTime Open container as configured in the target workflow’s Tape action, specifies 
the tape name, which populates the Title metadata field in the file. 

Clip Name—(Default: Whole Tape Capture) Specifies the clip name; optional for whole 
tape capture.

Primary Output Configuration

Configuration—Specifies the container type; the list is generated from the target 
workflow’s Target action’s primary configurations, which may be one or more.
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Output Configuration—Specifies the location, which must be specified directly in the 
Tape action.

Secondary Output Configuration

Secondary Output Configuration—Specifies the container type; the list is generated 
from the target workflow’s Target action’s secondary configurations, which may be zero 
or more.

Output Configuration—Specifies the location, which must be specified directly in the 
Tape action.

When you click Capture, the tape rewinds to the beginning and captures the content 
on the tape until EOT (End of Tape) is reached. 

Note: Abort on Discontinuity is ignored when you are capturing a tape using the 
Whole Tape Capture button.

Source Display—The bottom of the panel displays the VTR source for the current clips.

Timecode Break Recording
To set up a timecode break capture—a process that automatically creates a new clip file 
when a break in the timecode is detected—make sure that the Tape action is 
configured in your workflow as described below.

The Timecode Break feature creates separate files when it detects a break in the 
timecode. To accommodate dropped frames when the tape was recorded, set the 
Frame Threshold control.

In the Tape action in your Vantage workflow, set these configuration options to control 
timecode break recording: 

You can set these options statically for every job. Or, you can bind them to variables for 
modification on a job-by-job basis. If you plan to modify these options directly in the 
Tape Capture web app, bind them to variables in the Tape action in your workflow, so 
that they are configurable in the Tape Capture web app; see Binding Variables to 
Configuration Controls. Activate the workflow to display your variables here and enable, 
disable, or change them using the gear icon  in the Tape Capture Customize 
Parameters menu.

After you’ve set up and configured your workflow, activated it, and logged your clips, 
click Capture to initiate timecode break recording. 
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Note: The following configuration options affect how files are created in a Timecode 
Break workflow. It is important to understand how each option affects the files that are 
created. Some experimentation may be necessary to create the results desired.

Discontinuity Threshold—Specifies the minimum number of skipped frames that 
constitutes a discontinuity (timecode break) state. This threshold affects both Create 
New File on Discontinuity and Abort on Discontinuity, when enabled. Note that 
decremented and repeated frames always count as timecode discrepancies, and for 
these discrepancies, the threshold setting is ignored.

Create New File on Discontinuity—When checked and timecode discontinuity is 
detected, specifies that the current media file is closed and a new media recording file 
is opened. During an active capture recording, if a discontinuity is encountered, the 
current capture file completes and a new media file recording immediately starts. 

Note: This feature is not functional in tape capture workflows where Primary Output 
or Secondary Output is configured to generate AVC | HEVC | MPEG2 video.

Timecode discontinuities are defined as follows:

• Timecode increments by a value equal to or greater than the selected Discontinuity 
Threshold value.

• Timecode repeats. The Discontinuity Threshold value is ignored in this case.

• Timecode decrements. The Discontinuity Threshold value is ignored in this case.

Example 1: A timecode incrementing from 00:00:30;10 to 00:00:30;15 is detected by a 
threshold of 4 or less.

Example 2: A timecode repeating from 00:00:30;10 to 00:00:30;10 is detected.

Example 3: A timecode decrementing from 00:00:30;10 to 00:00:29;00 is detected.

Abort on Discontinuity—Ends the current recording when timecode discontinuity is 
detected. Mutually exclusive with Create New File on Discontinuity. 

Note: Abort on Discontinuity is ignored when you are capturing a tape using the 
Whole Tape Capture button. See Capturing a Whole Tape. 

Ignore Frames When Servo is Not Locked—If enabled, all frames captured while the 
servo is in the unlocked state (as reported by the VTR) are excluded from the output file.

Create New File When Servo Relocks—If enabled, creates a new media file when the 
servo re-locks after being in the unlocked state. When a servo relock is encountered 
during an active capture recording, the current capture file completes and a new media 
file recording starts.

Note: This feature is not functional in tape capture workflows where Primary Output 
or Secondary Output is configured to generate AVC | HEVC | MPEG2 video.
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• If Create New File When Servo Re-locks is enabled and Ignore Frames When Servo is 
Not Locked is disabled, the system may create unwanted (unlocked) frames at the 
end of output files.

• If Create New File on Discontinuity is enabled and Ignore Frames When Servo is Not 
Locked is also enabled, the result may be an output file that contains a discontinu-
ous timecode, even though Create New File on Discontinuity is enabled and the 
timecode was always incrementing. This occurs because of the system ignoring 
frames, regardless of the timecode, while the servo is unlocked. With this configura-
tion, the frames captured during the period when the servo was unlocked are 
excluded from the output. New frames are added to the file when the servo re-
locks, which causes the output file to have discontinuous timecode. To avoid this 
scenario, enable the Create New File When Servo Relocks option. In this state the re-
lock of the servo starts a new file where the discontinuity in the output file would 
have been.

• As described above, repeating timecodes are counted as discontinuities. Most VTRs 
repeat timecodes when the servo is unlocked; therefore, if Ignore Frames When 
Servo is Not Locked is disabled and Create New File on Discontinuity is enabled, the 
result may be many single frame files while the servo is unlocked. This won’t hap-
pen if Ignore Frames When Servo is Not Locked is enabled.

• With many VTRs, particularly an SRW-5800, there may be gray frames after the 
servo re-locks. Timecode for these frames is often invalid. Because the system is 
only able to respond to the status the VTR provides, it won’t detect and exclude 
gray frames.

• No two passes of the same section of tape are likely to be identical. This occurs 
because the VTR can sometimes take longer than others to lock the servo after the 
control track is detected. Therefore, it is important to check the logs to verify 
whether the servo was locked while a specific frame was captured.

• For previous users of Telestream’s Pipeline tape capture product, enabling all three 
settings above provide the cleanest results and the closest to what Pipeline did. 

Tapes Panel
The Tapes panel enables you to create tape names and add them to the list. You can 
then associate clips with the names of the tapes where they originated. Do this by 
selecting a tape before selecting Log to log a clip or drag a clip from the Clip Log onto a 
tape to make the association.

+ (Plus)—Opens the Configure Tape dialog. Enter the name of the tape and click Save 
to save (or Cancel to cancel) the new tape to the Tapes list.

 Trash—Click trash to delete all tapes from the tape list.

 Modify—The modify (three dots) button opens a dialog to edit or delete the tape. 
Click Edit to view and modify tape details. Click Delete to delete the tape. Deleting a 
tape deletes the associated logged clips. Deleting all tapes deletes all logged clips.
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Clip Log Panel
The Clip Log displays a list of clips that have been marked for recording in the media 
output file. After you set up a clip in the Clip log panel, clicking the Log button adds the 
clip to the Clip Log. The name displayed for the Clip Log changes depending on which 
tape is selected. The format of the name is: Clips On + <Name of Selected Tape>.

 Captured Files Folder—To quickly access captured files, click the folder icon to 
display the Captured Files panel. Click the  icon to copy the file output path and 
paste it into Windows File Explorer. Then, log into the Lightspeed Live Server to open 
the file with an appropriate program.

 Metadata—Click the Metadata button to access and modify the Labels metadata 
list. The contents of the metadata depends on the metadata label(s) you created in the 
Vantage Management Console. See Metadata above in Clip Panel for more information. 

 Modify—Click the Modify (three dots) button to display a panel for selecting Edit 
Entry to view and modify clip details, or Remove Entry to remove the clip.

 Trash—Click the Trash icon to delete all clips from the clip log.

Capturing Media
Use these buttons (at the top right corner of the Log panel) to alter your clip stitching 
order and update workflow variables.
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Set Clip Order—Click to display the Clip Stitch Order panel:

This panel displays the list of clips in the clip log. To re-arrange their order, select a clip and 
use the up and down arrows to re-arrange the list. Or, drag-and-drop them on their new 
location in the list.

Customize Parameters—Click the gear icon to display the Customize Parameters 
panel and configure Tape action parameters that are bound to a variable so that you 
edit them here in Tape Capture, on a job-by-job basis. You can display any description 
contained in a variable—select the question mark tool tip (?) next to each parameter. 
The question mark (?) also provides a tool-tip to explain the parameter. Also see 
Configuring Tape Parameters that are Bound to Variables. 

Capture—Click the Clip Log Capture button to read clips in the clip log, encode them 
and write the media to a media file. When you click Capture, the Capture Clips dialog 
displays. 
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From Capture Clips you can make these selections for the capture operation: 

Primary Output Configuration—Select a container configuration that was added in 
the Tape action for the Primary Output. The configuration names are in alphabetical 
order and the full name is displayed. 

Output Location—Select a Vantage Folder Address Book entry or select Follow 
Workflow Specification to use the location set in the Tape action workflow. 

Secondary Output Configuration—Select a container configuration that was added 
or enabled in the Tape action for the Secondary Output. The configuration names are in 
alphabetical order and the full name is displayed. 

To add Primary and Secondary outputs, see Configuring Primary and Secondary Outputs. 

Activate Capturing

When you click Capture in the Capturing Clips dialog, the dialog closes and Capturing 
starts and the blue Capture button in the top bar changes to  during the 
recording operation. 



Capturing Tape Media
Checking on Job Status

167

LIve Capture User’s Guide

Monitoring Capturing

When a capture is in progress, the Clip Log indicates which clip is currently recording 
and which clips are submitted to be recorded. 

The time that has elapsed during the recording operation is displayed, along with a 
progress circle.

Using the Preview Player Panel
The Preview Player panel plays video and audio from the current VTR source so that you 
can locate and mark clips. The player includes these features:

• Includes audio level displays and controls for up to eight (8) stereo pairs

• Shows tape source video and audio details

• Contains a full set of VTR controls with standard keyboard shortcuts.

Source Lock

RS422 Indicator

Alarm (visible and red if 
active)

Tape In
Remote

Audio Levels

Audio On/Off

VTR Controls Cue

Source

Video/Audio Details
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Source Display—The upper left corner displays the VTR source currently playing.

Source Lock—Click to lock the current source to your user account. When locked, the 
source cannot be controlled by other users. Click again to unlock (lock top opens). Note 
that you can forcibly unlock a source; a dialog states the user name and domain of the 
person who has reserved the source. The source is automatically locked when any 
RS422 transport control is in use.

Tape In Indicator—White indicates a tape is inserted; red TAPE OUT indicates the tape 
is not inserted.

Remote Indicator—White indicates VTR remote control; red LOCAL indicates local 
control.

RS422 Indicator—White when Tape Capture has VTR control; red NO RS422 when not 
in control (and Tape and Remote indicators are hidden).

Alarm—Red Alarm appears below RS422 only if a problem occurs with the source.

Audio Level Buttons and Displays—Click a button to turn an audio pair on or off. 
When on, a level display bar shows variations in the audio level. 

Video/Audio Details—Displays video resolution, frame rate, bit depth, number of 
audio channels, and whether captions are present.

Cue—Cues video to the timecode you enter. Enter timecode and click the arrow to cue.

VTR Controls and Keyboard Shortcuts
The VTR controls operate in a standard fashion. Enter SHIFT+? to display the list of VTR 
keyboard shortcuts (shown below:
.

Buttons Keyboard Shortcuts Function

i Mark In

o Mark Out

p Log Clip

 j Rewind (press 1-3 times to increase 
speed)

[ Step Backward

k Stop

] Step Forward

Space Bar Play

l Fast Forward (press 1-3 times to 
increase speed)
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Using the Tape Capture Web App
This topic explains how to perform typical tasks using the Tape Capture web 
application, and presents them in the order you usually follow to capture clips. The 
display indicator state for on/off controls is:

•  Enabled

•  Disabled

Setting up for Clip Logging
Before you begin logging and capturing, you must make preliminary selections:

1.  Select a channel Group and VTR source in the upper left corner.

2.  Select Workflows and then select a specific workflow from the list.

3. Configure capturing using the steps in the next topics.

Creating and Naming Tapes
Before you begin logging clips you want to capture, you should create tapes in the Tape 
Capture web app to match the tapes you plan to use in the VTR to capture clips:

1. In the Tapes panel, click the + (plus) button.

2. Enter tape information and press Enter.

3. Repeat to create as many tapes as needed for the clips you plan to capture.

The tape name is embedded in the output of the QuickTime and QuickTime Open 
container (and Avid MXF OP-Atom when generated by an Avid workflow via the Flip/
Flip64 action) and is viewable in these applications: Final Cut Pro, Adobe Premiere Pro, 
and DaVinci Resolve. 

In DaVinci Resolve, the Assist Using Reel Names... setting must be changed for the Tape 
Reel Name to display. Go to File > Project Settings > General Options and enable Assist 
Using Reel Names and set it to Embedding in Source Clip File.

To disable the propagation of the tape reel name, in the Tape action of the target 
workflow, check Disable Tape Reel Name.
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Creating a Clip
To create a clip, make sure the VTR is connected and selected as the source, and follow 
these steps:

1. Insert the source tape for the clip into the VTR. The Tape In indicator on the Preview 
Player should be white.

2. Select a tape name in the Tapes list to associate the current clip with the tape.

3. Play or scrub the video using the VTR controls to find the point where you want 
your clip to start. 

4.  Click the Mark In button in the Clip Panel to set the start timecode of your clip. 

5. Play or scrub the video using the VTR controls to find the point where you want the 
clip to end.

6. Pick one of the two alternatives below as your next step:

 Click the Mark Out button to mark the ending timecode of your clip. The dura-
tion is calculated automatically.

Optionally, instead of marking an out point, you can enter a duration after marking 
in, and the ending timecode is calculated for you.

7.  Click the metadata button to open the Configure Labels dialog to access and 
modify metadata contained in any Label added to the Tape action (if any).

8. Click Log to create the clip and add it to the Clip Log.

Configuring Clip Stitching
Clip Stitching direct-converts the source clips from multiple tapes, and arrange the clips 
in the order you want to stitch them in the output file. During capture, individual files 
are created of each clip. When capture from all tapes is complete, the output file is 
created with the clips in the order they were arranged in the Clip Ordering dialog. 

To configure clip stitching, follow these steps:

1. Enable Clip Stitching in the Tape action, and then activate the workflow. 

2. In the Tape Capture web app, create a clip list for each tape, either using manual IN/
OUT/LOG or by importing an EDL. This is done for every tape to be included in the 
output file.

3. Select the Clip Ordering button to open the dialog that provides the ability to 
arrange the clips in the order that you want them to appear in the output file. The 
clips could be moved up/down either by drag/drop or by using up/down arrows. 

4. Set the Timecode Override value, if desired. If Timecode Override is not enabled in 
the Tape action, the output clip has an initial timecode of 01:00:00;00. 

5. Select any other configuration setting.

6. Select Capture.

a. The Web app captures just like it does in the non-Stitching mode, by asking for 
the first tape by name and wait for confirmation that the tape has been inserted 
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into the VTR. After confirmation, the Web app controls the VTR and captures 
each of that tape's clips in linear TC order.

b. After all clips for the tape have been captured, the Web app prompts you to 
insert the next tape and the same process (step 6a) is executed. This process 
continues until all clips from all tapes have been captured into individual files.

7. When complete, the system generates an output file that contains all of the clips in 
the order that they were arranged in the Clip Ordering dialog.

Capturing Clips
When your clip log is complete (the list contains all the clips you want to capture), click 
the Capture button to open the Capture Clips dialog. Select the Configuration method 
and Output Location, and then click Capture. 

Tape Capture begins recording and capture the clips in the log into corresponding final 
output media files. For multiple tapes, the Tape Capture web app prompts you to insert 
the first tape when you start the capture. 

If the Rewind tape setting is enabled, when all clips from the first tape are complete, 
Tape Capture sends the VTR a command to rewind the tape (Note that Rewind tape 
defaults to disabled.) The app also selects the next tape in the list, and indicates that a 
tape needs to be inserted. Then, insert the tape and press the Capture button to resume 
capture (the button displays yellow and reads Resume). 

Configuring Tape Parameters that are Bound to Variables
You can configure parameters that are bound to a variable—or any variable added to 
the Tape action via the Add Variables menu— in the Customize Parameters dialog. To 
bind variables to a control, see Binding Variables to Configuration Controls. 
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Click the gear button  next to the Capture button to display this dialog by:

The question mark (?) provides a description of the variable, if one has been added.

Setting Drop/Non-Drop Frame Characteristics
You can change between drop frame and non-drop frame in the Customize Parameters 
dialog to change the characteristics of the captured file. For this option to be available 
in the Customize Parameters dialog you must have Timecode Override Enable 
activated in the Tape action, and have it bound to a variable. See Creating Tape Capture 
Workflows > Settings Panel. 

To change between drop frame and non-drop frame:
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1. Click the Gear icon to open the Customize Parameters dialog.

2. Enable TC-Toggle to enable timecode override.

3. Select 29.97 fps or 59.94 fps if you want to use drop frame. (Drop frame is only 
available for 29.97 fps or 59.94 fps.) Select any frame rate for non-drop frame. 

4. Select the timecode by clicking it once or by selecting the line below it. When 
selected, the line and TC Override name displays in blue. (All numbers must be 
highlighted in white. If only one section of numbers is highlighted then you can not 
change between drop frame and non-drop frame.)

5. Type a semicolon “;” to set for drop frame, or a colon “:” for non-drop frame. The 
character should change in the timecode.

6. Click Save to save your changes and close the dialog. 

When the capture is activated the output file uses the drop frame or non-drop frame 
characteristic you have set. 

Creating a Stitched Clip 
The Clip Stitching feature allows you to create a list of clips from one or more tapes, 
arrange the clips in the order in which they should be stitched together, capture all the 
clips to individual files, and then create a stitched output file (or files) containing all 
captured clips in the order specified.

Note: When clips or tapes have different frame rates, the job stops at the stitch 
location where the frame rate changes. Frames rates must be the same for stitch 
operations to complete successfully. 

Follow these steps to create a stitched clip:

1. In Vantage Workflow Designer, open the Tape action to configure it. (See Creating 
Tape Capture Workflows for more details.)
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2. In the Tape action Settings panel, enable the Stitch Clips option by binding it to a 
True variable. (To bind variables in the Tape action, see Binding Variables to 
Configuration Controls.) 

3. In the Tape action, set the Stitch Behavior to Direct Convert and enable Is Output 
Stitched if required. See the Tape action Settings Panel. 

Note: Clip Stitching is only supported for MXF OP1a, QuickTime, and MP4 outputs.

4. When the Tape action workflow is configured, activate the workflow. 

5. In the Tape Capture web app, create the list of clips you want to log, either by using 
the Mark In > Mark Out > Log method, or by importing an EDL file.

6. When your Clip Log is complete, select the Clip Stitch Order button  to open 
the Clip Stitch Order dialog. Use the Clip Stitch Order dialog to arrange the clips in 
the order you want them in the stitched output file. You can re-order clips either by 
drag-and-drop or by using the up/down arrows next to each clip. 

7. After the clips have been ordered, adjust any other parameters, as needed. 

8. Click the Capture button to open the Capture Clips dialog. Select the Configuration 
method and Output Location, and then click Capture. 

9. Tape Capture begins recording and capture the clips in the log into corresponding 
final output media files. 

With multiple tapes, Tape Capture prompts you to insert the first tape when you 
start the capture. When the tape completes, Tape Capture selects the next tape in 
the log list, and indicates that tape should be inserted. Insert the tape and click the 
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Capture button to resume the capture (the button displays yellow and displays 
Resume).

10. Once all individual clips have been captured from all tapes, the system 
automatically creates a primary output of individual clips and a stitched clip, or 
clips, depending on your workflow settings.

11. You can process the primary and secondary files by any downstream action in the 
same way they are in the non-stitched mode. 

Recording an Entire Tape—Even if It Has Errors
Use the Whole Tape Capture button to record the entire tape, even if it has various 
errors, such as discontinuities in timecode, loss of the tape control track, or if alarms are 
triggered in the VTR.

Note: Abort on Discontinuity is ignored when you are capturing a tape using the 
Whole Tape Capture button. 

To record the entire tape and ignore errors, click the Whole Tape Capture button . 
Tape Capture automatically creates a single clip and enters Mark In and Mark Out 
timecode values that instruct the Tape Capture web app to capture the entire tape from 
the beginning of the tape to the ending of the tape. A dialog displays to confirm that 
you want to capture the whole tape. When you click CAPTURE, the tape is rewound to 
the beginning and captures the content on the whole tape until EOT (End of Tape) is 
reached. 

Alternatively, without using the Whole Tape Capture button, you can set the Mark In 
timecode to 00:00:00:00 and the Mark Out timecode to 23:59:59:00. When you start the 
Capture recording process, the tape rewinds to the start (no matter where it was 
parked) and tape playback and recording starts. When the end of the tape is reached 
recording stops. Abort on Discontinuity is detected when using this tape capture 
method.

Note: The capture progress indicator does not function when capturing an entire 
tape, since the duration is unknown. However, you can observe the timecode display 
to confirm the current state. Although, with tapes that have no timecode or are 
without a control track the true state cannot be known. Direct observation of the VTR 
may be necessary.
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Resolving Tape Capture Error Messages
A list of error messages and their resolutions is provided below. 

Loss of Signal

If you encounter a loss of signal condition while capturing a clip with Tape Capture with 
Ignore Lost Frames in the Tape action in your workflow disabled, the logged clip fails 
with this error: 

Event <Event Name> on <Channel Name> failed to capture. Loss of Signal detected. Error 
code = -19802. Data invalid.

You can avoid this by enabling Ignore Lost Frames in the Tape action.

Note: Enabling Ignore Lost Frames should not be necessary in most cases. When 
enabled, all input-related error messages are ignored without warning.
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Creating Live and Tape 
Capture Workflows

Live Capture uses Vantage workflows to capture live media—both SDI and IP-based—
as well as tape-based—and serialize it to files. Thus, you should know how to create, 
configure, and activate Live Capture Vantage workflows to utilize Live Capture 
effectively. Creating and configuring workflows is performed in Vantage Workflow 
Designer.

Topics
■ Creating Live Capture Workflows

■ Creating Tape Capture Workflows

■ Using Paths for Vantage Storage

■ Prototype Capture Workflow—Labels & Variables

The Vantage User Guide provides general information about topics related to creating 
and using workflows.
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Creating Live Capture Workflows
Before you can use Live Capture to capture a live streaming source, you must create 
and activate a Live Capture workflow (you may have several, designed to meet different 
requirements) in Vantage, which uses the Capture action to serialize a live video source 
controlled from the Capture web app or from a Capture API-based program into a 
media file.

■ Creating a Live Capture Workflow

■ Capture Action Overview and Configuration

■ Configuring Program Settings

■ Restricting Input - Frame Type and Frame Rate

■ Expected Labels

■ Configuring Trigger Settings

■ Using the CalDAV Calendar Trigger

■ Configuring Primary and Secondary Outputs

■ Delivering Proxy Media to AWS S3 Storage

Creating a Live Capture Workflow
This topic describes the general process of creating and configuring a Capture action 
workflow. 

This is a simple, example workflow. Your workflows may contain many more actions to 
implement your requirements. For configuration details, follow links or refer to online 
help directly in Workflow Designer.

Note: The Capture action is an Origin action. Only ONE Capture action is allowed in a 
Live Capture workflow. Workflow Designer displays the error “A workflow may contain 
only one Capture action” when you attempt to add the second Capture action to it.

Follow these steps to create and activate a Capture action workflow: 

1. Launch Vantage Workflow Designer.

2. Select File > Create New Workflow and name the workflow. You may also want to 
create a Category (File > Create New Category), which is a folder where the 
workflow is stored. The default workflow naming pattern is [Workflow 
Name]_[Source Name].

Note: To avoid workflow failures, do not use these characters in workflow names: 
               ` * | \ : ; " ' < > ? / 

https://telestream.net/telestream-support/vantage/support.htm
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3. In the Workflow Design panel, open the Live action category and add a Capture action 
to the workflow design workspace:
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4. Click the Inspector icon on the upper left corner of the action (or double-click the 
action) to open the Inspector.

5. Configure the action according to your requirements. For configuration details, see 
Capture Action Overview and Configuration. 

6. Click Save when you finish configuring the action.

7. Click Activate to start the workflow so that it is ready to start jobs when directed to 
do so by the Live Capture web app.

Note: Job expiration is set for 24 hours and is enabled by default. For details, click the 
? in the upper right to open the Vantage User Guide. See the Viewing and Specifying 
Workflow Details topic for information on adjusting the expiration time. 
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8. Display the Monitor Status tab to view the status of your workflow as it operates 
and provide details. Double-click a workflow for details:

When you activate a workflow, it begins to operate and communicate with the Live 
Capture or Tape Capture web application to accept the input you select, encode and 
package it into the format you specified in the workflow, and output the captured 
media package to the Live store location you specified. 

There are many more ways to monitor your workflow. To learn more, click the ? icon or 
use the Help menu to open the Vantage User Guide. 

Now, you are ready to log into the Live Capture web app and begin using it as 
explained in Capturing Live Video. 
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Capture Action Overview and Configuration
The Telestream Live Service and the Capture action are Vantage features enabled in a 
Vantage domain to support Live Capture and appropriately licensed. The Capture 
action is intended for use in conjunction with Lightspeed Live Capture, for the purpose 
of ingesting live and live-linear media directly into production, post production, and 
broadcast workflows and serializing it into a file for further, file-based video processing.

You use the Live Capture web application to start and stop capturing selected live 
video streams and deliver them to a Capture action workflow in Vantage. You can also 
use Lightspeed Live Capture API to create custom programs to control Vantage capture 
workflows. Additionally, you can schedule and automate capture events using the Live 
Schedule Pro web app.

Live Capture ingests 3G and 12G SDI, plus RTMP, Transport Stream, SRT, NDI, and ST 
2110 IP sources via the Telestream Live Service. Live Capture decodes the source to 
digital baseband in real-time, and delivers it to the Vantage Capture action for 
encoding and serialization. Sources are defined using the Lightspeed Live Source 
Manager web app.

Caution: Workflows containing more than one Capture action are not 
supported. When you attempt to add a second Capture action, Workflow 
Designer displays the error: A workflow may contain only one Capture action.

The container and codec selected in the Capture action specify the encoding and 
format of the output file. The encoded media is captured to a primary file stored locally 
or copied to external SAN/NAS storage, also based on the Capture action configuration. 
At the same time, a secondary proxy file may also be configured and produced.

Note: Most MXF files, and QuickTime Open files are created in such a way that they 
can be opened for editing/playing while they are still growing during capture. Check 
with your edit/player application guide for details about supported formats.

As an origin action, the Capture action can only be used to begin a workflow. It may 
optionally be the only action in the workflow. A capture workflow can also include 
additional actions to meet processing requirements, such as a Populate action or other 
transcoding (using a Flip action, for example). Or, it may contain Move or Copy actions, 
to replicate the captured file to other locations.

The Capture action can operate in normal mode or Open Workflow mode. In Open 
Workflow mode, successive actions in the workflow execute concurrently as soon as the 
media is presented to it, dramatically speeding workflow execution. In workflows 
where actions execute normally (serially), the Capture action serializes the input stream 
and, when recording stops, passes it to the next action (if any) in the workflow, an so on 
through all the actions in the workflow. 

A Vantage domain supporting Live Capture has an Open Workflows license by default. 
Thus, you can execute the Capture action (and other Open-capable actions) in open 
workflow mode, significantly speeding media processing. Of course, in a workflow with 
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a single Capture action, the use of Open Workflow mode does not change the 
functionality of the workflow, because there are no downstream actions to utilize the 
file in the context of the workflow.

To enable Open Workflow mode on an action, right-click the action and select 
Workflow Mode > Open. (Open Workflows must also be enabled in the workflow and in 
the Vantage Management Console). See user guides in Workflow Designer and the 
Domain Console for details. 

The Capture action inspector enables you to select and configure live streams for 
specific processing, filtering, transcoding, and output.

Note: Controls with a green Browse button may be bound to an input variable to 
dynamically assign their setting or value. The variable must have a value when this 
action executes. You can assign the value to the variable in a previous action in the 
workflow or use the variable's default value. Click Browse to select the variable or 
create a new one.

Configuring Program Settings
Use the Program panel to configure the Capture action to meet your requirements.

The Program panel displays the source selection, variables to generate, and controls.

Source. Specifies the input source to use. For information on Source Inputs, refer to .

Channel Group. Specifies the name of the Group this workflow is associated with. You 
can add multiple workflows to each channel group you create, and then use channel 
groups in your Capture web apps to filter workflow selections, narrowing your view of 
workflows to those that are relevant to your work or focus. Channel groups, which are 
referred to as Nexus definitions in the Vantage Management Console, are created and 
managed using the Workflow Design Items > Nexus Definitions tab.

Generate Variables. Open this panel to specify which variables to generate for use in 
downstream actions:

Avid Master Mob ID 1 and 2 | Avid Source Mob ID 1 and 2. Check to update and 
publish the selected text variables to provide 1 or 2 sets of Master Mob ID and/or 
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Source Mob ID for use in a downstream Media Creation action, for Interplay check-
in of assets.

Workflow Name. Check to update and publish the selected text variable to provide 
the name of this workflow.

Primary | Secondary File Path. Check to update and publish the selected text vari-
able to the full paths for the primary and secondary container output.

Primary | Secondary Folder Path. Check to update and publish the selected text 
variable to provide the folder path for the primary and secondary container output.

Primary | Secondary Filename. Check to update and publish the selected text 
variable to provide the file name for the primary and secondary container output.

Start Timecode. Check to update and publish the selected variable to provide the 
starting timecode of the media.

Time-Shift. When enabled, allows ganged crash records to start all jobs on the same 
frame if time shift is applied, for manual trigger workflows only. This does not apply to 
recurring segment workflows, which have staggered start times. In a Capture workflow 
with Time-Shift enabled, the source input media frames are stored in a FIFO RAM buffer. 
This allows Lightspeed Live Capture to reach back in time and access media processed 
in the past, based on the value of the Time-Shift field. Since Live Capture's Time-Shift is 
always processing a source input's media frames, when recording is initiated, each 
frame stored in the Time-Shift buffer is available to be added to the captured file.

The number of seconds set for Time-Shift in Capture actions associated with this source 
should be less than or equal to the Max Time-Shift set in the Live Capture Source 
Manager web app. See Managing and Configuring Sources in the Lightspeed Live Capture 
User Guide for more information on setting Max Time-Shift.

Generally, for HD up to 30fps, the total for all source Time-Shift buffers combined 
should not exceed 80 seconds. At rates above 30 fps, the total should not exceed 60 
seconds. For UHD, the maximum should not exceed 10 seconds.

Timecode Override Enable. Check to enable override of the Input Source timecode 
with the one you enter in the Timecode Override control. When enabled, Timecode 
Override will override the Input Source timecode during a capture with the one 
specified and put this timecode at the beginning of the output file. 

Timecode Override. Specifies the timecode value. Enter the timecode to put at the 
beginning of the output file when Timecode Override Enable is checked.

Ignore Lost Frames. When enabled, allows capture to continue recording if a Loss of 
Signal | FIFO overrun/overflow | Loss of RS422 condition is encountered or if video 
format changes are encountered. If disabled, the capture will stop when it encounters 
these conditions. Enabling Ignore Lost Frames should not be necessary in most cases. 
For LOS details, see .

Delete files on failure. When enabled, the output files are deleted when a job fails or 
the workflow is deactivated while capturing. When not enabled, output files from failed 
jobs are retained. Depending on the cause of the failure and type of file being captured, 
the output files from failed jobs may be usable to the point where capture stopped.
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Enforce Required Labels to Record. When checked, when recording is started in the 
Capture web app, recording starts only if all label fields marked as required are not 
empty. If recording is prevented, an error displays indicating that the required label 
fields are empty. Update the fields in the label and retry. This feature is applicable to 
recordings started manually from the Capture Web app only.

Update Workflow. Update workflows allow you to trigger secondary workflows, which 
are often used to update metadata and notify external systems, such as Avid Media 
Central.

Create 708 Caption Data. (Default: enabled) When checked, 608 data is up-converted 
to 708 caption data. When unchecked, 608 data is not converted. The primary use case 
to disable this option is for SD broadcast formats that generally should not include 708 
captions.

When creating QuickTime / QuickTime Open media using the 608 caption track in a 
QuickTime container, Create 708 Caption Data should be disabled.

Process Stagger Duration. (Default: disabled) When several jobs are submitted to Live 
Capture at the same time - particularly immediate (aka crash) recordings - the surge in 
resource requirements may cause one or more recordings to fail. Supply a unique value 
greater than zero for each Capture workflow to cause jobs that are submitted to the 
other workflows during the stagger duration period to have a delayed initialization.

For crash recordings, non-zero Process Stagger Durations are intended to delay the 
start time of some jobs, when multiple jobs are submitted simultaneously.

For example, crash recording jobs are submitted to three workflows in rapid succession:

 - Workflow 1, with a Process Stagger Duration value of 3 seconds

 - Workflow 2, with a Process Stagger Duration value of 5 seconds

 - Workflow 3, with a Process Stagger Duration value of 0 seconds

In this example, workflow 1 will initialize upon submission. Workflow 2 initialization is 
delayed by 3 seconds after workflow 1, because of the Process Stagger Duration value 
entered for workflow 1. Workflow 3 initialization is delayed by 5 seconds after workflow 
2, because of the Process Stagger Duration value entered for workflow 2.

The Process Stagger Duration delays the initialization of the capture process, but not 
necessarily the start time of a timed job. Assuming a timed recording is submitted with 
an adequate buffer for initialization for all Capture Record processes to complete 
(approx. 30 seconds to one minute), the recording will be frame accurate with respect 
to the starting time code.

Hide Secondary Outputs. (Default: disabled) When this control is enabled, the paths 
to secondary outputs are not added to the Vantage binder for the job. The HLS manifest 
files (*.m3u8) are still added to the binder, but the *.ts fragments are not.

Enable this control when generating HLS secondary output (which by design creates 
many files compared to primary), where it adds significant load on the Vantage Live 
Service, as all fragments are added to the job history. The HLS secondary files in this 
specific case must be written to external storage (for example, a MAM) and not the 
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internal Live Store. Enabling this control results in secondary output not being cleared 
from storage when the Vantage job expires, and the storage location used by this 
Vantage secondary output is managed externally to Vantage.

Restricting Input - Frame Type and Frame Rate
When enabled, the Capture workflow is restricted to a specific combination of frame 
type and frame rate. This setting applies only to the Manual trigger or any trigger that 
has Allow Manual Control enabled. 

Select Frame Type. Specifies the frame type/size to use for the restriction. 

Frame Rate. Specifies the frame rate to use with the selected frame type.

The following are the available combinations of frame type and frame rate:

- 2160p-4K: 23.98, 24, 25, 29.97, 30, 50, 59.94, 60

- 2160p-UHD: 23.98, 24, 25, 29.97, 30, 50, 59.94, 60

- 1080i: 25, 29.97, 30

- 1080p: 23.98, 24, 25, 29.97, 30, 50, 59.94, 60

- 720p: 50, 59.94, 60

- 625i-PAL: 25

- 525i-NTSC: 29.97

Warning Only. Check when you want to start and stop manual recordings in the 
Capture Web app with settings that do not match the selected restrictions. The 
warning message Format Mismatch displays on the channel card in the Live Capture 
web app, but recording continues. 

Operation When Restrict Input is Enabled
When Restrict Input is enabled AND Warning Only is NOT enabled, the Record button 
and Gang Record icon are disabled when settings do not match. No recording can be 
started via the Capture web app. This restriction applies to the Manual trigger and any 
trigger that has the Allow Manual Control option enabled.

When Restrict Input is enabled AND Warning Only is IS enabled, manual recordings can 
be started and completed with settings that do not match the selected restrictions. The 
warning message Format Mismatch is displayed on the channel thumbnail card in the 
Capture web app, but recording will continue. 

Automatic Triggers Record When Restrict Input is Enabled
Automatic triggers, such as Web Service, DAI Trigger, and CalDAV Calendar will record 
even when Restrict Input is enabled and settings do not match UNLESS they have the 
Allow Manual Control option enabled. See Operation When Restrict Input is Enabled 
above for behavior when the Allow Manual Control option is enabled. 
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Expected Labels
Enable Labels to enable operators to update label values in the Live Capture web 
application and process them in the Capture action or downstream in the workflow. 
Labels can be used in downstream Vantage actions, typically to update or add 
properties in Interplay, or transformed into text or XML for out-of-band delivery. 

Labels that are enabled can be configured in the Live Capture web app Channel 
Options > Configure Labels dialog. Label creation and design is performed in the 
Vantage Management Console. 

For more information on creating labels, search the Lightspeed Live Capture User Guide 
for Create Labels and Variables for the Tape and Capture Actions. To update Labels in the 
Live Capture web application, search for Channel Options.

Note: If label parameters are changed or modified in the Vantage Management 
Console, the changes need to be applied to Capture actions that use them, so that 
they display correctly in the Live Capture web app. 
To apply label updates to a Capture action, you must:
    1. Put the workflow into edit mode and display the Capture action inspector.
    2. In Expected Labels, disable the target label(s); then re-enable them.
    3. Save the action and re-activate the workflow. 
Now, the updated label(s) will display correctly in the Live Capture web app.

Configuring Trigger Settings
Use the Trigger panel to select the method you want to use to control live video input, 
and to configure trigger settings.

You can implement the following triggers: DAI |Manual | Recurring Segment | CalDAV 
Calendar | Web Service. Proceed to the appropriate topic for configuration details, 
following.

Note: When you use Live Schedule Pro to schedule recordings, only Web Service, 
Manual, or Recurring Segment triggers are supported.

Select. Choose DAI |Manual | Recurring Segment | CalDAV Calendar | Web Service. 
Proceed to the appropriate topic for configuration details, following. 

DAI Triggers
The DAI (Dynamic Ad Insertion) Trigger enables automatic recording to start and stop 
based on incoming SCTE-104 markers contained in the VANC data stream of the 
workflow’s SDI input. Recording begins when a Start Program marker is detected and 
stops when an associated Stop Program marker with an Event ID that matches the Start 
Program’s ID is detected. See details below. 

You can not use DAI triggers to create events in Live Schedule Pro. DAI triggers are 
implemented directly in the Vantage Capture action.
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Single, unique files are created for each Capture event.

Note: A Time-Shift buffer of 10 seconds is required when using the DAI Trigger.

Start Preroll. Enable to set the number of frames to pre-roll the start trigger. 

Stop Preroll. Enable to set the number of frames to pre-roll the stop trigger. 

Default Start Behaviors for DAI Trigger

A recording is started by the Capture action when one of the following is seen attached 
to a sample on the source:

- SCTE splice insert data with Splice_Insert_Type = 3.

- SCTE time signal data with a segmentation type ID of 0x10 indicating Program Start.

Default Stop Behaviors for DAI Trigger

A recording is stopped by the Capture action when one of the following is seen 
attached to a sample on the source with the corresponding Event ID:

- SCTE splice insert data with Splice_Insert_Type = 1.

- SCTE time signal data with a segmentation type ID of 0x11 indicating Program End.

Select Rules File. Browse to select the XML rules file used to enable automatic 
recording to start and stop based on SCTE-104 markers.

Allow Manual Stop. When enabled, DAI jobs can be manually stopped via the 
Lightspeed Live Capture web application.

Note: SCTE-104 rules files can be complex. Best practice is to contact a Telestream 
Sales Engineer for details on configuring them correctly.

Manual Triggers
Select Manual to trigger video capture manually, using the Record button in the 
Lightspeed Live Capture web application.

Note: If you are using the Lightspeed Live Capture web application to control 
capturing, you must set the Trigger option to Manual so the web app can control the 
recording of input channels. 
You can also use manual triggers when creating events in Live Schedule Pro.

Recurring Segment Triggers
The Recurring Segment trigger enables you to capture files of the time duration 
specified, from 5 minutes to 8 hours, and it repeats indefinitely. You control when to 
start recording and when to stop recording directly in the Live Capture web app, unless 
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Begin recording on workflow activation is selected, in which case, recording starts as 
soon as you activate the workflow.

You can also use Recurring Segment triggers when creating events in Live Schedule Pro 
to automate your start and stop times.

Repeating segments are created based on your specified segment duration calculation 
method and the specified duration. The first and last segments captured may be a 
shorter time than the specified duration, depending on when the recording start and 
stop commands are initiated. 

Port. Specify a port number (default: 19000) for the web service input that will trigger 
Live Capture. When activating multiple Capture workflows simultaneously, you must 
use unique ports. The program interacting with each workflow must be configured to 
use the same port number for execution of Capture operations.

Segment Duration. Specifies the time duration of recurring segments: 5 min. | 10 min. 
| 15 min. | 20 min. | 30 min. | 1 hr. | 2 hr. | 3 hr. | 4 hr. | 6 hr. | 8 hr. The default is 5 minutes. 

Note: When you set the Primary Output of your workflow to use a QuickTime Open 
container, you should also set the Default Duration in the QuickTime Open general 
configuration to the same duration as the segment duration.

Duration Calculation Method. Specifies the method used to determine start and end 
points per segment: Midnight | Timecode | Duration. 

Midnight - Segments are created on evenly-divided time boundaries starting at 
midnight, based on the duration selected. For example, if you specify a 15 minute 
segment, there are 96 divisions. The first segment stops at the next 15 minute 
boundary, and all repeating segments start and stop at 00:00, 00:15, 00:30, and 00:45. If 
you specify a 2 hour segment, there are 12 divisions, and the first segment stops at the 
next 2 hour boundary, and all repeating segments start and stop at 02:00, 04:00, 06:00, 
etc. 

When capturing a recurring segment, Capture attempts to start new segments at the 
exact start of a minute, and the job name reflects this in the naming convention: 
record-HH:MM:SS:00. If the start time is only an estimate, the name reflects the 
estimated start time of the segment, and the delineation for seconds is omitted from 
the name: [base name]-~HH:MM. If the service fails to retrieve a time code but the 
source is not in a LOS state, the name is [base name]-initial.

1 hour example:

Recurring Segment duration=1 hour

Segment 1 start=current timecode

Segment 1 end= xx:00:00:00 (where xx is the next hour, mark out point exclusive)

Segment 2 start=xx:00:00:00 (where xx is the next hour, mark in point inclusive)

The result is that all segments are the selected duration based on timecode, except the 
first segment and the last segment, if it is ended arbitrarily.
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Timecode - use when you want the start time code of the first segment to be the 
current timecode, and then advance the timecode by the segment duration you 
specified to determine the segment end point. 

For example:

Recurring Segment duration=1 hour

Current Timecode = 08:00:03;22

Segment 1 start = 08:00:03;22

Segment 1 end = 09:00:03;22 (exclusive out point)

The result is that the duration of all segments are determined by timecode, except the 
last one if it is ended arbitrarily.

Duration - use when you want the duration of each segment to be measured in frames, 
rounded to the nearest whole frame (an integer value). It is calculated using the 
specified segment duration at the video frame rate, taking into account drop frame or 
non-drop frame. This ensures that all segments have the same frame count. For 
example, a 5 minute duration segment at 29.97 is 8991 frames.

Begin Recording on Workflow Activation. When checked, a job starts and begins 
recording immediately upon workflow activation.

Enable File Count Naming Pattern. When checked, a numeric string is added after the 
base filename string, based on the number of digits you specify. The string starts at 1 
and increments for each segment recorded. 

Number of digits in file name. Specifies the number of digits in the incrementing file 
count string being applied to the current segment filename. For example, if you set it to 
4, files are specified as basefilename.0003.mxf.

CalDAV Calendar Triggers
The CalDAV Calendar Trigger enables you to record based on events on a CalDAV-
compatible calendar. For detailed instructions, see Using the CalDAV Trigger below. 

You can not use CalDAV Calendar triggers when creating events in Live Schedule Pro.

Note: When using the CalDAV Calendar Trigger you must set your TimeCode Source 
in the Vantage Management Console to either Computer Clock or Source. When using 
Source, you must have time-of-day timecode in your source that matches the time set 
in your Live Capture server.

Calendar. Enter the URL to the CalDAV calendar you want to use. 

Username. Enter the email address you use for your CalDAV calendar. 

Password. Enter the password you use to sign in to your CalDAV calendar.

Send Calendar Status Notification Emails. Check this option if you want to have an 
email sent when Capture is able to successfully connect to the CalDAV calendar upon 
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workflow activation, or when connection to the URL goes online, and when the 
calendar goes offline. The email goes to the address configured in the Vantage 
Management Console for the Administrator Email Address. If you have not received a 
notification email, check your spam folder, and then check your Vantage configuration.

Note: The email address for notifications must be properly configured in the Vantage 
Management Console > Settings & Options > Email tab. See the Vantage Domain 
Management Guide for detailed instructions. 

Allow Manual Control. (Use caution when enabling the Manual Trigger control.) When 
enabled, manual control via the Lightspeed Live Capture web application is allowed. 
Jobs can be immediately started using the manual controls in the same way as with the 
Manual Trigger.

In addition, scheduled jobs that have been added to the schedule record queue can be 
stopped and removed from the job queue. When a manual stop is issued, all scheduled 
jobs that are currently queued or are in the process of being recorded will be removed 
from the schedule queue. Jobs currently recording will be stopped and removed from 
the queue. New events added to the calendar will be added to the queue if they are 
within the 1-hour queue window.

If a CalDAV Calendar Trigger workflow is deactivated then reactivated, any scheduled 
events on the calendar that are within the 1-hour schedule queue window will be 
added to the scheduled capture queue regardless of any previous manual control.

Web Service Triggers
Select Web Service to trigger live video capture in a custom program, using commands 
from the Lightspeed Live Capture API. You can queue up a maximum of 16 Web Service 
trigger jobs per Live Capture server at any one time.

You can also use Web Service triggers when creating events in Live Schedule Pro.

Port. Specify a port number for the web service input that will trigger Live Capture or 
leave the default, which is 17000. When running multiple Capture workflows 
simultaneously, you must use unique ports. The program interacting with each 
workflow must be configured to use the same port number for execution of Capture 
operations.

Note: Do not use port numbers 8083, 8084, 8089, 8090, 15000, or 18000 for the Web 
Service input port. An error message does not appear when activating a workflow set 
to these ports, but the Web Service Trigger will not function. 

Create Metadata Log. When enabled, metadata log files are created that include frame 
numbers, the timecode value of each frame, and RS422 status (when RS422 is enabled). 
The log file is written to the output location along with the primary output.

Allow Manual Control. (Use caution when enabling the Web Service manual control.) 
When enabled, manual control via the Lightspeed Live Capture web application is 
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allowed, in addition to capture via the Lightspeed Live Capture API. Jobs can be 
immediately started using the manual controls in the same way as with the Manual 
Trigger.

In addition, web service jobs that have been added to the web service record queue 
can be stopped and removed from the job queue. When a manual stop is issued all web 
service jobs that are currently queued or are in the process of being recorded will be 
stopped and removed from the web service queue. 

Using the CalDAV Calendar Trigger
The CalDAV Calendar Trigger enables you to capture video based on events in a CalDAV 
calendar. When using CalDAV Calendar Trigger:

 - Each event must be at least 15 minutes in duration, or greater.

 - Event durations are restricted to a maximum of 9 hours. Events that are longer will 
stop recording automatically at 9 hours duration.

 - Event names cannot contain an accent grave character or any of the following 
characters: * | \ : ; " ' < > ? /  

You can not use CalDAV Calendar triggers when creating events in Live Schedule Pro.

Note: You must use a calendar that is dedicated to only contain events that are used 
for Lightspeed Live Capture. All events in the calendar are used for Live Capture, no 
matter what name they are given or other purpose they are intended for.

What Happens When a Queued Event is Deleted
If an event on the calendar has been added to the Capture queue (events are queued 
up when they are within 1 hour of their start time) and is subsequently deleted from 
the CalDAV calendar, its job status is reported as Complete in the Workflow Designer 
and the Job Status Views application.

- In the case where the deleted event had not yet started capturing, a 0K (zero K) sized 
file associated with the job will remain in the workflow's output folder location.

- In the case where the deleted event was in a capturing state when it was deleted, a 
playable file associated with the job will remain in the file's output folder location.

See Using the Job Status Views in the Lightspeed Live User Guide for more information on 
using this application.

Configuring Primary and Secondary Outputs
The output location, file name and nickname settings are set once for all primary and 
secondary outputs. Select the output location where the captured file should be 
written, optionally edit the file name using tokens or variables, and specify the output 
nickname for use by downstream actions operating on the file. 



Creating Live and Tape Capture Workflows
Creating Live Capture Workflows

193

LIve Capture User’s Guide

Output Location. Click Output Location and select from these choices.

- Vantage Store: Write the output to a Live Store. Select any available Live Store from the 
drop down list.

Telestream recommends creating a Live Store in Vantage and using it as the output 
location for efficient Capture operations. See Capture User Guide > Using Live Stores for 
Capturing Files for details.

- Path: Write the output to a specific Windows file system. Manually enter a Windows 
share (UNC path) or drive letter (not recommended on Vantage arrays) or click Browse 
to navigate and select the location. Or, click the green Browse button and select a 
variable which supplies the fully-qualified path.

Caution: In rare instances, two capture processes writing to the same path 
location folder may result in one file overwriting the other. To prevent this, the 
best practice is to use a unique folder location for each workflow, or append a 
Time token (set to mmm) to the file name in a workflow (configured in Edit 
Filename), which returns the current millisecond, thus altering the file name. 

Edit Filename. Displays the Filename Pattern Editor and specifies the pattern for the 
file you are creating. Default: Workflow Name - Source Name. Use the menu on the right 
to select one or more tokens to insert to create the exact filename pattern you require.

Available tokens:

- Base Name: Customizes the output file name with a name you enter in the Live 
Capture web application, or when passing a name token from the Lightspeed Live 
Capture API or CalDAV Calendar trigger.

- Workflow Name: Adds the name of the workflow as part of the file name.

- Source Name: Adds the name of the live source as part of the file name. 

- Variable: Choose and add a variable to the file name.

- Date: Adds the date as part of the file name.

- Time: Add the time as part of the file name.

Note: The time applied to the Time token represents the time that the output file is 
created. Files are initialize at different times based on the Trigger type being used.

The variable token is replaced by the value it holds when the action executes. The 
variable should be set prior to execution of this action. For example, if a variable token 
named ISCI is given the value 12H4JA678, wherever the ISCI variable token appears in 
the filename pattern it is replaced with that value.

Select Media Nickname. Click the menu to select the nickname (or enter it manually) 
for this new package file.

Add. Create a new Configuration Template, by first choosing the template's output 
container format from the Add menu. Specify a container type, enter a unique name in 
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the container’s Config Name field and configure container details in the panel on the 
right. Now, click on the video and audio streams on the left and configure them as well, 
in the panel on the right. Add all of the output configurations that you want to have 
available in the Live Capture web app. 

After logging clips, click the Capture button in the Live Capture web app to select the 
primary output container format you want to use for the capture operation.

Delete. Click the X icon on the right to delete the output from this action.

Delivering Proxy Media to AWS S3 Storage
You can use the Push action to write proxy media from the secondary output of an 
open, live capture-based workflow to AWS S3 in real-time.

Note: Push actions are intended for use in live, Capture action workflows operating in 
Open mode to write secondary HLS or DASH output to AWS S3 storage. Other uses 
have not been tested and may result in failure.

In addition to writing secondary output to your Capture server during transcoding, you 
can also deliver the Capture action’s secondary proxy output HLS | DASH media to AWS 
S3 remote object storage. All segments and manifest/playlist files are pushed to S3 as 
soon as they are written or updated during Capture job execution in Open mode.

To deliver media to AWS S3 object storage, add a Push action immediately following 
the Capture action: 

Configure the Push action with your AWS account information: region, bucket, target 
path, and credentials. For configuration details, see the man page—click the M button 
in the inspector’s toolbar.

Finally, right-click on the Capture and Push actions and set them to Open mode, as 
shown in this figure.

Note: Open Workflow mode must be enabled in the Vantage domain—in the 
Vantage Management Console, Select Settings & Options, and in the General tab, 
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check Enable Open Workflows. The workflow itself must the open mode enabled as 
well. In Workflow Designer, display the Workflow Details panel (click the disclosure 
button to the left of the workflow’s title bar) and check Open mode. 
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Creating Tape Capture Workflows
Before you can use the Tape Capture web application or API to capture tape-based 
media to a file, you should create and activate one or more tape capture workflows as 
needed, each of which uses the Tape action to make a video source available for 
Capture web app or API control.

Note: Only ONE Tape action is allowed in a Tape Capture workflow. Workflow 
Designer displays the error “A workflow may contain only one Tape action” when you 
attempt to add the second Tape action to it.

Topics
■ Tape Action Overview

■ Expected Labels

■ Configuring Primary and Secondary Outputs

■ Settings Panel

■ Creating a Tape Capture Workflow
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Tape Action Overview
The Telestream Live Service and the Tape action are Vantage features in a Vantage 
domain running on a Lightspeed Live server. The Tape action is used in workflows 
created for ingesting tape-based media via SDI in the Live Server and serializing it to 
files for further video processing.

You use the Lightspeed Live Tape web application to select sources and control 
recording during playout. You can also use Lightspeed Live Capture Web API to create 
custom programs to control Vantage capture workflows. 

The Tape action is used to start SDI tape capture workflows created in the Vantage 
domain installed on the Lightspeed Live server. The Tape action inspector enables you 
to select and configure VTR sources for processing, filtering, transcoding, and output. 
You can also use the action to add metadata labels.

The container and codec selected in the Tape action allow configuration of the 
encoding and format of the capture operation. The encoded media is captured to a 
primary file stored locally or copied to external storage. 

Note: Most MXF files, and QuickTime Open files are created in such a way that they 
can be opened for editing/playing while they are still growing during capture. Check 
with your edit/player application guide for details about supported formats.

As an origin action, the Tape action in a Vantage workflow begins the workflow, and it 
may be the only action in the workflow. A tape capture workflow may also include 
additional actions, such as a Copy or Move action, which can be optionally used to 
output the captured file to an additional location.

Use the Lightspeed Live Tape Capture web application to control VTR sources from the 
VTR Preview Player panel, log clips from tapes, and capture logged clips from tape to 
files. For information about the Live Capture web application, please see the Lightspeed 
Live Capture User Guide. The Lightspeed Live Tape Capture Web API can also be used to 
create custom programs to control tape capture workflows.

This action is open workflow capable if the Open Workflows license is installed; right-
click the action and select Workflow Mode > Open. Open Workflows must also be 
enabled for the current workflow and in the Vantage Management Console Settings.

Note: Controls with a green Browse button may be bound to a variable to 
dynamically assign their setting or value. The variable must have a value when this 
action executes. You can assign the value to the variable in a previous action in the 
workflow or use the variable's default value. Click Browse to select the variable or 
create a new one.

Inputs
The inputs are listed individually at the top of the inspector.
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Source. Select the input source to use from the Source menu. For more information on 
Source Inputs, refer to .

Channel Group. Specifies the name of the Group this workflow is associated with. You 
can add multiple workflows to each channel group you create, and then use channel 
groups in your Capture web apps to filter workflow selections, narrowing your view of 
workflows to those that are relevant to your work or focus. Channel Groups, which are 
referred to as Nexus definitions in the Vantage Management Console, are created and 
managed in the Workflow Design Items > Nexus Definitions tab.

Expected Labels
Enable Labels to allow operators to update label values in the Tape Capture web 
application and process them in the Tape action or downstream in the workflow. Labels 
can be used in downstream Vantage actions, typically to update or add properties in 
Interplay, or transformed into text or XML for out-of-band delivery.

Labels that are enabled can be configured in the Tape Capture web app - select the 
Channel Options > Configure Labels dialog. Label creation is performed in the Vantage 
Management Console. 

For more information on creating labels, search the Lightspeed Live Capture User Guide 
for Create Labels and Variables for the Tape and Capture Actions. To update Labels in the 
Live Capture web application, search for Channel Options.

Note: If label parameters are changed or modified in the Vantage Management 
Console, the changes need to be applied to Capture and Tape actions that use them, 
so that they display correctly in the Tape Capture web app. 
To apply label updates to a Capture action, you must:
    1. Put the workflow into edit mode and display the Capture action inspector.
    2. In Expected Labels, disable the target label(s); then re-enable them.
    3. Save the action and re-activate the workflow. 
The updated label(s) will now display correctly in the Tape Capture web app.

Configuring Primary and Secondary Outputs
You use the Primary and optional Secondary Output panels to create configuration 
templates that you can select in the Tape Capture web app. 

The output location, file name and nickname settings are set once for all primary and 
secondary configurations. Select the output location where the captured file should be 
written, optionally edit the file name using tokens or variables, and specify the output 
nickname for use by downstream actions operating on the file. 

Configuration templates can be added to each output type and consist of a container 
format and the video and audio codecs to be use for the captured output. There is no 
limit to the number of configuration templates you can create. 

Output Location. Click Output Location and select from these choices:
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- Vantage Store: Write the output to a Live Store. Select any available Live Store from the 
drop down list.

Telestream recommends creating a Live Store in Vantage and using it as the output 
location for efficient Capture operations. See Capture User Guide > Using Live Stores for 
Capturing Files for details.

- Path: Write the output to a specific Windows file system server and directory. Manually 
enter a Windows share (UNC path) or drive letter (not recommended on Vantage arrays) 
or click Browse to navigate and select the location. Or, click the green Browse button 
and select a variable which supplies the fully-qualified path.

Caution: In rare instances, two capture processes writing to the same path 
location folder may result in one file overwriting the other. To prevent this, the 
best practice is to use a unique folder location for each workflow, or append a 
Time token (set to mmm) to the file name in a workflow (configured in Edit 
Filename), which returns the current millisecond, thus altering the file name. 

Edit Filename. Displays the Filename Pattern Editor and specifies the pattern for the 
file you are creating. Default: Base Name. Use the menu on the right to select one or 
more tokens to insert to create the exact filename pattern you require.

Available tokens:

- Base Name: Select to add the base (clip) name as part of the file name. The Base Name 
token is populated with the Clip Name selected in Clip Panel of the Tape Capture user 
interface.

- Workflow Name: Select to add the name of the workflow as part of the file name.

- Source Name: Select to add the name of the live source as part of the file name. 

- Variable: Select to choose and add a variable to the file name.

- Date: Select to add the date as part of the file name.

- Time: Select to add the time as part of the file name.

The Variable token is replaced by the value it holds when the action executes. The 
variable should be set prior to execution of this action. For example, if a Variable token 
named ISCI is given the value 12H4JA678, wherever the ISCI variable token appears in 
the filename pattern it is replaced with that value.

Select Media Nickname. Specifies the nickname for this media.

Add. Create a new Configuration Template, by first choosing the template's output 
container format from the Add menu. Specify a container type, enter a unique name in 
the container’s Config Name field and configure container details in the panel on the 
right. Now, click on the video and audio streams on the left and configure them as well, 
in the panel on the right. Add all of the output configurations that you want to have 
available in the Tape Capture web app. 
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After logging clips, click the Capture button in the Tape Capture web app to select the 
primary output container format you want to use for the capture operation.

Delete. Click the X icon on the right to delete the output from this action.

Settings Panel
Specify settings to use for each output configuration. Binding a parameter to a variable 
makes the parameter configurable directly in the Tape Capture web app.

Generate Variables

Ignore Lost Frames. When enabled, allows capture to continue recording if a Loss of 
Signal | FIFO overrun/overflow | Loss of RS422 condition is encountered or if video 
format changes are encountered. If disabled, the capture will stop when it encounters 
these conditions. Enabling Ignore Lost Frames should not be necessary in most cases. 
For LOS details, see.

Pre-Roll Duration. Specifies the number of seconds that tape rolls before a scheduled 
recording begins. You can also assign a variable defined elsewhere in the workflow.

Note: Setting Pre-Roll Duration to 0 (zero) may have a use in some cases, such as 
capturing digital sources. A 0 (zero) setting could cause issues when capturing from 
tape sources. The default Pre-Roll is 3, which often works fine for a tape source. 

Post-Roll Duration. Specifies the number of seconds that tape rolls after a scheduled 
recording ends. You can also assign a variable defined elsewhere in the workflow. Note 
that the VTR stops only after all frames have been captured, so post-roll may continue 
longer than the duration you specify.

Timecode Override Enable. When checked, activates and overrides the Input Source 
timecode with the one entered in the Timecode Override control. When enabled, 
Timecode Override overrides the Input Source timecode during a capture with the one 
specified and puts this timecode at the beginning of the output file. All clips in the Tape 
clip list will have their timecode overwritten by this timecode.

Timecode Override. Specifies the timecode value to use to put at the beginning of the 
output file when Timecode Override Enable is active. 

Discontinuity Threshold. Specifies the minimum number of skipped frames that 
constitutes a discontinuity (timecode break) state. This threshold affects both Create 
New File on Discontinuity and Abort on Discontinuity, when enabled. Note that 
decremented and repeated frames always count as timecode discrepancies, and for 
these discrepancies, the threshold setting is ignored. 

Discontinuity Cooldown. When checked, delays discontinuity checking for the 
specified time. After a discontinuity is detected, additional discontinuities are ignored 
until the specified time (in seconds) has passed.

Create New File on Discontinuity. When checked and timecode discontinuity is 
detected, specifies that the current media file is closed and a new media recording file 
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is opened. During an active capture recording, if a discontinuity is encountered, the 
current capture file will complete, and a new media file recording will immediately 
start.

Time code discontinuities are defined as follows:

 - Time code increments: If time code increments by a value equal to or greater than the 
selected Discontinuity Threshold value.

 - Time code repeats: The Discontinuity Threshold value is ignored in this case.

 - Time code decrements: The Discontinuity Threshold value is ignored in this case.

Example 1: A time code incrementing from 00:00:30;10 to 00:00:30;15 would be 
detected by a threshold of 4 or less.

Example 2: A time code repeating from 00:00:30;10 to 00:00:30;10 would be detected.

Example 3: A time code decrementing from 00:00:30;10 to 00:00:29;00 would be 
detected.

Abort on Discontinuity. When enabled, capture aborts when a timecode discontinuity 
is detected as specified by the Discontinuity Threshold or when the VTR servo is not 
locked.

Note: Create New File on Discontinuity and Abort on Discontinuity options are 
mutually exclusive; when both are checked, Abort on Discontinuity takes precedence. 
That is, if discontinuity is detected, the job is aborted.

Ignore Frames When Servo is Not Locked. If enabled, all frames captured while the 
servo is in the unlocked state (as reported by the VTR) are excluded from the output file. 

Create New File When Servo Relocks. If enabled, creates a new media file when the 
servo relocks after being in the unlocked state. When a servo relock is encountered 
during an active capture recording, the current capture file will complete, and a new 
media file recording starts.

If Create New File When Servo Relocks is enabled and Ignore Frames When Servo is Not 
Locked is disabled, the system may create unwanted (unlocked) frames at the end of 
output files.

If Create New File on Discontinuity is enabled and Ignore Frames When Servo is Not 
Locked is also enabled, the result may be an output file that contains a discontinuous 
timecode, even though Create New File on Discontinuity is enabled and the timecode 
was always incrementing. This occurs because of the system ignoring frames, 
regardless of the timecode, while the servo is unlocked. With this configuration, the 
frames captured during the period when the servo was unlocked will be excluded from 
the output file. New frames would then be added to the file when the servo relocks, 
which would cause the output file to have discontinuous timecode. To avoid this 
scenario, enable the Create New File When Servo Relocks option. In this state the relock 
of the servo will start a new file where the discontinuity in the output file would have 
been.
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As described above, repeating timecodes are counted as discontinuities. Most VTRs 
repeat timecodes when the servo is unlocked; therefore, if Ignore Frames When Servo is 
Not Locked is disabled and Create New File on Discontinuity is enabled, the result may 
be many single frame files while the servo is unlocked. This will not happen if Ignore 
Frames When Servo is Not Locked is enabled.

With many VTRs, particularly an SRW-5800, there can be gray frames after the servo 
relocks. Timecode for these frames is often invalid. Because the system is only able to 
respond to the status the VTR provides, it will not detect and exclude these gray frames.

No two passes of the same section of tape are likely to be identical. This occurs because 
the VTR can sometimes take longer than others to lock the servo after the control track 
is detected. Therefore, it is important to check the logs to verify whether the servo was 
locked while a specific frame was captured.

Use Duration Over Markout. Ignores mark out and rolls tape for the specified duration 
regardless of time code.

Treat input as Progressive. Assumes input is progressive even if it is interlaced.

RS422 time code delay. Adjusts RS422 time code by specified number of frames. 
RS422 time code delay can be used to compensate for VTR decks requiring adjustments 
to frame timing. Frames can appear early or late, depending on the type and/or age of 
the VTR deck used. This adjustment compensates for VTR decks that are not 100% 
frame accurate (or for systems with routing latency to the associated timecode). Most 
VTR decks do not require this offset adjustment. If you have a VTR deck that requires 
this adjustment it is necessary to use a trial and error process to determine the correct 
offset. The default is 0, the minimum is -3 frames, and the maximum is +3 frames.

Rewind Tape. When checked, a Rewind command is sent to the VTR after capture is 
complete. If there are multiple clips on a tape slated for capture, the Rewind command 
is sent once; after all clip capture jobs have completed.

Stitch Clips. When checked, stitches the aggregated content from all captured clips 
into a direct-converted output file. See Stitch Behavior, below. 

Stitch Clip Base Name. Specifies the base name to use in job names and the Base 
Name part of the file name pattern. When blank, StitchedClip is the default base 
name.

Stitch Behavior. Specifies the stitched file behavior: Direct Convert, which can not be 
changed. Creates a self-contained output file for the Primary and/or Secondary 
outputs, which contains the aggregated content from all captured clips in the order 
specified by the user.

The output file can be used by a downstream action for additional processing.

Allow Secondary Output to be Disabled. Check to add the option to disable the 
secondary output in the Tape Capture web application. When selected, the "Disable 
Secondary Output" option is added to the Tape Capture web app Capture Clips dialog. 
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Note: When Allow Secondary Output to be Disabled is selected, no downstream 
processing can be done for the secondary output. With this enabled, you cannot save 
the workflow if it is set to process the secondary output. 

When you need to have downstream actions process the secondary output, but you 
want the option to disable the secondary output in the Tape Capture web app, add the 
Poster Frame secondary output so that can be selected in the web app as the disabled 
option. 

You must create one or more MP4 secondary outputs when Allow Secondary Output to 
be Disabled is selected, in order to have the option to enable and create a secondary 
output in the Tape Capture web app. 

Generate Variables. Select which variables to generate:

Is Output Stitched. When checked, enables the ability to detect if the output is 
stitched or not. Select or create a True/False variable to generate, which is used in a 
downstream action to execute the workflow based on the result. (Use a Decide action 
to test the variable and perform one branch or another.)

Primary Configuration. When checked, generates the specified variable to enable 
downstream actions to determine which configuration was used in this action. The 
variable contains the primary configuration that was selected by an operator for this 
job, in the Record panel of the Tape Capture Web app, which is selected from the menu 
that displays all of the primary configurations you have configured here in the Tape 
action to be available to the operator during tape capture operations.

Secondary Configuration. When checked, generates the specified variable to enable 
downstream actions to determine which configuration was used in this action. The 
variable contains the secondary configuration that was selected by an operator for this 
job, in the Record panel of the Tape Capture Web app, which is selected from the menu 
that displays all of the secondary configurations you have configured here in the Tape 
action to be available to the operator during tape capture operations. 

Avid Master Mob ID | Avid Source Mob ID. Check to generate variables to provide the 
Avid Master Mob ID and/or the Avid Source Mob ID for use in downstream actions. 
Then select the text variable you want to generate.

Workflow Name. Check to generate variable to provide the name of this workflow for 
use in downstream actions. Then select the text variable you want to generate.

Time Code Burn-in Filter
Check to enable this filter and configure it. The Time Code Burn-in filter writes the 
current value of the time code into the video frame at the specified location and font 
size, typically for use in proxy files.

Controls with a green Browse button can be specified dynamically, on a job-by-job 
basis by assigning a variable whose value has been set in an upstream action.
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X Position. The X position of the top-left of the timecode in the output video frame. 
The range is from 0 to 4096 pixels.

Y Position. The Y position of the top-left of the timecode in the output video frame. 
The range is from 0 to 2160 pixels. 

Font Size. Sets the font size of the timecode. The range is from 6 to 120 pixels. 

Text Color. (Default: White). Sets the text color of the timecode. You can enter simple 
color names, such as red, green, or white. Or enter a color hexadecimal code such as 
#0000DDFF, which is dark blue. The "FF" characters in this example specify the opacity, 
and are optional. When these characters are not included the text is completely opaque 
(no transparency). The pound sign (#) must be included with the hexadecimal code. 
When a color entry is not valid, the black default is used. 

Background Color. (Default: Black). Sets the color of the area behind the timecode. You 
can enter simple color names, such as red, green, or blue, or enter a color hexadecimal code 
such as #0000DD, which is dark blue. The pound sign (#) must be included with the 
hexadecimal code. When a color entry is not valid, the white default is used. 

Timecode Transparency. The opacity of the timecode. 1.00 is fully opaque, or 100 per 
cent opacity, 0 is transparent. 

Note: The burned-in Timecode will always represent the actual input timecode being 
used by the Input Source.

Creating a Tape Capture Workflow
Follow these steps to create and activate a tape capture workflow in Vantage: 

Note: Only ONE Tape action is allowed in a Tape Capture workflow. Workflow 
Designer displays the error “A workflow may contain only one Tape action” when you 
attempt to add the second Tape action to it.

1. Open Vantage Workflow Designer.

2. Select File > Create New Workflow to start a new workflow.



Creating Live and Tape Capture Workflows
Creating Tape Capture Workflows

205

LIve Capture User’s Guide

3. Drag a Tape action from the Live group to the design area. A tape capture workflow 
may consist of this one action. However, you can add other actions to perform 
additional functions. See Vantage Actions | Containers | Codecs. 

4. Open the Tape action inspector and configure these controls:

Source—Select the source to utilize.

Channel Group—Select a channel group (Nexus).

Expected Labels—Select labels you created, if any, to contain metadata. When 
selected, they are available to configure in the Tape Capture web application.
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5. Configure the Configuring Primary and Secondary Outputs and the Settings Panel to 
meet your requirements. For configuration details, see Tape Action Overview. 

6. Click Save when you finish configuring the Tape action. 

7. Click Activate to start the workflow. This workflow must be running to connect the 
Tape Capture Web app to the VTRs.

Binding Variables to Configuration Controls
Binding variables to an action’s configuration settings enables you to configure those 
settings directly from the Tape Capture | Live Capture | Live Schedule Pro web 
application and provide run-time values for each job you submit, rather than hard-
coded, static values that never change from job to job.

Note: For detailed topics on creating and using Vantage variables, click the ? icon to 
display the Vantage Users Guide.

To bind a variable to a control where supported, click the green Variable browse button 
next to the control:

The Select Variable dialog displays:

You can update each variable that is bound to a control is displayed in the...

• Live Capture web app Customize Parameters dialog. See Channel Options. 

• Tape Capture web app Customize Parameters dialog. See Configuring Tape Parame-
ters that are Bound to Variables. 

• Live Schedule Pro web app Variables dialog. See Using Variables in Events in the 
Live Schedule Pro User Guide.
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Using Paths for Vantage Storage
Vantage stores are named locations for temporary files. They are used in Vantage to 
conveniently store and access working media and attachment files, and to write media 
and other output files. Many Vantage services require access to files; Windows clients 
such as Workflow Portal also read and write files. These programs (both Windows 
programs and services) may run on one computer. Usually, however, they are 
distributed on many computers in an array. In an array, file access must be managed to 
ensure that the all programs can function correctly.

You can specify Vantage stores on a Windows computer using the following forms:

• UNC paths (shares): \\ComputerName\Sharename

• Drive-letters: C:\folder\folder

If Vantage is installed on a single server—the Vantage database, Vantage services, 
clients, Vantage stores and folders (an All-in-one domain), you can use either form. 
However, Telestream recommends that you always use the UNC path form to reduce 
file access problems. It is a requirement when you are operating in an array.

Drive-letter paths are defined in the context of a local computer; it does not identify the 
computer that hosts the drive. This prevents them from being useful in arrays. For 
example, if you specify a Vantage store on drive C using a drive letter, and a Workflow 
Portal operator on a different computer tries to view files in that store, Workflow Portal 
searches for files on drive C on the operator’s computer, not the Vantage server.

In another example, you create a workflow in Workflow Designer installed on Computer 
A. It has a Watch action, which is executed by a Vantage Monitor Service running on 
Computer B. You specify a hot folder on drive C on Computer A, where Workflow 
Designer is installed. When the service executes the Watch action, it attempts to locate 
the hot folder on Computer B’s C drive, which does not exist.

When any Vantage service or client program needs to access and use Vantage storage 
or a directory on a different computer, you must specify the path using the UNC form. 
When services or clients access Vantage storage from another computer, the Vantage 
storage location or directory must be configured as a share, and access must be 
granted to the appropriate Windows users. For more information, see Windows 
Authentication Guidelines in the Vantage Domain Management Guide.

When you plan to use a SAN system, be aware that some SAN systems expose the 
shared drive as a letter (mapped) drive—for example, X:—that is visible in any SAN. You 
can utilize SAN drives via a letter drive reference, provided that each Vantage server is a 
SAN client and that all mount points use the same letter.



Creating Live and Tape Capture Workflows
Prototype Capture Workflow—Labels & Variables

208

LIve Capture User’s Guide

Prototype Capture Workflow—Labels & Variables
The purpose of this prototype workflow is to illustrate the use of variables, extracted 
from an incoming metadata label submitted with the Capture event, which captures 
video from cameras in four different cities.

The Capture action is configured to ingest the label when it starts a job. The Populate 
action extracts the label’s field value and updates a variable, which is then examined in 
parallel Decide actions to identify the name of a city, and store the captured output in 
the proper city’s directory.

Creating and Configuring the Media Creation Capture 
Workflow

Follow these steps to create and activate the first workflow—using the Media Creation 
action: 

1. Launch Vantage Workflow Designer.

2. Select File > Create New Workflow and name the workflow—Media Creation 
Capture, for example
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Note: To avoid workflow failures, do not use these characters in workflow names: 
               ` * | \ : ; " ' < > ? / 

3. In the Workflow Design panel, open the Live action category and add a Capture action 
to the workflow design workspace below:
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4. Click the Inspector icon on the upper left corner of the action (or double-click the 
action) to open the Inspector.

5. Configure the action according to your requirements. For configuration details, see 
Capture Action Overview and Configuration. 

6. Click Save when you finish configuring the action.

7. Click Activate to start the workflow so that it is ready to start jobs when directed to 
do so by the Live Capture web app.
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Populate Action—The Populate action updates specified variables from the specified 
fields in the incoming Live Schedule label, as shown:

The Delivery Location’s City field is what is of interest in this example. The Delivery 
Location variable is updated with the value in the City field.

Refer back now, to the workflow itself. There are four Decide and Copy action sets. 

Decide and Copy Action Sets—Each Decide passes control to downstream actions in 
its branch only when a specific city is present in the Delivery Location variable. Here is 
one of the Decide actions, where it succeeds if the variable is equal to the string 
"Denver":
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The result is true, thus it executes successfully, permitting the corresponding Copy to 
duplicate the file, as shown here:

In this example, the TIFO file generated by the Capture action is nicknamed Denver, and 
the file is copied to E:\Delivery\Denver.

Summary
You can design and configure your live capture and tape capture workflows to process 
both variables and labels, and use the values that are unique to each capture job to 
intelligently process your captured media, as shown here delivering the captured 
output into a unique directory for each city where the video was shot.
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Managing Video Sources

You use the Source Manager web app to create, configure, and manage your 
Lightspeed Live Capture server’s various supported video source inputs—both SDI and 
IP-based video. Before you can connect a specific Vantage workflow to a source for 
recording in Live Capture, it must be configured in Source Manager. 

You can control access to Source Manager by creating and managing users and 
authorities in the Group Portal web app (see User Administration).

Topics
■ Overview

■ User Administration

■ Configuring Capture for SD/HD | UHD SDI Sources

■ Enabling QuadLink Loop Through

■ Configuring SDI Sources

■ Creating & Configuring Transport Stream Sources

■ Creating & Configuring RTMP Sources

■ Creating & Configuring SRT Sources

■ Creating & Configuring NDI Sources

■ Creating and Configuring ST 2110 Sources

■ Managing System Settings

■ Version Info | Help | Documents | Contact Methods

■ Troubleshooting
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Overview
Source Manager enables you to create, configure, and manage each Lightspeed Live 
Server’s video sources.

Sources do not automatically display in Live Capture when they are created here in 
Source Manager. In Live Capture, you create channels, which are connections between 
an active Vantage Capture workflow and a source. Once you create a channel, its source 
displays on the channel card and in the preview window, when the channel is selected.

Launch Source Manager using http://localhost:8090/ | http://<Remote host 
name>:8090/. The default credentials are admin/live!. For more information on 
launching and logging in to Source Manager, see Launching the Source Manager Web 
App. For other web app topics, see Managing your Web Apps.

Note: Unlike other Capture web apps, Source Manager only operates on its host 
platform’s inputs. Thus, if you have a Capture array, you must log onto Source Manager 
on each Lightspeed Live server to manage that server’s source inputs.

■ Using the Source Manager Window

■ Sources Panel

■ Preview Panel

■ Audio and Text Tracks Panel

■ Source Information and Statistics Panel
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Using the Source Manager Window
The Source Manager web app provides you an overview of all SDI sources on the 
Lightspeed Live Server, and other sources you’ve added, Source Manager displays 
thumbnails, a preview of the selected source plus an audio and source information/
status panel. 

In the case of a Capture array—multiple servers—the sources for each Lightspeed Live 
Server are displayed in a separate panel.

The Source Manager window displays several panels:

• The left panel—the Sources panel—displays inputs, referred to as sources; the per-
manent SDI sources, plus sources of other types that you’ve created (RTMP, Trans-
port Stream, etc.). 

• On the top right is the Preview panel for the selected source.

• Below the Preview panel is the Audio Control panel.

• Below the Audio Control Panel is the tabbed audio and text track panel.

• At the bottom right is the Source Information and Statistics panel. 

Other modal panels display as you use Source Manager to add and configure sources, 
and perform other utilitarian tasks.

Source 
Information and 
Statistics Panel

Audio Control 
Panel

Sources Panel

Audio and Text 
Track Panels

Preview Panel System Settings
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Sources Panel
Each source in the Sources panel displays a thumbnail (which updates every few 
seconds) of the current input (or the LOS video test pattern if no input is present), plus 
important details: frame size and rate, timecode, etc.

Toolbar
The toolbar includes icons for adding sources, and displaying or hiding the thumbnails.

To add a new source, click the + icon and select a source type from the Source menu.

Note: File loop and slate sources are included for use in Telestream Live Stream, but 
are not supported in Live Capture. ST 2110 (both text and HTML files are supported) is 
available on C2+ and C4 Lightspeed Live servers equipped with the Mellanox 
ConnectX-6 25/100Gb Ethernet NIC and the Rivermax Media Library.

Add Source 
icon

Hide/Display 
thumbnails

Source Type 
icon

Source Name

Click the + icon and select a 
source type from the menu.
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Source Type Icons
Each source’s thumbnail displays an icon in the upper left corner of the source’s 
thumbnail, depicting the source type. The thumbnail displays a LOS banner when there 
is loss of signal.

Permanent SDI source

Transport Stream source

RTMP source

ST 2110 source (on C2+ | C4 servers equipped with 25/100Gb Ethernet NIC)

NDI source

SRT source

Source is currently being captured and can’t be edited or deleted.

This source has experienced LOS (loss of signal).
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Preview Panel
Select a source thumbnail to play the stream in the preview panel to the right, along 
with tracks and metrics, below: 

 

The preview panel is comprised of a proxy preview of the current stream, with an 
audio/text tabbed panel below. 

Note: The Text Tracks tab is not used in Live Capture. Editing, duplicating, and 
deleting tracks has no effect on the stream being captured in Capture workflows.

Viewing Audio Levels and Muting Audio
You can use the controls in the audio meter to enable | disable audio playback through 
your workstation speakers. The audio level meters for each channel display and adjust 
automatically, based on the selected track (Stereo, 5.1 Surround Sound, etc.), with 
channel-by-channel mute control. 

Proxy video

Source Toolbar

Audio and text 
track panels

Audio meters and 
mute controls

Source metrics

Track Toolbar
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Audio and Text Tracks Panel
If there are multiple audio tracks in the stream, you can switch among them using the 
Audio Tracks tab. 

Note: The Audio tracks tab enables you to select a track to play. Otherwise, it 
performs no useful function, with the exception of identifying AC3 audio (Tagging AC3 
Audio Embedded in PCM). Editing, duplicating, and deleting audio tracks has no effect 
on the stream being captured in Capture workflows.

Text tracks are not used in Live Capture.

Source Information and Statistics Panel
The Source Information and Statistics panel (at the bottom-right corner of the main 
window) displays real time platform performance metrics and metrics for the currently 
selected source:

CPU0/CPU1—Percentage of CPU utilization by processor—CPU 0 and CPU 1. If system 
utilization of one or the other processor. If an IP source’s CPU0 or CPU1 utilization 
exceeds 75 percent, consider changing the Preferred Processor of one of the sources to 
use the other processor so the recordings can balance. (You can’t change the control 
during capture.) If utilization approaches 100 percent, it may lead to capture failure.

Affinity—The processor group currently processing this source. For details, see 
Balancing CPU Processor Group Affinities.

Resolution | Frame Rate | Bit Depth | Audio Channels | Captions—Video metrics.

Firmware Version—The firmware version in this server’s SDI card.
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User Administration
You use the Group Portal web app to control access to the Source Manager web app. In 
the Group Portal, you can create users and assign roles for restricting utilization of the 
Source Manager web app. For example, you can assign roles for administrators, operators, 
schedulers, monitors, and API users.

Note: Group Portal uses the term Group to refer to a set of Lightspeed Live Capture 
users. You create a group and then you add users—however, these users are only valid 
for the target Lightspeed Live Server. 

Topics
■ Launching the Group Portal

■ Creating a Group

■ Signing In

■ Creating/Updating Live Capture Users

Launching the Group Portal
Here’s how to launch the Group Portal web application:

Note: Only Chrome web browser, version 76.0.3809.100 or later, is supported for use 
of Lightspeed Live web applications.

On the target Live Capture server, verify that the Telestream Live Source Service is 
running. 

Launch Chrome and enter the following URL in the address field (If you changed the 
default port, be sure to use it):

http://localhost | <host name>:8090/Systems

When running Chrome locally on the target Live Capture server, use localhost as the 
host name in the URL.
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The Group Portal web app launches and displays the Group Portal window:

 

This window represents the first launch, without a group having been created. If you 
already have created a group, proceed to Signing In, following.

Creating a Group
This is a one-time task: 

1. Click the gray box with the plus sign:
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2. The Group Portal web app displays the Group Portal panel:

 

3. Name the group and specify the host:

• Group Name—Specifies the name of the group. Typically, name the group the 
same name as the server.

• Address—Specifies the host name | localhost of the target Live Capture server.

• Port Number—Specifies the web socket server port (default: 8084).

Group Portal displays the Sign in panel.

Signing In
Use the Sign In panel to authorize your user. 

Note: Only users with an administrator role can log in to the Group Portal.

If you’ve clicked away, display the Sign In panel again by clicking the More button on 
the Not Authenticated panel. 

Enter your credentials. The default credentials are: admin / live!. If this is the first time, 
use the default credentials. If other admin users have been created, you can log in with 
those credentials.
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If you have trouble starting the Group Portal web app, review the common problems in 
Troubleshooting.

When you have logged in successfully, the group panels display:

The green title bar on the group indicates a successful connection. Now, you can 
manage users in that group.
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Creating/Updating Live Capture Users
To create or update users, click on the group to display the Group Details panel:

Select the Users menu  in the upper right corner or click the More menu in the 
Admin panel and select Manage Users. 

To add a new user, click Add (+). To edit an existing user, click the user’s pencil icon. To 
delete a user, click the trash icon.

When adding a user, assign a user name and password, select a role, and click Save. 

Available roles and their privileges include:

• Administrator—Enables users to manage users in Group Portal, and view | create | 
modify sources in the Source Manager web app

Click here or here to display 
the Users panel.
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• Operator—Enables users to view | create | modify sources in the Source Manager 
web app

• Scheduler | Monitor—Enables users to view sources in the Source Manager web 
app but prevents them from changing settings.
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Configuring Capture for SD/HD | UHD SDI Sources
You can configure C4 and later model Lightspeed Live Servers to process a stream of 
SD|HD video on each SDI port. Or, you can configure them to combine (in software) 
four HD SDI signals into a single UHD video stream, using a technique known as 
quadlinking. 

Note: Quadlinking isn’t supported on Lightspeed Live Servers with 12G SDI.

On servers with eight SDI ports, you can mix and match SD/HD and UHD: You can 
configure both four-port sets for two UHD signals, or one set for UHD and the other sets 
configured for SD/HD. 

Use these procedures to configure a set of four SDI ports to quadlink UHD or in reverse, 
return to using SD/HD SDI on those ports. The process involves switching cables from 
your video source devices, re-configuring your sources via the Source Manager web 
app, and creating appropriate workflows and connecting them to the appropriate 
sources in Vantage Workflow Designer.

Note: The Vantage Live Service does not differentiate between UHD and SD/HD in 
SDI sources. If the server is connected to a UHD signal but SingleLink Video | SingleLink 
Loop Thru Video Input is specified, the four signals of the source are processed as four 
separate sources. To quadlink the SDI sources to create a UHD signal, you must enable 
QuadLink Video Input | QuadLink Loop Thru Video Input for servers equipped with 3G 
SDI.

Configuring Live Capture for UHD Video

Note:  Lightspeed Live servers with dual 8-port 3G SDI cards have 8 permanent input 
and 8 permanent output SDI ports; loop-through is permanently enabled and can’t be 
changed. Ignore loop through steps when performing this task on these servers.

When the 3G SDI ports video mode are set for SD/HD (SingleLink Video mode and you 
want to re-configure them to quadlink four SDI inputs into one UHD video stream, 
follow these steps:

1. Connect a valid UHD source (4 UHD cables) to the server’s SDI ports (1 through 4 or 
5 though 8, model dependent). 

2. On 8-port servers only, if you are planning to enable video loop through, make sure 
to connect cables properly for QuadLink Loop Through Video Input (Enabling 
QuadLink Loop Through). 

3. Start the 4-port UHD source to provide signal to the Lightspeed Live Server.

4. In Vantage Workflow Designer, deactivate all Live Capture workflows using SDI 
sources.
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5. Launch Source Manager (Launching the Source Manager Web App). In the Sources 
panel (see Configuring SDI Sources), select your SDI port based on your Lightspeed 
Live server:

– 4-port server—select SDI 1

– 8-port server—select SDI 1 or SDI 5 (this server supports two UHD streams)

– 8-port server for loop through—select SDI 1 or SDI 5, but not both.

– Dual 8-port with loop through—select SDI 0:1 to 0:5 or SDI 1:1 to 1:5.

6. Click the Edit icon  to display the Configure Sources panel.

7. Disable Preferred Processor (if displayed in the panel—model dependent and 
advanced mode only (see Managing System Settings)). This option should be 
disabled for UHD/4K. 

8. Set Video Mode to QuadLink Video Input or, for a dual 8-port system, select 
QuadLink Loop Thru Video Input.

9.  Click Save and close the panel. The four SDI source set (1-2-3-4 or 5-6-7-8) is now 
QuadLinked into one UHD source.

When you QuadLink SDI 1, then SDI 2, 3, and 4 are removed from the Sources panel 
and SDI 1 is renamed to include the acronym UHD. Similarly, when you QuadLink 
SDI 5—SDI 6, 7, and 8 are removed from the Sources panel and SDI 5 is renamed.

10. Optionally, on 8-port servers, you can implement video loop through—set the 
video mode to QuadLink Loop Thru Video Input and perform the steps in Enabling 
QuadLink Loop Through now.

11. In Vantage Workflow Designer, create (or update) a Live Capture workflow per your 
UHD video processing requirements and configure the Capture action to connect 
to the newly-named SDI input that created for this workflow. See Creating Live 
Capture Workflows.

12. Activate the workflow so that it is ready to start a job when it receives a stream.

Configuring Capture to Process SD/HD Video

Note:  Lightspeed Live servers with dual 8-port 3G SDI cards have 8 permanent input 
and 8 permanent output SDI ports; loop-through is permanently enabled and can’t be 
changed. Ignore loop through steps when performing this task on these servers.

When your Live server is currently set to UHD/4K mode and you want to re-configure it 
to process SD/HD video, follow these steps:

1. Make sure that a valid UHD/4K source is actively providing a signal to the server’s 
SDI ports you are using for UHD and plan to convert back to SD/HD use.

2. In Vantage Workflow Designer, deactivate all Live Capture workflows that were 
using the UHD/4K source.

3. In Source Manager, display the Sources panel (see Configuring SDI Sources), select 
the UHD/4K source (SDI 1 or SDI 5—or SDI 0:1 or SDI 0:5 on C5) you want to convert 
and then click the Edit icon  to display the Configure Sources panel. 
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4. Set Video Mode to SingleLink Video Input | SingleLink Video Loop Thru Input, then 
click Save to update the configuration and close the panel. The SDI source is 
converted to SD/HD and the other three SDI sources are displayed again.

Note: On dual 8-port servers, loop through is permanently set and can’t be changed.

5. If you enabled SingleLink Loop Through Video, perform the steps in Enabling 
QuadLink Loop Through now, and return to continue.

6. Turn off the device generating UHD/4K video and disconnect the SDI cables from 
the UHD/4K device.

7. Connect the SDI cables to your SD/HD device(s) as planned—making sure to 
connect cables properly for SingleLink Loop Through Video Input if enabled.

In the Source Manager panel, and select each of the four SD/HD sources and con-
figure them as appropriate. See Configuring SDI Sources.

8. In Vantage Workflow Designer, create (or update) the SD/HD workflow per your 
processing requirements and configure its Capture action to connect to the newly-
named SDI source for this workflow. See Creating Live Capture Workflows.

9. Click Activate to start the workflow so that it is ready to start a job when it receives 
a stream.
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Enabling QuadLink Loop Through
QuadLink Loop Through Video Input is available only on servers equipped with an 8-
port 3G SDI card. 

Note: QuadLink Loop Through is not supported on servers equipped with the HEVC 
(H/W) card. 
C5 Lightspeed Live servers have 8 permanent input and 8 permanent output SDI 
ports; loop-through is permanently enabled and can’t be changed.

Configuring an SDI source with QuadLink Loop Through causes the server to route the 
SDI source back out—or loop through—a paired SDI port, in addition to using the signal 
as a source. You can use this, for example, for confidence monitoring of the SDI signal 
into the server. You can enable QuadLink Loop Through on SDI 1 or SDI 5.

Important Note: SDI-1 input is used as the master sync when QuadLink Loop 
Through Video Input is enabled. All source inputs MUST be of the same baseband 
video type (frame rate and frame size) and they MUST share a common video 
reference that is frame synced and gen-locked together. Failure to meet this 
requirement results in a vertical offset being introduced in the sources.

If the source video type (such as frame rate or frame size) changes on SDI1 when 
operating in QuadLink Loop Through mode, the other inputs fail and go to LOS (loss of 
signal). After SDI1/5 is set back to match the other inputs, changing a setting on a 
source and saving it resets the source back into operation. 

When you enable QuadLink Loop Through for a given SDI source, the paired SDI source 
for the output is automatically deleted without warning—because it is now an output 
on the paired SDI port. For example, you set [host] - SDI 1 to loop through to SDI 5; 
Source Manager deletes the source instance of [host] - SDI 5. The previous source is 
unavailable to any Capture action or stream channel that was set to use that source. 

SDI-1 automatically goes to SDI-2 and SDI-3 goes to SDI-4 and the source cards auto-
populate correctly. See Port-Paired Loop Through Assignments for more information.

Port-Paired Loop Through Assignments
The following pairings apply when configuring SDI input ports for Loop Through: 

For Servers with Four 3G SDI Ports
• SD/HD:

– SDI-1 is paired with SDI-3 

– SDI-2 is paired with SDI-4

• UHD/4K:

– No Loop Through
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For Servers with Eight 3G SDI Ports
• SD/HD:

– SDI-1 is paired with SDI-5 

– SDI-2 is paired with SDI-6

– SDI-3 is paired with SDI-7 

– SDI-4 is paired with SDI-8

• UHD/4K:

– UHD/4K Input 1 QuadLinked with SDI-1+SDI-2+SDI-3+SDI-4

– UHD/4K Output 5 QuadLinked with SDI-5+SDI-6+SDI-7+SDI-8 for loop-through.
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Configuring SDI Sources
All SDI sources are permanent—you can’t create or delete them. For each SDI source 
port on the server (model dependent), an SDI source displays in the Sources panel.

Note: If you have implemented RouteMaster for SDI source control, if you are 
changing the destination, you should de-activate associated workflows and then 
restart them. See the Live Schedule Pro User Guide for selecting RouteMaster sources.

In a Live Capture array, you should name each Lightspeed Live Server’s SDI ports with a 
unique name to avoid confusion—for example, add the Lightspeed Live Server name 
as a prefix: Lightspeed1-SDI-1, or on a C5, Lightspeed1-SDI-0:1.

To modify an SDI source configuration, select it in the Sources panel to display its 
Preview panel. 

Note: While an SDI source is being captured, you can only edit the source’s name and 
description. Some controls display only when you enable advanced mode. Select 
Settings in the main menu  to display the System Settings panel. See Managing System 
Settings.

Click the Edit icon  to display its Configure Source dialog:

Advanced Mode settings—
enable Advanced Mode in 
the System Settings panel.
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When Loop Thru is specified for Video Mode, the Configure Source dialog displays 
additional controls:

 

Make changes to the controls as required and click Save to close the panel and update 
the source.

Name—Specifies the name to use in Capture web apps and the Vantage Capture 
action. You can’t change the name while the source is being captured.

When you name a source, observe these rules:

– Each source instance must be named uniquely.

– These characters are prohibited: ` * | \ : ; " ' < > ? / 

– After changing a source name you must re-configure affected Capture actions in 
Vantage workflows that utilize the renamed source. See Capture Action Overview 
and Configuration.

The default name for SDI ports on a single-card server has the form: SDI [1 through n], 
where ‘n’ is 4 or 8 depending on the SDI card in the Lightspeed Live Server.

When hosted on a dual, 8 port-card (16-Port (dual 8 port) 3G SDI Cards with Reference and 
LTC) Lightspeed Live server, the default name has the form: SDI [0 | 1]:[1 through n], 
where the card number is 0 or 1, and the connector number is 1 through n, where ‘n’ is 
4 or 8 depending on the depending on the SDI card in the Lightspeed Live Server.

When you rename a source, observe these rules:

– Each source instance must be named uniquely.

– These characters are prohibited: ` * | \ : ; " ' < > ? / 

– After changing a source name you must re-configure affected Capture actions in 
Vantage workflows that utilize the renamed source. See Capture Action Overview 
and Configuration.

Description—Practical description of the source or when using RouteMaster with Live 
Schedule Pro, the router port.

For a router source controlled by RouteMaster, you specify the SDI source—which is the 
router output—by providing the keyword destination and the router’s port number, 
separated by a colon. For example: destination:152. This specifies that there is an 
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SDI cable from router port 152 to the SDI port you’re configuring, which does not 
change.

Force 8-Bit Video—8-bit video should only be used with 8-bit codecs such as XDCAM. 
When enabled, activates 8-bit down-sampling of the SDI video. Using 8-bit sampling 
offers more efficient compression. Disable to utilize 10-bit video, which should be used 
for all 10-bit codecs such as ProRes.

Ignore VPID—An SDI source displays Loss of Signal when the embedded VPID data is 
not valid for the source. In normal use, VPID data should match the SDI source and it is 
expected that a new source process is created when the source changes; for example, 
when the frame size or frame rate changes.

If the VPID does not match the source frame rate and frame size after an upstream 
source is switched, you can enable Ignore VPID to ignore the VPID data to avoid loss of 
signal during recording.

Freeze on LOS—When enabled, causes the source to hold the last good frame if the 
signal is lost. When disabled, LOS causes the LOS Video Test Pattern to be displayed. For 
details, see Loss of Signal Behavior.

Preferred Processor

Note: If this control doesn’t display, processor balancing on this model server is 
performed automatically, and no end-user adjustment is available, or advanced mode 
is disabled (see Managing System Settings). Use only when capturing SD/HD SDI 
sources—disable it when capturing UHD/4K.

When enabled (C2+ and earlier), processing associated with each Capture | Tape job is 
assigned to the assigned CPU on the server’s multi-core CPU to prevent inefficient 
process mapping across CPU sockets during heavy loads, typically when several 
sources are capturing concurrently. 

On C4 and later models, for IP sources you can manually set affinity to a specific socket. 
If you create IP sources in order and use them in order, balancing is automatic. However, 
for example, if you delete every other IP source, the remaining sources do not balance 
and you can use can use this control to balance them. If IP sources are maintained long 
term, it may be helpful to assign each source a preferred processor.

Disabling this option during multi-source capturing may result in excessive CPU usage. 
When Preferred Processor is disabled, affinity is set to 0 (Balancing CPU Processor Group 
Affinities).

LOS Video Test Pattern—Applies only when Freeze on LOS is disabled. Specifies the 
test pattern to display during LOS. For details, see Loss of Signal Behavior.

LOS Audio Test Signal—Specifies the audio signal to use during LOS.

Max Time-Shift—Specifies the maximum duration of video that the time-shift frame 
buffer can hold, which is used to delay the source for workflows using this source. 
Specifies the duration in seconds (maximum: 10). Some limitations may exist for higher 
bit rates and frame rates.
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Note: Live Capture’s Time-Shift holds incoming source media frames in an internal 
FIFO buffer. See Determining the Time-Shift Buffer Duration for suggested settings for 
various frame sizes and rates. 

When a capture workflow is activated with Time-Shift enabled, the source media is 
stored in the buffer, which allows Live Capture to reach back in time and access media 
processed in the past, based on the value of the Time-Shift field. Since Live Capture’s 
Time-Shift is always processing a source’s media, when you start recording, any media 
stored in the buffer is available to be added to the capture file.

Timecode Source—Click the menu to choose one of the following timecode source 
signals for the selected SDI input:

– Source—Uses the timecode provided in VBI or VANC (SMPTE 12M-2/RP188) of 
the selected Lightspeed Live Capture’s video input signal. If a valid timecode is 
not available or goes away, see the Free Run Timecode option below.

– Computer Clock—Uses the time-of-day clock provided by the Live Capture server. 
When selected, also configure Compensate for Computer Clock Drift.

WARNING: If the video and timecode are not synchronized, time code 
discontinuities can occur. To avoid time code anomalies such as unexpected 
discontinuities and repeated time codes, always sync the incoming SDI frames 
with your chosen time code source. Failure to do so can cause recording that stop 
abruptly or do not stop as expected.

Caution: If your Live Capture server’s Time Zone Setting is set to a time zone that 
does not have Daylight Savings Time, computer clock use UTC time, due to a 
Windows limitation.

– None—Specifies zero-based timecode recording. When recording begins, the 
timecode is set to 00:00:00:00. If Free Run Timecode is enabled, then the 
timecode inserted into a QuickTime or MXF file auto-increments. Otherwise, 
every frame in the output file contains timecode 00:00:00:00. Capture displays N/
A on the workflow thumbnail, indicating that there is no applicable timecode 
available, and 00:00:00:00 displays in Capture’s Preview timecode window.

– Analog LTC—Uses the timecode provided on the SDI card's LTC input (marked 
with an R on the SDI card). If a valid timecode is not available or goes away, see 
the Free Run Timecode option below.

Note: Analog LTC timecode is passed to Live Capture in input frame samples from the 
SDI card. When a channel is in an LOS state, the LTC timecode is not present and is 
passed to Live Capture at 00:00:00:00 until a valid signal is present on the input.

– RS422—Uses the timecode provided by a VTR connected via RS422 (requires the 
optional 4-port or 8-port RS422 VTR Interface Kit—see Connecting VTR Systems). 
If an input is connected to a VTR under RS422 control, RS422 must be selected.
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Note: When using the CalDAV Calendar trigger you should set the Timecode Source 
to either Computer Clock or Source. When using Source, you must have time-of-day 
timecode in your source that matches the time set in your Lightspeed Live Server. 
See Configuring Trigger Settings. 

Free Run Timecode—When enabled, and the timecode is not detected or goes away, 
the timecode seamlessly free-runs from the last good timecode received. When not 
enabled and the timecode is not detected or goes away, then the timecode reverts to 
zero (00:00:00:00) and stays at zero. 

Raw Ancillary Dump (Advanced mode only—see Managing System Settings)—When 
enabled and the output container is set to TIFO, the SDI input’s ancillary data is inserted 
directly into the Primary Output file

Caution: Do not enable this option unless directed by Telestream Support. 

Use Inverse Telecine—Does not apply in Capture, because no frame-rate conversion is 
applied. Do not enable this control.

Line Offset (Advanced mode only—see Managing System Settings)—When enabled, 
shifts the video by the specified line offset. Default is 0. Minimum is -4, and maximum is 
+4. The range is -4 to 4 lines.

Cisco ID3 (Advanced mode only—see Managing System Settings)—Enable to allow the 
SCTE-104 information to be converted to ID3 on output. 

Extended RS422 Status (Advanced mode only—see Managing System Settings)—
When enabled, VTRs supporting the Extended Status Sense RS422 command returns 
extended status data. The extended status data is added to log files.

Video Mode (Applies only to 3G SDI Ports 1 & 5, model-dependent)—Specifies the 
type of signal that is attached to SDI ports and how to process it. Changing input 
sources from SD/HD to QuadLink UHD/4K is comprehensive—and performed in a 
series of steps—described in Configuring Capture for SD/HD | UHD SDI Sources. 

Do not change this setting without performing one or both of the procedures. Enabling 
Loop Through (or reverting back) is also performed in a series of steps—see Enabling 
QuadLink Loop Through for the steps to take. 

– SingleLink Video Input—Specifies that the source is either Standard Definition or 
High Definition video.

– SingleLink Video Input with Loop Through—Specifies an SD/HD source, routed 
back out through a paired SDI port.

– QuadLink Video Input—Specifies that the source is either UHD/4K video. When 
activated, all four SDI inputs are combined into one QuadLink UHD/4K source. All 
four signals of a UHD/4K source must match for UHD/4K mode to be activated, 
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unless Ignore Format Match Check is enabled (see following). Unmatched signals 
also occur when any UHD/4K sources are not currently playing video.

– QuadLink Loop Thru Video Input —Specifies a QuadLink UHD/4K source, routed 
back out through paired SDI ports (8-port 3G SDI cards only).

Note: Loop Through is not supported on servers equipped with the HEVC SDI card.

Initial Video Format—Specifies the video format of the incoming signal. This enables 
capture recovery to the proper frame size (SD/HD and UHD/4K) and rate during a 
temporary Loss of Signal. If a recurring workflow using a source with Initial Video 
Format set to the house format is set to record on activation and Ignore Lost Frames is 
enabled, recording begins when the Capture system is powered up without user 
intervention—using the specified format—even if there isn’t yet a valid source to 
ingest.

Ignore Format Match Check (when source is specified as UHD/4K)—When enabled, 
maintains the UHD/4K source even if the signals do not have a matching signal. Only 
when there is no valid UHD/4K signal from all ports, does the output displays the LOS 
Video Test Pattern.

PsF Hint (for UHD only)—You should enable PsF Hint for 1080PsF25, 1080PsF29.97 and 
1080PsF30 SDI sources that do not report PsF in the VPID payload so that it is processed 
appropriately. See SDI Source Video Formats.

Note: Live Capture always treats 23.98 | 24 PsF SDI sources as progressive.

3G SDI Signal Level (For 3G SDI SD/HD cards only)—Specifies the signal level of the 
SDI source. If the signal level is incorrect or mis-detected, the workflow may fail with a 
compressor error:. 3G level is detected automatically based on VPID data. If VPID data is 
not present or is incorrect, the signal level must be manually set:

– Automatic—Specifies that the Capture server auto-detects between Level A and 
B. Choose when the signal may be unknown or switch between A | B. 

– Level A—Specifies direct mapping of uncompressed 1080p (up to 60 fps) video at 
3Gb/s.

– Level B—Specifies Level B-DL format; mapping dual-link HD-SDI/SMPTE 372M 
(1080p up to 60 fps) at 3Gb/s.

Overlay Border on Loop Thru (For 3G SDI SD/HD cards only when set to Loop Thru)—
When enabled, Live Capture displays a border around the preview panel during 
recording. Border color is controlled by the Overlay Border Color selection.

Overlay Source Name on Loop Thru (For 3G SDI SD/HD cards only when set to Loop 
Thru)—When enabled, Live Capture overlays the source name on the preview panel.

Overlay Timecode on Loop Thru (For 3G SDI SD/HD cards only when set to Loop 
Thru)—When enabled, Live Capture overlays the source timecode on the preview 
panel.
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Overlay Workflows on Loop Thru (For 3G SDI SD/HD cards only when set to Loop 
Thru)—When enabled, Live Capture overlays the Vantage workflow name on the 
preview panel during recording.

Overlay Border Color (For 3G SDI SD/HD cards only when set to Loop Thru)—Specifies 
the color to display the border on the preview panel.

Overlay Border Thickness (For 3G SDI SD/HD cards only when set to Loop Thru)—
Specifies the width (in pixels) of the border on the preview panel.

Quad-Link Image Division (when sources is specified as UHD/4K)—Specifies the 
method for processing image division. Image division is detected automatically based 
on VPID data. If VPID data is not present or is incorrect, image division must be 
manually set:

– Automatic—Specifies that Capture automatically detects the image division 
mode. Use of the Automatic setting requires a valid VPID signal from the source. 
See SDI Source Video Formats indicating when manual selection is required.

– Square—Specifies that when processing QuadLink Image Division, Capture uses 
the square-division method where the full image is divided into four quadrants.

– 2SI—Specifies that when processing QuadLink Image Division, Capture uses 
two-sample interleave (2SI) method, sending two consecutive pixels to one of 
the four sub-images. 
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Creating & Configuring Transport Stream Sources
Capturing Transport Stream sources is an optional, licensed feature which requires a 
Manzanita Muxing for Capture license. For details, see Licensing a Live Capture Array.

To create or edit a Transport Stream source, click the Add Input button in the Sources 
panel toolbar and select Transport Stream to display the Configure Source panel:

Note: You can only format IP sources using standard frame sizes and frame rates. See 
the Technical Specifications in the Lightspeed Live Capture product sheet on the 
Telestream web site for supported formats. 

Note: While a source is being captured, you can only edit the source’s name and 
description. Some controls display only when you enable advanced mode. Select 
Settings in the main menu  to display the System Settings panel. See Managing System 
Settings.

Telestream recommends limiting IP-based sources to eight, unless testing in your 
environment indicates you can support more.

Click the + icon and select 
Transport Stream from the menu.

https://telestream.net/pdfs/datasheets/dat-Lightspeed-Live-Capture.pdf
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Click Save to close the panel and create the transport stream source per your 
specifications.

Name—Specifies the name used to identify this source in Capture web apps and the 
Vantage Capture action. You can’t change the name while the source is being captured.

When you name a source, observe these rules:

– Each source instance must be named uniquely.

– These characters are prohibited: ` * | \ : ; " ' < > ? / 

– After changing a source name you must re-configure affected Capture actions in 
Vantage workflows that utilize the renamed source. See Capture Action Overview 
and Configuration.

The name cannot be changed when this source is connected. In a Capture array, when 
you create IP-based sources on more than one server, they should be named uniquely 
across the entire array for clarity.

Description—Practical description of the source.

Advanced mode only—
enable Advanced Mode 
in the System Settings 
panel.
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Multicast Group IP Address—Specifies the optional IP address to use.

Network Interface—Specifies the local NIC (Network Interface Card)/IP address 
identified to receive this stream. Multiple NIC cards may be present on the server.

Note: When you add a NIC card to a server or change it from the disabled to enabled 
state, you must restart the Vantage Live Service for the service to recognize it and 
update the Local NIC/IP Address menu.

Enable SSM—When Source Specific Multicast (SSM) is enabled, you can enter a list of 
accepted source IP addresses for multicast, under Source Filter. 

Source Filter—When you enable SSM, the Source Filter field displays. Enter a list 
of accepted IP addresses for the multicast sources. Separate IP addresses in the 
list by the return character, via the Enter/Return key. 

Port Number—Specifies the port number to utilize. 

Program Number—When enabled, specifies the program number to capture, when 
multiple programs are present in the stream. When disabled, the first available program 
is used.

Max Time-Shift—Specifies the maximum duration of video that the time-shift frame 
buffer can hold, which is used to delay the source for workflows using this source. 
Specifies the duration in seconds (maximum: 10). Some limitations may exist for higher 
bit rates and frame rates.

Note: Live Capture’s Time-Shift holds incoming source media frames in an internal 
FIFO buffer. See Determining the Time-Shift Buffer Duration for suggested settings for 
various frame sizes and rates. 

When a capture workflow is activated with Time-Shift enabled, the source media is 
stored in the buffer, which allows Lightspeed Live to reach back in time and access 
media processed in the past, based on the value of the Time-Shift field. Since Live 
Capture’s Time-Shift is always processing a source’s media, when you start recording, 
any media stored in the buffer is available to be added to the capture file.

Force 8-Bit Video—8-bit video should only be used with 8-bit codecs such as XDCAM. 
When enabled, activates 8-bit down-sampling of the SDI video. Using 8-bit sampling 
offers more efficient compression. Disable to utilize 10-bit video, which should be used 
for all 10-bit codecs such as ProRes.

Preferred Processor

Note: If this control doesn’t display, processor balancing on this model server is 
performed automatically, and no end-user adjustment is available, or advanced mode 
is disabled (see Managing System Settings). Use only when capturing SD/HD SDI 
sources—disable it when capturing UHD/4K.
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When enabled (C2+ and earlier), processing associated with each Capture | Tape job is 
assigned to the assigned CPU on the server’s multi-core CPU to prevent inefficient 
process mapping across CPU sockets during heavy loads, typically when several 
sources are capturing concurrently. 

On C4 and later models, for IP sources you can manually set affinity to a specific socket. 
If you create IP sources in order and use them in order, balancing is automatic. However, 
for example, if you delete every other IP source, the remaining sources do not balance 
and you can use can use this control to balance them. If IP sources are maintained long 
term, it may be helpful to assign each source a preferred processor.

Disabling this option during multi-source capturing may result in excessive CPU usage. 
When Preferred Processor is disabled, affinity is set to 0 (Balancing CPU Processor Group 
Affinities).

Timecode Source—Sets the default timecode source. Choose one of the following 
timecode source signals for the selected Transport Stream source: 

– Source—For H.264 or H.265 the source’s SEI data is used, and for MPEG2 the 
source’s GOP header timecode is used. If no valid source timecode is available, 
see the Free Run Timecode option below.

– Computer Clock—Uses time-of-day clock provided by the Live Capture server. 
When selected, also configure Compensate for Computer Clock Drift.

Caution: If your Lightspeed Live Server’s Time Zone Setting is set to a time zone 
that does not have Daylight Savings Time, computer clock use UTC time, due to a 
Windows limitation.

– None—Specifies zero-based timecode recording. When recording begins, the 
timecode is set to 00:00:00:00. If Free Run Timecode is enabled, then the 
timecode inserted into a QuickTime or MXF file auto-increments. Otherwise, 
every frame in the output file contains timecode 00:00:00:00. Capture displays N/
A on the workflow thumbnail, indicating that there is no applicable timecode 
available, and 00:00:00:00 displays in Capture’s Preview timecode window.

Free Run Timecode—Enabling Free Run Timecode has no effect when Compensate for 
Computer Clock Drift is also enabled. When enabled, and the desired timecode is not 
detected or goes away, the timecode seamlessly free-runs from the last good timecode 
received. When Free Run Timecode is not enabled and the desired timecode is not 
detected or goes away, the timecode reverts to zero (00:00:00:00) and stays at zero.

Compensate for Computer Clock Drift—Only applies when Computer Clock is 
specified as Timecode Source.

Regardless of how Compensate for Computer Clock Drift is set, if packets are lost and 
frames are dropped, the Live Source process adds frames using the last good timecode 
in order to compensate for the lost frames. This may cause timecode values to be 
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repeated where a frame was lost. If your Transport Stream signal is strong, this problem 
should not occur.

When Compensate for Computer Clock Drift is enabled
Computer Clock Time is monitored and compared to the timecode being added to 
the captured file. Since the Computer Clock is not gen-locked with a true time 
source associated with the incoming frames it can drift over time and get out of 
sync with the incoming stream. When a drift of one second is reached the timecode 
being added to the file is re-synced to the system’s Computer Clock time. This 
means there may be a discontinuity in the file’s timecode at the point where the re-
sync occurred. Enabling Free Run Timecode when Compensate for Computer Clock 
Drift is enabled has no effect on the process described here.

When Compensate for Computer Clock Drift is Disabled
The source process uses the Computer Clock time without compensating for drift. 
Over time the timecode may drift several seconds compared to the ‘real’ time. For 
example—if a recording is 6 hours long the Computer Clock drift might be many 
seconds by the end of the 6 hour recording. If no frames were dropped the time-
code in the output file is contiguous from start to finish.

Freeze on LOS—When enabled, causes the source to hold the last good frame if the 
signal is lost. When disabled, LOS causes the LOS Video Test Pattern to be displayed. For 
details, see Loss of Signal Behavior.

LOS Video Test Pattern—Select the test pattern to display during LOS.

LOS Audio Test Signal—Specifies the audio signal to use during LOS.

Use Inverse Telecine—Does not apply in Capture, because no frame-rate conversion is 
applied. Do not enable this control.

TS over RTP—Enable to receive transport streams wrapped in RTP packets.

Cisco ID3 (Advanced mode only—see Managing System Settings)—Enable to allow the 
SCTE-104 information to be converted to ID3 for deliver to the Capture action.
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Creating & Configuring RTMP Sources
To create and configure a new RTMP source, click the Add Input icon in the Sources 
panel toolbar and select RTMP to display the Configure Source panel:

Note: You can only format IP sources using standard frame sizes and frame rates. See 
the Technical Specifications topic in the Lightspeed Live Capture product sheet on the 
Telestream web site for supported formats.
Once you have added and configured an RTMP source, you can only modify the name, 
description, and Preferred Processor. When you require an RTMP source with different 
settings, add a new RTMP source and configure it accordingly.
Some controls display only when you enable advanced mode. Select Settings in the main 
menu  to display the System Settings panel. See Managing System Settings.

Telestream recommends limiting IP-based sources to eight, unless testing in your 
environment indicates you can support more.

Click the + icon and select RTMP 
from the menu.

https://telestream.net/pdfs/datasheets/dat-Lightspeed-Live-Capture.pdf
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For Live Capture systems with more than one server, you should name each separate 
Live Capture server’s RTMP sources with unique names—for example, add the Live 
Capture server name as a prefix: Lightspeed1-RTMP. 

When configuration is complete, click Save to close the panel and create the RTMP 
source per your specifications.

Name—Specifies the name used to identify this source in Capture web apps and the 
Vantage Capture action. You can’t change the name while the source is being captured.

When you rename a source, observe these rules:

– Each source instance must be named uniquely.

– These characters are prohibited: ` * | \ : ; " ' < > ? / 

– After changing a source name you must re-configure affected Capture actions in 
Vantage workflows that utilize the renamed source. See Capture Action Overview 
and Configuration.

Description—Practical description of the source.

Stream Name—Specifies the name (default: myStream) of this RTMP stream source. 

Max Time-Shift—Specifies the maximum duration of video that the time-shift frame 
buffer can hold, which is used to delay the source for workflows using this source. 
Specifies the duration in seconds (maximum: 10). Some limitations may exist for higher 
bit rates and frame rates.

Note: Live Capture’s Time-Shift holds incoming source media frames in an internal 
FIFO buffer. See Determining the Time-Shift Buffer Duration for suggested settings for 
various frame sizes and rates. 
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When a capture workflow is activated with Time-Shift enabled, the source media is 
stored in the buffer, which allows Lightspeed Live to reach back in time and access 
media processed in the past, based on the value of the Time-Shift field. Since Live 
Capture’s Time-Shift is always processing a source’s media, when you start recording, 
any media stored in the buffer is available to be added to the capture file.

Preferred Processor

Note: If this control doesn’t display, processor balancing on this model server is 
performed automatically, and no end-user adjustment is available, or advanced mode 
is disabled (see Managing System Settings). Use only when capturing SD/HD SDI 
sources—disable it when capturing UHD/4K.

When enabled (C2+ and earlier), processing associated with each Capture | Tape job is 
assigned to the assigned CPU on the server’s multi-core CPU to prevent inefficient 
process mapping across CPU sockets during heavy loads, typically when several 
sources are capturing concurrently. 

On C4 and later models, for IP sources you can manually set affinity to a specific socket. 
If you create IP sources in order and use them in order, balancing is automatic. However, 
for example, if you delete every other IP source, the remaining sources do not balance 
and you can use can use this control to balance them. If IP sources are maintained long 
term, it may be helpful to assign each source a preferred processor.

Disabling this option during multi-source capturing may result in excessive CPU usage. 
When Preferred Processor is disabled, affinity is set to 0.

Timecode Source—Specifies the default timecode source. Choose from the following 
timecode source signals: 

– Source—For H.264 or H.265 the source’s SEI data is used; for MPEG2 the source’s 
GOP header timecode is used. If no valid source timecode is available, see Free 
Run Timecode below.

– Computer Clock— by the Lightspeed Live Capture Server. When selected, also 
configure Compensate for Computer Clock Drift.

Caution: If your Lightspeed Live Server’s Time Zone Setting is set to a time zone 
that does not have Daylight Savings Time, computer clock use UTC time, due to a 
Windows limitation.

– None—Specifies zero-based timecode recording. When recording begins, the 
timecode is set to 00:00:00:00. If Free Run Timecode is enabled, then the 
timecode inserted into a QuickTime or MXF file auto-increments. Otherwise, 
every frame in the output file contains timecode 00:00:00:00. Capture displays N/
A on the workflow thumbnail, indicating that there is no applicable timecode 
available, and 00:00:00:00 displays in Capture’s Preview timecode window.

Free Run Timecode—Enabling Free Run Timecode when Compensate for Computer 
Clock Drift is enabled has no effect. When enabled, and the desired timecode is not 
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detected or goes away, the timecode seamlessly free-runs from the last good timecode 
received. When Free Run Timecode is not enabled and the desired timecode is not 
detected or goes away, the timecode reverts to zero (00:00:00:00) and stays at zero.

Compensate for Computer Clock Drift—Only applies when Computer Clock is 
specified as Timecode Source.

Regardless of how Compensate for Computer Clock Drift is set, if packets are lost and 
frames are dropped the Live Source process adds frames using the last good timecode 
in order to compensate for the lost frames. This may cause timecode values to be 
repeated where a frame was lost. If your Transport Stream signal is strong, this problem 
should not occur.

When Compensate for Computer Clock Drift is enabled
Computer Clock Time is monitored and compared to the timecode being added to 
the captured file. Since the Computer Clock is not gen-locked with a true time 
source associated with the incoming frames it can drift over time and get out of 
sync with the incoming stream. When a drift of one second is reached the timecode 
being added to the file is re-synced to the system's Computer Clock time. This 
means there may be a discontinuity in the file’s timecode at the point where the re-
sync occurred. Enabling Free Run Timecode when Compensate for Computer Clock 
Drift is enabled has no effect on the process described here.

When Compensate for Computer Clock Drift is Disabled
The source process uses the Computer Clock time without compensating for drift. 
Over time the timecode may drift several seconds compared to the ‘real’ time. For 
example—if a recording is 6 hours long the Computer Clock drift might be many 
seconds by the end of the 6 hour recording. If no frames were dropped the time-
code in the output file is contiguous from start to finish.

Freeze on LOS—When enabled, causes the source to hold the last good frame if the 
signal is lost. When disabled, LOS causes the LOS Video Test Pattern to be displayed. For 
details, see Loss of Signal Behavior.

LOS Video Test Pattern—Applies only when Freeze on LOS is disabled. Specifies the 
test pattern to display during LOS.

LOS Audio Test Signal—Specifies the audio signal to use during LOS.

Tagging AC3 Audio Embedded in PCM
If the audio in a source is AC3, you must indicate it as such, so that the Vantage Capture 
workflow can process it properly.

Note: The only audio track setting that applies to Live Capture is the AC3 
Decompressor. No other settings apply.

To identify a track as AC3, follow these steps:

1. Select the source to display its preview panel.

2. Click the Audio Tracks tab and select the track you are working on.
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3. Click the Edit icon  to display the Configure Audio Track panel:

4. Enable the AC3 Decompressor control and click Save. 

When enabled, AC3 audio embedded in PCM is decoded at the source level and passed 
on as PCM, for use directly in the primary or secondary outputs and the Preview panel 
of a Live system. When the AC3 Decompressor is enabled, the affected source’s Live 
Source process restarts automatically.
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Creating & Configuring SRT Sources
Live Capture supports SRT (Secure Reliable Transport)—an open-source video 
streaming transport protocol—that provides secure, low-latency streaming 
performance over noisy or lossy networks such as the public Internet.

SRT testing was performed using AVC generated by the Makito X Encoder in these 
profiles:

• High 422 8/10-bit 420/422

• High 10 420 8/10-bit

• High 420 8-bit

• Main 420 8-bit

• Baseline 420 8-bit.

On the Makito X Encoder, make sure that the video/audio encoders in use for your SRT 
output settings are enabled. 

Note: You can only format IP sources using standard frame sizes and frame rates. See 
the technical specifications in the Lightspeed Live Capture product sheet on the 
Telestream web site for supported formats.
While a source is being captured, you can only edit the source’s name. To modify other 
settings in the configuration, first stop recording the source in Live Capture.
Some controls display only when you enable advanced mode. Select Settings in the main 
menu  to display the System Settings panel. See Managing System Settings.

Telestream recommends limiting IP-based sources to eight, unless testing in your 
environment indicates you can support more.

To create and configure an SRT source, click the Add Input icon in the Sources panel 
toolbar:

Click the + icon and select SRT 
from the menu.

https://telestream.net/pdfs/datasheets/dat-Lightspeed-Live-Capture.pdf
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Select SRT from the menu to display the Configure Source panel:

When configuration is complete, click Save to close the panel and create the SRT 
source.

Name—Specifies the name used to identify this source in Capture web apps and the 
Vantage Capture action. You can’t change the name while the source is being captured.

When you rename a source, observe these rules:

– Each source instance must be named uniquely.

– These characters are prohibited: ` * | \ : ; " ' < > ? / 

– After changing a source name you must re-configure affected Capture actions in 
Vantage workflows that utilize the renamed source. See Capture Action Overview 
and Configuration.

For Live Capture systems with more than one server, you should name each separate 
Lightspeed Live Server’s SRT sources with unique names—for example, add the 
Lightspeed Live Server name as a prefix: Lightspeed1-SRT. 

Description—Practical description of the source. 

SRT Caller Mode—Enable this option to establish an SRT link between your SRT source 
and destination device when required, where this device is the caller.

Advanced mode only—
enable Advanced Mode in 
the System Settings panel.
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SRT Stream Address—SRT sources are created in Listener mode by default. When 
Caller Mode is enabled, specify the IP address of the listener device. The stream must be 
started, and the IP address must be valid, or you can’t save the configuration. 

AES Encryption—Enable to implement AES encryption on this source.

AES Encryption Passphrase—When AES encryption is enabled, supply a pass 
phrase (10-79 characters).

AES Encryption Key Length—When AES encryption is enabled, specify the key 
length from the menu.

Network Interface—Specifies the primary 25/100Gb Ethernet NIC.

Port Number—Specifies the port number to utilize for both listener and caller mode.

Force 8-Bit Video—Forces a 10-bit source to be down-sampled to 8-bit.

8-bit video should only be used with 8-bit codecs such as XDCAM. Using 8-bit sampling 
offers more efficient compression.

Preferred Processor

Note: If this control doesn’t display, processor balancing on this model server is 
performed automatically, and no end-user adjustment is available, or advanced mode 
is disabled (see Managing System Settings). Use only when capturing SD/HD SDI 
sources—disable it when capturing UHD/4K.

When enabled (C2+ and earlier), processing associated with each Capture | Tape job is 
assigned to the assigned CPU on the server’s multi-core CPU to prevent inefficient 
process mapping across CPU sockets during heavy loads, typically when several 
sources are capturing concurrently. 

On C4 and later models, for IP sources you can manually set affinity to a specific socket. 
If you create IP sources in order and use them in order, balancing is automatic. However, 
for example, if you delete every other IP source, the remaining sources do not balance 
and you can use can use this control to balance them. If IP sources are maintained long 
term, it may be helpful to assign each source a preferred processor.

Disabling this option during multi-source capturing may result in excessive CPU usage. 
When Preferred Processor is disabled, affinity is set to 0 (Balancing CPU Processor Group 
Affinities).

Max Time-Shift—Specifies the maximum duration of video that the time-shift frame 
buffer can hold, which is used to delay the source for workflows using this source. 
Specifies the duration in seconds (max. 10). Sources with higher bit rates and frame 
rates may reduce duration.

Note: Live Capture’s Time-Shift holds incoming source media frames in an internal 
FIFO buffer. See Determining the Time-Shift Buffer Duration for suggested settings for 
various frame sizes and rates. 
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When a capture workflow is activated with Time-Shift enabled, the source media is 
stored in the buffer, which allows Lightspeed Live to reach back in time and access 
media processed in the past, based on the value of the Time-Shift field. Since Live 
Capture’s Time-Shift is always processing a source’s media, when you start recording, 
any media stored in the buffer is available to be added to the capture file.

Timecode Source—Specifies the default timecode source. Choose from the following 
timecode source signals: 

– Source—For H.264 or H.265 the source’s SEI data is used; for MPEG2 the source’s 
GOP header timecode is used. If no valid source timecode is available, see Free 
Run Timecode below.

– Computer Clock— by the Live Capture server. When selected, also configure 
Compensate for Computer Clock Drift.

Caution: If your Lightspeed Live Server’s Time Zone Setting is set to a time zone 
that does not have Daylight Savings Time, computer clock use UTC time, due to a 
Windows limitation.

– None—Specifies zero-based timecode recording. When recording begins, the 
timecode is set to 00:00:00:00. If Free Run Timecode is enabled, then the 
timecode inserted into a QuickTime or MXF file auto-increments. Otherwise, 
every frame in the output file contains timecode 00:00:00:00. Capture displays N/
A on the workflow thumbnail, indicating that there is no applicable timecode 
available, and 00:00:00:00 displays in Capture’s Preview timecode window.

Free Run Timecode—Enabling Free Run Timecode when Compensate for Computer 
Clock Drift is enabled has no effect. When enabled, and the desired timecode is not 
detected or goes away, the timecode seamlessly free-runs from the last good timecode 
received. When Free Run Timecode is not enabled and the desired timecode is not 
detected or goes away, the timecode reverts to zero (00:00:00:00) and stays at zero.

Compensate for Computer Clock Drift—Only applies when Computer Clock is 
specified as Timecode Source.

Regardless of how Compensate for Computer Clock Drift is set, if packets are lost and 
frames are dropped the Live Source process adds frames using the last good timecode 
in order to compensate for the lost frames. This may cause timecode values to be 
repeated where a frame was lost. If your Transport Stream signal is strong, this problem 
should not occur.

When Compensate for Computer Clock Drift is enabled
Computer Clock Time is monitored and compared to the timecode being added to 
the captured file. Since the Computer Clock is not gen-locked with a true time 
source associated with the incoming frames it can drift over time and get out of 
sync with the incoming stream. When a drift of one second is reached the timecode 
being added to the file is re-synced to the system's Computer Clock time. This 
means there may be a discontinuity in the file’s timecode at the point where the re-
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sync occurred. Enabling Free Run Timecode when Compensate for Computer Clock 
Drift is enabled has no effect on the process described here.

When Compensate for Computer Clock Drift is Disabled
The source process uses the Computer Clock time without compensating for drift. 
Over time the timecode may drift several seconds compared to the ‘real’ time. For 
example—if a recording is 6 hours long the Computer Clock drift might be many 
seconds by the end of the 6 hour recording. If no frames were dropped the time-
code in the output file is contiguous from start to finish.

Freeze on LOS—When enabled, causes the source to hold the last good frame if the 
signal is lost. When disabled, LOS causes the LOS Video Test Pattern to be displayed. For 
details, see Loss of Signal Behavior.

LOS Video Test Pattern—Applies only when Freeze on LOS is disabled. Specifies the 
test pattern to display during LOS.

LOS Audio Test Signal—Specifies the audio signal to use during LOS.
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Creating & Configuring NDI Sources
NDI (Network Device Interface) is a royalty-free software specification to enable video-
compatible products to communicate, deliver, and receive high-definition video over 
gigabit Ethernet networks in a high-quality, low-latency, frame-accurate manner and 
suitable for switching in a live production environment.

Video is limited to HD and 16 audio channels.

Live Source supports a Loss of Signal state to maintain the channel when there is no 
active signal from an established NDI source, but the video (frame rate, frame size, bit 
depth, etc.) and audio (channel count, bit depth) cannot change when the signal is re-
established. 

NDI Access Discovery Method requires TCP port 5960.

To create and configure a new NDI source, click the Add Input icon in the Sources panel 
toolbar and select NDI to display the Configure Source panel:

If you require an NDI source channel from a new NDI source, Telestream recommends 
that you create a new NDI source channel and configure it, instead of editing an 
existing NDI source.

Note: You can only format IP sources using standard frame sizes and frame rates. See 
the Technical Specifications topic in the Lightspeed Live Capture product sheet on the 
Telestream web site for supported formats.
Some controls display only when you enable advanced mode. Select Settings in the main 
menu  to display the System Settings panel. See Managing System Settings.

Telestream recommends limiting IP-based sources to eight, unless testing in your 
environment indicates you can support more.

Click the + icon and select NDI 
from the menu.

https://telestream.net/pdfs/datasheets/dat-Lightspeed-Live-Capture.pdf
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For Live Capture systems with more than one server, you should name each separate 
Lightspeed Live Server’s NDI sources with unique names—for example, add the 
Lightspeed Live Server name as a prefix: Lightspeed1-NDI.

When configuration is complete, click Save to close the panel and create the NDI source 
per your specifications.

Name—Specifies the name used to identify this source in Capture web apps and the 
Vantage Capture action. You can’t change the name while the source is being captured.

When you name a source, observe these rules:

– Each source instance must be named uniquely.

– These characters are prohibited: ` * | \ : ; " ' < > ? / 

– After changing a source name you must re-configure affected Capture actions in 
Vantage workflows that utilize the renamed source. See Capture Action Overview 
and Configuration.

Description—Practical description of the source.

Stream—Specifies the identity of the NDI stream.

Live Capture supports NDI Access Discovery Method (active polling). This method 
supports discovery both within the same subnet and across subnets. If the NDI sources 
are on the same subnet as the Lightspeed Live server, the Source menu in the NDI 
Source Configuration panel auto-populates and displays the list of NDI sources that are 
discoverable.

If the NDI sources are not on the same subnet, the Source menu in the NDI Source 
Configuration panel auto-populates and displays the list of NDI sources that are 
identified in the NdiSources.config file. 

If the NDI sources are not on the same subnet, update the configuration file:



Managing Video Sources
Creating & Configuring NDI Sources

257

LIve Capture User’s Guide

• Add the NDI source or the NDI source’s IP address using the NDI Tools Access Man-
ager application in NDI Tools

OR

• Enter the IP address of the NDI source in C:\Program Files\Telestream\Live Source 
Server\NdiSources.config and restart the Telestream Live Source Service.

Restart the Telestream Live Source Service. 

Max Time-Shift—Specifies the maximum duration of video that the time-shift frame 
buffer can hold, which is used to delay the source for workflows using this source. 
Specifies the duration in seconds (maximum: 10). Some limitations may exist for higher 
bit rates and frame rates.

Note: Live Capture’s Time-Shift holds incoming source media frames in an internal 
FIFO buffer. See Determining the Time-Shift Buffer Duration for suggested settings for 
various frame sizes and rates. 

When a capture workflow is activated with Time-Shift enabled, the source media is 
stored in the buffer, which allows Lightspeed Live to reach back in time and access 
media processed in the past, based on the value of the Time-Shift field. Since Live 
Capture’s Time-Shift is always processing a source’s media, when you start recording, 
any media stored in the buffer is available to be added to the capture file.

Timecode Source—Choose one of the following timecode source signals for the 
selected source:

– Source—Uses embedded VITC timecode in the source ancillary stream, if present. 
If a valid timecode is not available or goes away, see the Free Run Timecode 
option below.

– Computer Clock—Uses the time-of-day clock provided by the Lightspeed Live 
Capture Server. When selected, also configure Compensate for Computer Clock 
Drift.

Caution: If your Lightspeed Live Server’s Time Zone Setting is set to a time zone 
that does not have Daylight Savings Time, computer clock should use UTC time, 
due to a Windows limitation.

– None—Specifies zero-based timecode recording. When recording begins, the 
timecode is set to 00:00:00:00. If Free Run Timecode is enabled, then the 
timecode inserted into a QuickTime or MXF file auto-increments. Otherwise, 
every frame in the output file contains timecode 00:00:00:00. Capture displays 
N/A on the workflow thumbnail, indicating that there is no applicable timecode 
available, and 00:00:00:00 displays in Capture’s Preview timecode window.

Note: When using the CalDAV Calendar trigger you should set Timecode Source to 
either Computer Clock or Source. When using Source, you must have time-of-day 
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timecode in your source that matches the time set in your Lightspeed Live Server. 
See Configuring Trigger Settings. 

Freeze on LOS—When enabled, causes the source to hold the last good frame if the 
signal is lost. When disabled, LOS causes the LOS Video Test Pattern to be displayed. For 
details, see Loss of Signal Behavior.

Free Run Timecode—When enabled, starts timecode from 0 if there is no embedded 
timecode in the source.

When enabled, and the timecode is not detected or goes away, the timecode 
seamlessly free-runs from the last good timecode received. When not enabled and the 
timecode is not detected or goes away, then the timecode reverts to zero (00:00:00:00) 
and stays at zero.

LOS Video Test Pattern—Applies only when Freeze on LOS is disabled. Specifies the 
test pattern to display during LOS.

LOS Audio Test Signal—Specifies the audio signal to use during LOS.
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Creating and Configuring ST 2110 Sources
You can ingest ST 2110 sources on a C2+ | C4 Lightspeed Live Server that includes a 
dual-port 25/100Gb Ethernet NIC with redundant backup via SMPTE 2022-7. On other 
servers, ST 2110 sources are not supported.

Note: See Lightspeed Live Server Specifications > Ethernet-based media—ST 2110 for 
limits on ingesting ST 2110. Also, see the Technical Specifications in the Lightspeed 
Live Capture product sheet on the Telestream web site for supported formats.

When the secondary NIC port is used for an ST 2110 source, Live Source displays an 
indication of the 2022-7 status in the source statistics panel:

You can also view an ST 2110 channel card to determine primary and secondary 
channel status (see Channel Controls). Green up arrows indicate a connection; red down 
arrows indicate the ST 2110 source is disconnected.

To modify an ST 2110 source configuration, select it in the Sources panel to display its 
Preview panel. Click the Edit icon  to display its Configure Source panel.

To create an ST 2110 source (using text / HTML SDP files or NMOS), click the Add Input 
 icon in the Sources panel toolbar:

ST 2110 Secondary (SMPTE 2022-7) status.

Click the + icon and select ST 2110 
Input from the menu.

https://telestream.net/pdfs/datasheets/dat-Lightspeed-Live-Capture.pdf
https://telestream.net/pdfs/datasheets/dat-Lightspeed-Live-Capture.pdf
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Select ST 2110 to display its Configure Source panel, shown here with NMOS enabled:

When configuration is complete, click Save to close the panel to create or update the ST 
2110 source per your specifications.

Name—Specifies the name to use in Capture web apps and the Vantage Capture 
action. You can’t change the name while the source is being captured.

When you name a source, observe these rules:

– Each source instance must be named uniquely.

– These characters are prohibited: `*|\:;"'<>?/

– After changing a source name you must re-configure affected Capture actions in 
Vantage workflows that utilize the renamed source. See Capture Action Overview 
and Configuration.

Description—Practical description of the source.

Network Interface—Specifies the primary 25/100Gb Ethernet NIC. 

Secondary Network Interface—Specifies the secondary 25/100Gb Ethernet NIC, 
chosen from the menu. May be enabled or disabled.

NMOS —If your video network utilizes NMOS (Networked Media Open Specification), 
enabling NMOS hides the SDP fields, and enables the Live Source NMOS node, device, 
and receivers (video, audio and data) to be discoverable in an NMOS registry and an 
NMOS browser/explorer. 

Advanced mode only—
enable Advanced Mode in 
the System Settings panel.



Managing Video Sources
Creating and Configuring ST 2110 Sources

261

LIve Capture User’s Guide

To set NMS logging levels on your Capture server, see Setting NMOS Logging Levels.

The Live Source NMOS Node Server (per AMWA IS-04 NMOS Discovery and Registration 
Specification) dynamically interfaces with the NMOS infrastructure; adding, deleting, 
updating or retrieving NMOS information associated with an ST 2110 source (per 
AMWA IS-05 NMOS Device Connection Management Specification).

When NMOS is Disabled...

When NMOS is disabled, SDP File controls display so that you can specify them:

Video SDP File—Specifies the URL of the required SDP file for use with a video 
stream (may be either text or HTML files).

Audio SDP File(s)—Specifies the URL of the required SDP file(s) for use with audio 
streams (may be text or HTML files). Up to 4 permitted, each on a separate line. 

Ancillary SDP File—When enabled, specifies optional SDP file URL for use with 
ANC data streams. In order to receive closed captions data and VITC timecode, a 
valid ANC data stream is required (may be text or HTML file).

Video | Audio | Ancillary Media Index—Specifies the index of the file.

Force 8-Bit Video—Forces a 10-bit source to be down-sampled to 8-bit. Unlike SDI 
sources which are inherently 10-bit but are rendered to either 8- or 10-bit frames by the 
AJA card, the ST 2110 source data may be any bit depth supported by the standard. The 
bit depth is specified in the video SDP file. Force 8-bit works regardless if NMOS is 
enabled or not. NMOS wraps an SDP description, and Live Source manager can convert 
it to a 10-bit or an 8-bit video format internally.

8-bit video should only be used with 8-bit codecs such as XDCAM. Using 8-bit sampling 
offers more efficient compression.

2022-7 HW Mode (Advanced mode only—see Managing System Settings)—Enables 
2022-7 hardware mode when the SDP configuration files for the incoming streams 
specify an associated secondary stream. In 2022-7 HW mode, processing is offloaded to 
a processor on the 25/100Gb Ethernet NIC. Enabling this control enables the Live 
Source process to use less CPU cycles and system memory.
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Freeze on LOS—When enabled, causes the source to hold the last good frame if the 
signal is lost. When disabled, LOS causes the LOS Video Test Pattern to be displayed. For 
details, see Loss of Signal Behavior.

Preferred Processor

Note: If this control doesn’t display, processor balancing on this model server is 
performed automatically, and no end-user adjustment is available, or advanced mode 
is disabled (see Managing System Settings). Use only when capturing SD/HD SDI 
sources—disable it when capturing UHD/4K.

When enabled (C2+ and earlier), processing associated with each Capture | Tape job is 
assigned to the assigned CPU on the server’s multi-core CPU to prevent inefficient 
process mapping across CPU sockets during heavy loads, typically when several 
sources are capturing concurrently. 

On C4 and later models, for IP sources you can manually set affinity to a specific socket. 
If you create IP sources in order and use them in order, balancing is automatic. However, 
for example, if you delete every other IP source, the remaining sources do not balance 
and you can use can use this control to balance them. If IP sources are maintained long 
term, it may be helpful to assign each source a preferred processor.

Disabling this option during multi-source capturing may result in excessive CPU usage. 
When Preferred Processor is disabled, affinity is set to 0 (Balancing CPU Processor Group 
Affinities).

Initial Video Format (SD formats not supported). Initial Video Format enables a 
recording session to start before signal is established, so that a recording in progress 
does not get locked as loss of signal at 1080p30. This is especially useful when you are 
using a workflow with recurring segments or it is set to activate on power up, or signal 
is lost or power is lost temporarily. When the ST 2110 Source loses connection with the 
sender, the video is replaced with a test signal as configured in Initial Video Format.

Specifies the video format to ingest when no video signal is being received. When the 
signal starts or restarts (and ignore lost frames is enabled in the Live Capture workflow), 
the signal is recorded, provided that is the same format as initial video format you have 
specified.

Sync Timeout—ST 2110 sources consist of multiple streams: video, audio, and ancillary 
data. When more than one stream in a given source is patched, Live Capture attempts 
to align the timestamps of the streams so they are in sync. If it can't sync the streams in 
less than the time (in milliseconds) in this field (2000 ms by default) it displays an error, 
and does not add the stream.

LOS Video Test Pattern—Applies only when Freeze on LOS is disabled. Specifies the 
test pattern to display during LOS. For details, see Loss of Signal Behavior.

LOS Audio Test Signal—Specifies the audio signal to use during LOS.

Max Time-Shift—Specifies the maximum duration of video that the time-shift frame 
buffer can hold, which is used to delay the source for workflows using this source. 
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Specifies the duration in seconds (maximum: 10). Some limitations may exist for higher 
bit rates and frame rates.

Note: Live Capture’s Time-Shift holds incoming source media frames in an internal 
FIFO buffer. See Determining the Time-Shift Buffer Duration for suggested settings for 
various frame sizes and rates. 

When a capture workflow is activated with Time-Shift enabled, the source media is 
stored in the buffer, which allows Lightspeed Live to reach back in time and access 
media processed in the past, based on the value of the Time-Shift field. Since Live 
Capture’s Time-Shift is always processing a source’s media, when you start recording, 
any media stored in the buffer is available to be added to the capture file.

Timecode Source—Click the menu to choose one of the following timecode source 
signals for the selected SDI input:

– Source—Uses embedded VITC timecode in the source ancillary stream, if present. 
If a valid timecode is not available or goes away, see the Free Run Timecode 
option below.

– Computer Timecode—Uses the time-of-day clock provided by the Live Capture 
Server. When selected, also configure Compensate for Computer Clock Drift.

Caution: If your Lightspeed Live Server’s Time Zone Setting is set to a time zone 
that does not have Daylight Savings Time, computer clock should use UTC time, 
due to a Windows limitation.

– None—Specifies zero-based timecode recording. When recording begins, the 
timecode is set to 00:00:00:00. If Free Run Timecode is enabled, then the 
timecode inserted into a QuickTime or MXF file auto-increments. Otherwise, 
every frame in the output file contains timecode 00:00:00:00. Live Capture 
displays N/A on the workflow thumbnail, indicating that there is no applicable 
timecode available, and 00:00:00:00 displays in Capture’s Preview timecode 
window.

Note: When using the CalDAV Calendar trigger you should set Timecode Source to 
either Computer Clock or Source. When using Source, you must have time-of-day 
timecode in your source that matches the time set in your Lightspeed Live Server. 
See Configuring Trigger Settings. 

Free Run Timecode—When enabled, starts the timecode from 0 if there is no 
embedded timecode in the source.

When enabled, and the timecode is not detected or goes away, the timecode 
seamlessly free-runs from the last good timecode received. When not enabled and the 
timecode is not detected or goes away, then the timecode reverts to zero (00:00:00:00) 
and stays at zero.
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Raw Ancillary Dump (Advanced mode only—see Managing System Settings)—When 
enabled and the output container is set to TIFO, the SDI input’s ancillary data is inserted 
directly into the Primary Output file

Caution: Do not enable this option unless directed by Telestream Support. 
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Managing System Settings
Click Source Manager’s More  menu > Settings to display the System Settings dialog: 

 

Use this panel to configure these controls to meet your requirements:

Advanced Mode—Enables/disables advanced mode. In advanced mode, all controls 
display; otherwise, certain controls in source configuration panels are hidden. 
Advanced mode controls are identified in this guide by the phrase Advanced Mode 
Only.

External Reference Input—Enable to synchronize looped-through outputs from Live 
Source Manager to an external reference—see Using External Reference (REF) for SDI 
Playout for details.

RTMP Listener Port—Specifies the RTMP listener port. Default: 1935. If you change the 
listener port, be certain the RTMP server is also sending to the same port. Be sure to 
restart the Telestream Live Source Service—see Restarting the Telestream Live Source 
Service for guidance.

Restrict Preview Ports Range—When enabled, restricts the range of preview ports 
that you can automatically select when the selection may interfere with other network 
traffic. Default lower and upper range: 1024 to 65534. Be sure to restart the Telestream 
Live Source Service—see Restarting the Telestream Live Source Service for guidance.

– Port Range Start | End—Specifies the lowest and highest port to use. The Start 
value must be lower than Port Range End value.

Manual NMOS Registration—Displays only on Live Capture systems configured for 
use for ST 2110, with a Mellanox 25/100Gb card installed. When enabled, specify the 
NMOS registry controls to update the NMOS configuration file. Disable the control to 
remove all settings from the configuration file. See Manually Configuring NMOS 
Registration Settings for details.

Click Save to update changes you have made.
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Manually Configuring NMOS Registration Settings
When you enable Manual NMOS Registration in the System Settings dialog, Source 
Manager displays the NMOS controls: 

 

Configure these controls to meet your requirements:

Registry Address—the URL of the NMOS registry server

Registry Port—the port of the NMOS registry server

Registry API Version—the version of the AMWA IS-04 Query API that is in use in the 
NMOS registry environment. Live Source uses version 1.3 by default.

Node Port—the NMOS node port; default: 4212.

Connection Port—the connection port for AMWA IS-05 Device Connection 
Management; default: 3215.

Click Save to update the NMOS Registration configuration file and restart the 
Telestream Source Service for changes to take effect.

Using External Reference (REF) for SDI Playout
Lightspeed Live Servers manufactured beginning October 2022 with Corvid 44, Corvid 
88, and 12G SDI video cards have an additional connector intended for timecode 
reference. This LTC timecode reference connector has been added at the far right of the 
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card. You can use the Reference connector (labeled R) previously used for LTC on these 
cards for a Bi-Level or Tri-Level Sync signal. You can also use this Reference connector to 
synchronize looped-through outputs from Live Source Manager to external reference 
in Live Capture.

Lightspeed Live Servers so-equipped display the External Reference Input control in 
the System Settings panel.

When External Reference Input is enabled, the Ref port reads a black burst / Bi-Level / 
Tri-Level Sync signal, as opposed to analog LTC signal. The LTC port reads the analog 
LTC signal. If the External Reference Input is disabled, then the system is configured for 
Reference input (R) to accept LTC, and the LTC input is ignored.

Restart the Lightspeed Live Server to make this change take effect.

For Ref and LTC connection details, see Making Data and Signal Connections.

Version Info | Help | Documents | Contact Methods
Click main menu > About to display Source Manager’s About panel:

This panel provides the following:

• Source Manager version number

• Live Capture User Guide and legal documents—license agreements and copyright 
attribution statements

• Telestream customer service contact information—email, web site and telephone 
numbers.
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Troubleshooting

Can’t Start the Group Portal Web App
You’re trying to launch the Group Portal web app, and Chrome displays this error: “This 
site can’t be reached”. 

Resolution
Try these potential problems and retry:

• If you’re using localhost, make sure you’re on the target Lightspeed Live Server 
where Telestream Live Source Service is running.

• If you’re using a host name, verify that it is correct for the target Lightspeed Live 
Server.

• Open the Services panel and verify that Telestream Live Source Service is running; 
start if it isn’t.
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Lightspeed Live Server 
Resource Requirements

Live Capture uses a variety of codecs and container formats to digitize live video and 
serialize it into media files. At the simplest level, Live Capture consists of customizable 
workflow actions that automate the real-time video capture process. 

A workflow is the process you create in Vantage that ingests an incoming live source 
and compresses it using one of many codecs and saves the file using one of many 
container formats. It utilizes the Vantage Capture action to perform these tasks.

Given the data and computation intensity of multiple, simultaneous processes, care 
must be taken not to exceed the limits of the Lightspeed Live Server’s available 
resources.

General information is provided, as well as model-specific resource usage guidelines.

Note: This chapter provides information to help you calculate Lightspeed Live 
Capture resource usage when hosted on a Lightspeed Live Server—it is not intended 
for use on VM | cloud-based Live Capture systems.
On VM and cloud-based systems, you should conduct your own performance testing 
to determine how to configure your system and use it to meet these guidelines.

Topics
■ Overview

■ Balancing CPU Processor Group Affinities

■ Processes & Factors Affecting Performance

■ Capturing Uncompressed Media Via SDI

■ Maximum Concurrent Captures

■ Maximum Concurrent Captures for VM-based Live Capture

Note: CPU utilization should not exceed 75%; 60 percent or less is recommended. 
Contact Telestream (Obtaining Support | Information | Assistance) if you encounter 
situations where the load is not balanced across both nodes/sockets or exceeds 75%. 
Also see Use Source Manager to Manage Affinity Settings for affinity balancing.
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Overview
Several Live Capture workflows may be connected to a single video source. This 
enables you to configure your system to create multiple format output files from a 
single source simultaneously. For example, if your Live Capture workflow generates two 
hi-res output files, such as MXF OP-1a and QuickTime, Live Capture can be used for this 
by creating two Capture actions, both of which use the same source.

This figure illustrates four SDI HD inputs. SDI 1 is connected to two workflows. SDI 2, 3, 
and 4 are each connected to individual workflows. This source-to-workflow flexibility 
makes it important to ensure that simultaneous processes being performed on a 
Lightspeed Live Server do not exceed its total processing capabilities.

Processes that materially affect system resources include the Primary Output codec, 
Secondary Output codec and the input video’s frame size, video bit depth. Also, the 
Live web app’s Preview and thumbnails, and the time shift buffer (if enabled) affect 
resources. 

Keep in mind that the CPU is assigned to a processor group based on which source 
input is selected. See Balancing CPU Processor Group Affinities for details.

Every process should be taken into account when determining what resources are 
required. For example, if two workflows are sourcing from the same input, then the 
requirements are twice that required if only one workflow is sourcing the input.
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Balancing CPU Processor Group Affinities
Live Capture uses the Windows processor affinity feature to balance CPU loads, to gain 
the most efficient CPU usage for capturing live SD/HD video. On servers where you can 
disable processor affinity, you should disable it when capturing UHD/4K video.

How Windows manages processor affinity varies by the server’s CPU characteristics. For 
CPUs with 64 or fewer logical processors, Windows manages affinity one way. On 
platforms with CPUs with more than 64 logical processors, affinity is handled 
differently, due to socket management limits. 

Note: Disabling the Preferred Processor control is generally not beneficial, except on 
VM-based Live Capture SW systems, which only perform one capture at a time.

Live Capture workflows execute capture processes on the processor group (also known 
as CPU affinity) to which the associated source has been assigned.

Live Capture automatically assigns each source affinity to a processor group (Affinity 1 
or Affinity 2) at start-up. Live Capture assigns affinity to IP sources when you create 
them, based on the Preferred Processor control’s settings.

Note: To ensure balanced processor groups when you are using six 10-bit sources, 
you should use all four ports of the first SDI card and two ports of the second SDI card, 
with 2 ports unused. The two unused sources should be alternating affinities to 
maintain balance in the rest of the sources.
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Use Source Manager to Manage Affinity Settings
You use Source Manager to view and modify all of your source’s affinity status and 
assignment, which is controlled by the Preferred Processor control in the source’s 
Configure Source dialog, as shown here:

Note: If this control doesn’t display, processor balancing on this model server is 
performed automatically, and no end-user adjustment is available, or advanced mode 
is disabled (see Managing System Settings). Use only when capturing SD/HD SDI 
sources—disable it when capturing UHD/4K.
This control displays on all server models when Advanced Settings is enabled. The 
ability to disable Preferred Processor is enabled only on systems with less than 64 
logical processors.

To display the Preferred 
Processor control, enable 
Advanced Mode in the System 
Settings panel.

Preferred Processor can’t be 
disabled when the server has 
64+ processors.

Preferred Processor can be 
disabled when the server has 
64 or less processors.
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Care should be taken to ensure that a processor group is not assigned more workflows 
than it can support. See the Resource Utilization tables later in this chapter for specific 
processor and codec capacities.

To determine which processor group a given source has been assigned, in Source 
Manager, make sure Advanced Mode is enabled (Managing System Settings). Select a 
source to view the processor group assignment (in the Affinity column)—as well as CPU 
utilization—in real time:

Managing Affinity on C1 | C2 | C2+ Servers
C1 | C2 | C2+ Lightspeed Live Servers have two separate CPU processor groups. When 
enabled, processing associated with each Capture | Tape job is assigned to the assigned 
CPU on the server’s multi-core CPU to prevent inefficient process mapping across CPU 
sockets during heavy loads, typically when several sources are capturing concurrently. 

You can manually set affinity to a specific socket for any source type on any model. If 
you create IP sources in order and use them in order, balancing is automatic. However, 
for example, if you delete every other IP source, the remaining sources do not balance 
and you can use this control to balance them. If IP sources are maintained long term, it 
may be helpful to assign each source a preferred processor.

For both source types—dynamically created sources (IP sources) and permanent 
sources (SDI sources)—it is possible to delete dynamically created sources in a way that 
leave the remaining sources unbalanced. 

Disabling this option during multi-source capturing may result in excessive CPU usage. 
When Preferred Processor is disabled, affinity is set to 0.

On a C2+ Lightspeed Live server, with advanced mode enabled (Managing System 
Settings), you can disable manual affinity completely—disable the Preferred Processor 
control in the Configure Source dialog. When you disable Preferred Processor, the Live 
Source process will attempt to use both sockets.

Managing Affinity on C4 | C5 Servers
On a C4 or C5 server, you can manually set affinities when required for IP 
sources.Processor affinities should be balanced for optimal utilization. Generally, SDI 1 | 
3 | 5 | 7 are assigned an affinity value of 1. SDI 2 | 4 | 6 | 8 are assigned affinity 2.

Balancing affinities is generally automated. SDI affinities—set automatically. When you 
dynamically create sources, you typically don’t need to adjust affinities in order and use 
them. However, if you delete alternate IP sources, for example, you may be left with 
sources that do not balance. 

Affinity for a given source is set zero (0) when Preferred Processor is disabled for the 
source.
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When performing 4 concurrent captures, they should be balanced across processor 
arrays. For example 1, 2, 3, 4 or 5, 6, 7, 8 are balanced across affinity groups. 1, 3, 5, 7 or 2, 
4, 6, 8 aren’t balanced, because they are assigned the same affinity group and thus, will 
saturate the resources of the CPU processor group.

On a C5 server, when you are capturing 6 10-bit sources, you should use all four SDI 
ports of the first SDI card and two of the second. The last two ports of the second card 
remain unused. These two unused sources should be alternating affinities to maintain 
balance in the rest of the sources.

Note: CPU utilization should not exceed 75%; 60% or less is recommended.

For more details, see Source Information and Statistics Panel and Maximum Concurrent 
Captures.
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Processes & Factors Affecting Performance
These processes and factors materially affect system resources:

Primary Output Codec
The Primary Output codec is the most resource intensive component. See the codec 
charts below for general information on CPU utilization.

Secondary Output codec
The Secondary Output AVC codec generally utilizes the GPU for encoding and uses the 
CPU for video processing library operations such as spatial formatting and interlacing. 
It is the second most resource intensive component. 

Codec/Source Input Bit Depth
It is considered best practices to match the selected codec's bit depth to the bit depth 
of the source input. For example, DNxHD HQX is a 10-bit codec. Set the associated 
source input to 10-bit in order to avoid additional processes to convert the incoming 
frames to match the codec's bit depth.

In contrast, DNxHD SQ is an 8-bit codec, so you should use it only on 8-bit source, in 
order to obtain the most efficient resource usage.

Live Capture Web App
Using the Live Capture web app directly on a Lightspeed Live Server adds to the 
resource load. This fact must be taken into account when capturing multiple channels 
concurrently. For details, see Live Capture Web App.

Telestream recommends that you connect to the Live web applications from browsers 
running on client workstations and you do not run them directly on a Lightspeed Live 
Server. This avoids additional decoding load for the Live Web app's preview directly on 
the server.

Determining the Time-Shift Buffer Duration
The Time-Shift buffer in the Lightspeed Live Server has a maximum duration of 10 
seconds for each source. The memory used by each instance of the Time-Shift buffer is 
directly related to the frame size and frame rate of the source video. 

Note: For more details about the Time-Shift buffer, see Creating Live Capture 
Workflows.

Use the following data as a baseline when determining the duration of each source’s 
Time-Shift buffer:
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Standard Definition (SD) Codecs
• NTSC and PAL—The total for all (maximum 8 SD sources) source Time-Shift buffers 

combined should not exceed 80 seconds.

High Definition (HD) Codecs
• 720p/1080i /1080p up to 30fps— The total for all Time-Shift buffers combined 

should not exceed 80 seconds.

• 720p/1080p above 30fps—The total for all Time-Shift buffers combined should 
not exceed 60 seconds.

UHD/4K Codecs
• The total for all (maximum 2 UHD/4K sources) Time-Shift buffers combined should 

not exceed 20 seconds.
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Capturing Uncompressed Media Via SDI
Live Capture hosted on a Lightspeed Live server can capture Uncompressed SD | HD 
|UHD/4K in 8- or 10-bit via SDI. Several factors (both platform- and media-based) 
determine capture limits. 

• Storage Location—Local media drive or shared storage (NAS | SAN).

• Drive Configuration—The drive configuration is governed by the number of drives 
in your Live Capture server’s media drive and the RAID type. A standard Live Cap-
ture server ships with a media drive containing 4 drives striped as RAID 5. In addi-
tion, the media drive can be expanded to 8 drives by purchasing Media Drive 
Option LS-LIVE-4TB-OPTION. The RAID type of the media drive can be changed   
from RAID 5 by the end user to RAID 0 if disk I/O is more important than data redun-
dancy. See Rebuilding the Lightspeed Live Storage RAID.

• Frame Size | Frame Rate | Scan Type—The incoming source frame size, frame rate, 
and scan type (interlaced (i) | progressive (p)) affects the requirements for capturing 
and generating an uncompressed output file.
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Maximum Concurrent Captures
Use this table to determine the resource requirements for capture workflows executing 
concurrently on a Lightspeed Live Server, based on the codec and profile you’ve 
specified in the Capture action. When ingesting multiple concurrent feeds, the CPU 
load is automatically balanced across both NUMA nodes/CPU sockets.

Caution: You shouldn’t route more than six 10-bit, 59.94 SDI sources to a server, 
whether you’re capturing them or not—over time, it degrades performance. If all 
8 sources are 1080p 59.94 progressive, two of them should be switched to Force 
8-bit or they should be a lower frame rate than 59.94 FPS. 

Codec and Profile Max. Concurrent Captures per Server
C2 C2+ C3 C4/C5

HD 1080p @ 59.94
AVC-H.264 2 4  4 6
Panasonic AVC-Ultra 25 2 4  4 6
Panasonic AVC-Intra 50 2 4  4 6
Panasonic AVC-Intra 100 2 4  4 6
Panasonic AVC-Intra 200 2 4  4 6
Sony XAVC Class 100 (HD) 2 4  4 6
Sony XAVC Long Class 50 2 4  4 6
HEVC 2 4  4 6
Avid DNxHD up to HQX 2 4  4 6
Apple ProRes HD 444 2 4  4 6
Apple ProRes 422 HD up to HQ 2 4  4 6
Sony XAVC Class 100 2 4 4 6
x264 HD - Baseline, Main, High (8-bit) 2  4 6
x264 HD - High 10, High 422(10-bit) 4  4 6
x265 HD - Main10 2 4  4 6
JPEG2000 YUV 10-bit lossless 2  1 2
JPEG2000 YUV 10-bit lossy 2 1 2
HD 1080i @ 29.97
Sony XDCAM 420/422 (8-bit) 4 8 8
DVCProHD 4 8 8
HD 1080i @ 59.94
Sony XDCAM 420/422 (8-bit) 2 8 8
DVCProHD 2 8 8
JPEG2000 YUV 10-bit 2 2 4
SD NTSC
IMX 2 4 8 8
DV/DVC Pro 2 4 8 8
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Maximum Concurrent Captures for VM-based Live 
Capture

Live Capture Software requires one license per capture, for a maximum of four licenses 
per VM. If a single license is active but multiple Capture workflows are active, you can 
not start a capture operation. See Live Capture Software Licensing for licensing details.

UHD/4K
JPEG2000 YUV 10-bit lossless 1 up to 30p 1 up to 30p 2 up to 30p
JPEG2000 YUV 10-bit lossy 1 up to 30p 1 up to 30p
Sony XAVC Long QFHD Class 100  1 up to 30p  2 up to 30p
Sony XAVC Long QFHD Class 200  2 up to 30p
Sony XAVC Class 300 (4K/UHD) 1 up to 30p 

(CBG | VBR

1 up to 60p 
(CBG only)

 2 up to 30p  2 up to 60p

Sony XAVC Class 480 (4K/UHD) 1 up to 30p 
(CBG | VBR)

2 up to 30p 2 up to 60p
(CBG only)

Avid DNxHR 4K/UHD up to HQX 1 up to 30p 2 up to 30p 2 up to 60p
Apple ProRes 422 4K/UHD SQ 1 up to 60p 2 up to 60p 2 up to 60p
Apple ProRes 422 4K/UHD HQ 1 up to 60p 2 up to 30p 2 up to 60p
x264 4K/UHD 1 up to 30p 2 up to 30p 2 up to 30p
x265 4K/UHD 1 up to 30p 2 up to 30p 2 up to 30p
XAVC QFHD Long Class 100  1 up to 30p 2 up to 30p
XAVC QFHD Long Class 140
XAVC QFHD Long Class 200 1 up to 30p 2 up to 30p

Codec and Profile Max. Concurrent Captures per Server
C2 C2+ C3 C4/C5
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Connecting VTR Systems

This chapter describes connecting VTR units to a Lightspeed Live Server using the 
optional 4-port USB-to-RS-422 VTR Interface Kit (purchased separately) so that you can 
control them with the Tape web app.

The 4-port RS-422 VTR Interface Kit enables you to connect up to 4 VTRs to the 
Lightspeed Live Server. The VTR Interface Kit muxes and passes multiple RS-422 port 
connections through a single USB cable, connected to the Lightspeed Live Server.

To support 8 VTRs you can use two 4-port VTR Interface Kit.

Note: Before you can capture video from a VTR, the system must be set up and 
configured (Configuring Vantage and Updating Live Capture), including a tape capture 
workflow (Creating Live and Tape Capture Workflows). 
Use of the Tape Capture web app is described in Capturing Tape Media.

Topics
■ 4-Port Interface Kit Components

■ Installing the RS-422 Interface Box

■ Connecting a VTR to the Lightspeed Live Server

■ RS-422 Connector Pin Assignments

■ Configuring RS-422 Port Latency Time
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4-Port Interface Kit Components
The 4-Port RS-422 VTR Interface Kit includes these components: 

• One USB-to-RS-422 interface box, pre-mounted, providing four RS-422 serial ports

• One 1R-U rack-mount tray that can hold two RS-422 interface boxes

• One USB cable to connect the RS-422 interface box to the Lightspeed Live Server

• Two sets of RS-422 DB9-to-RJ45 (Ethernet style) adapters:

– Four Female DB9-to-RJ45 blue adapters to connect to the RS-422 interface box. 

– Four Male DB9-to-RJ45 gray adapters to connect to a VTR.

• Rack mount tray mounting hardware (see image below) includes:

– Four 10-32 rack screws and washers

– Four G-type cage nuts

– One small tie-wrap to secure the USB cable to the tray.

The RS-422 interface box is powered by the Lightspeed Live Server’s USB port, so no 
additional power supply is required. Drivers for the USB-to-RS-422 interface box are 
included in the software package and are installed as one of the steps below.
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Installing the RS-422 Interface Box
The RS-422 interface box and tray should be installed in a rack. It is best installed in the 
rear of the equipment rack directly behind the Lightspeed Live Server—or directly 
above or below—to be close to the Lightspeed Live Server USB ports.

To install the USB-to-RS-422 interface box in its rack mount tray, follow these steps:

1. Insert the USB cable into the 
rear of the RS-422 interface 
box. 
Fasten the USB cable to the tray 
by inserting the tie wrap 
through the raised anchor tab 
and tighten it to secure the 
cable.

2. To prepare the tray mounting 
location, place the four G-type 
cage nuts onto holes of an 
open rack space that is close 
to the Lightspeed Live Server. 

3. Install the rack mount tray 
with the supplied screws and 
washers into the cage nuts.

4. Making sure that the Lightspeed Live Server is off, attach the USB cable to the 
Lightspeed Server; for a single 4-port box, insert the USB cable into either USB port. 
For two 4-port boxes, plug box 1 into the lower USB port to support VTRs 1-4; plug 
box 2 into the top USB port for VTRs 5-8.
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Note: If only one USB port is available, use an external USB hub to provide additional 
ports. Plug box 1 into the hub's first USB port and box 2 into the second USB port.

Do not turn on your Lightspeed Live Server yet. Proceed to Connecting a VTR to the 
Lightspeed Live Server, following.
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Connecting a VTR to the Lightspeed Live Server
If you have a single VTR, you should connect it (RS-422 and SDI) through the box to the 
Lightspeed Live Server on the first port. For example, connect the VTR’s RS-422 port to 
Channel 1 (CH1) on the RS-422 interface box and then connect the VTR’s SDI Out to SDI 
1 on the Lightspeed Live Server. 

For multiple VTRs, Telestream suggests plugging VTR1 into RS-422 and SDI Port 1, VTR2 
into RS-422 and SDI Port 2, etc.

Note: The back plane of the Lightspeed Live Server has two USB ports. When using 
two 4-port RS-422 boxes to support up to 8 VTRs, connect the bottom USB port to the 
4-port RS-422 box supporting VTRs 1 through 4 and the top USB port connects to a 
second 4-port RS-422 box supporting VTRs 5 though 8. 

To make the connections for each VTR, follow these steps:

1. Turn off the VTR and the Lightspeed Live Server.

2. Position or install the VTR(s) in a safe and convenient location co-located near the 
RS-422 box and the Lightspeed Live Server.

3. If you are using RJ45 cables for control, attach the gray, male DB9-to-RJ45 adapter 
to the RS-422 terminal on the VTR.

Note: If an RS-422 router is between the RS-422 interface box and the VTR, the male 
DB9-to-RJ45 gray adapter should be plugged into the router on the Lightspeed Live 
Server side of the system. 

4. To prepare for VTR connection, If you are using RJ45 cables for control, attach a 
female DB9-to-RJ45 blue adapter to the Channel 1 (CH1) RS-422 serial port on the 
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interface box. Attach additional DB9-to-RJ45 blue adapters to other channels if you 
plan to connect more than one VTR. 

Connect a user-supplied serial cable into the RS-422 port or Cat5E (or higher) cable 
into the RJ45 jack on the adapter connected to the VTR. A Cat5E (Cat5 Enhanced) 
cable is recommended; a straight-through pin-to-pin type (not a cross-over cable) 
is required. The maximum cable length is 100 meters (328 feet).

5. Connect the other end of the Cat5E cable into the DB-9 connector or RJ45 jack on 
the adapter connected to the RS-422 interface box, on the terminal number that 
corresponds to the SDI source (input) number you want to use on the Lightspeed 
Live Server. 

6. Connect an SDI cable to the SDI Output terminal on the VTR.

7. Connect the other end of the SDI cable to the SDI input terminal on the Lightspeed 
Live Server that corresponds to the same terminal number you connected to on the 
RS-422 interface box.

8. Power up the VTR and switch it into the proper Remote mode for RS-422 control.

9. To establish serial communication, the RS-422 Interface Box must be initialized in 
the Vantage Live Service on the Capture server. 

10. To initialize the device, make sure that it is plugged into a USB port and re-start 
your Live Capture server.

When all connections are complete between the VTR, the RS-422 interface box, and the 
Lightspeed Live Server, the VTR connection is initialized and CH1 (Channel 1) of the RS-
422 interface box automatically synchronizes with SDI 1 on the Lightspeed Live Server, 
and similarly for all other VTRs.
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RS-422 Connector Pin Assignments
Use the pin assignment diagram below if you have to create custom RS-422 cables for 
your USB-to-RS-422 interface box.
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Configuring RS-422 Port Latency Time
The RS-422 port’s latency is set at 1 msec by default. However, if new drivers are 
installed or a new USB-to-RS-422 interface box is used, the latency value may not 
persist and should be reconfigured to 1 msec or other value as required.

Note: The COM port number typically starts with 3 for VTR connections because COM 
ports 1 and 2 are permanent and reserved. Therefore, VTR1 is typically COM port 3; 
VTR2 is 4, VTR5 is 7, etc.

Follow these steps to set each USB Serial Port’s Latency Timer value to 1 msec:

1. Open Device Manager on the Lightspeed Live Capture server.

2. Click on Ports > USB Serial Port.

3. Select the first USB Serial Port, right-click and select Properties.

4. Select the Port Settings tab and click Advanced:

5. Change Latency Timer to 1 msec and click OK.

6. For multiple VTRs, repeat steps 3, 4 and 5 for the remaining USB serial ports. 

7. Click OK to update and close the Device Manager.


	Lightspeed Live Capture Guide
	Lightspeed Live Capture User Guide
	Return Material Authorization (RMA) Procedure

	Introduction
	Live Capture Overview
	More Choices, More Flexibility
	Media Platform Friendly
	Fast, Parallel Open Media Processing
	File-Based Transcoding on Live Capture Servers

	Live Capture Web Apps
	Live Application Program Interfaces
	Vantage API
	Live Source API
	Live Capture API

	Live Capture Single Server Licensing
	Required Live Capture License
	Optional Live Capture Licenses
	Live Capture Software Licensing

	Licensing a Live Capture Array
	Single Server Vantage Domain Adding Live Capture
	New Vantage Arrays Including Live Capture
	Existing Vantage Arrays When Adding Live Capture

	Lightspeed Live Server Overview
	Lightspeed Live Server Specifications
	System Power
	Drives
	Cooling System
	SDI Video Cards
	Ethernet Network Interface Cards
	SDI Source Video Formats
	SDI Input Audio
	Input Reference
	Output Reference


	GPU
	Expansion Card Slots
	RS-422 VTR Interface Kit Option
	Front Panel
	Front Panel Features
	LEDs (left to right)
	Power On/Off Button
	UID Button (hidden)
	USB Ports
	Drives


	Rear Panel Ports and Connectors
	SDI Video Connections
	4-Port 3G SDI Card with Ref and LTC Connectors
	8-Port 3G SDI Card with Ref and LTC Connectors
	4-Port 3G SDI Card (Discontinued)
	8-Port 3G SDI Card (Discontinued)
	4-Port 12G SDI Card (Discontinued)
	16-Port (dual 8 port) 3G SDI Cards with Reference and LTC
	8-Port 3G SDI Card with LTC
	8-Port 3G SDI Card with LTC and REF


	25/100Gb Ethernet Connections

	Live Capture VM Server Requirements
	General VM Requirements
	Suggested Guidelines

	VMWare Server Requirements
	AWS EC2 Server Requirements


	Installing & Managing Your Lightspeed Live Server
	Installing a Lightspeed Live Server
	Unpacking the Server
	Rack-Mounting Your Lightspeed Live Server
	Assembling the Rails
	Installing Outer Rails into the Rack
	Installation in Round Hole Rack
	Installation in Square Hole Rack

	Installing the Server in the Rack
	Removing the Server from the Rack

	Making Data and Signal Connections
	First-Generation (Gen 1) Rear Panel—4-Port Card (Discontinued)
	C2 (Discontinued) | C2+ Rear Panel—2-Port (2 Deactivated) 3G SDI Card
	C2+ Video Card Backplane
	C3 (Discontinued) | C4 Rear Panel—8-Port 3G SDI Card
	C4 Video Card Backplane
	C4 Rear Panel—4-Port 12G SDI Card
	C4 Video Card Backplane
	C3 (Discontinued) | C4 Rear Panel—8-Port 3G SDI Card
	C5 Lightspeed Live Server Rear Panel—Dual 8-Port Card Set

	Power Requirements and Connections
	Power and General Cautions and Warnings


	Renaming a Lightspeed Live Server
	Managing the Windows Operating System
	Activating Windows with the Microsoft Activation Key
	Applying Microsoft Updates
	Default Windows User ID and Password
	Web App Ports and Windows Firewall Settings

	Maintaining a Lightspeed Live Server
	Performance Tuning a Lightspeed Live Server
	Setting Your NVIDIA GPU to TCC Mode
	Backing up a Lightspeed Live Server
	Managing and Monitoring Lightspeed Live Servers
	Installing New or Replacement Media Hard Drives
	Rebuilding the Lightspeed Live Storage RAID
	Replacing a Power Supply
	Replacing the Power Supply


	Setting NMOS Logging Levels
	Managing Live Capture Logging
	Accessing and Zipping Up Live Capture Log Files
	Zipping Up System Log Files
	Support Log Files
	SNMPLogs Folder
	SNMPLogs\traceLog Folder


	Managing Log File Logging Levels
	Accessing Logging Configuration Files



	Configuring Vantage and Updating Live Capture
	Overview
	Up and Running Checklist
	Installing your Server...
	In the Vantage Management Console...
	In Source Manager...
	In Vantage Workflow Designer...
	In Live Capture...

	Previewing Sources and Finding Workflows
	Previewing Sources
	Finding Workflows

	Using Live Stores for Capturing Files
	Creating a Live Store in Vantage
	Identifying Live Stores with a UNC Path
	Executing Transport Actions Using Local & UNC Paths
	Managing Live Storage Disk Space
	Rule-based Space Management
	Workflow and Job-based Space Management
	Manual Space Management


	Creating Labels and Variables for Use in Workflows
	Updating Vantage and External Systems with Variables
	Updating Vantage and External Systems with Metadata

	Updating Live Capture Software
	Updating Live Capture Web Apps on Windows Workstations
	Updating Live Capture
	NVidia/AJA Driver and Firmware Installation Steps

	Updating | Installing Live Capture Software
	Installation Steps


	Restarting the Telestream Live Source Service
	Firewalls and Blocked Ports Limit Functionality
	Creating a UNC Path for Resource Locations
	Configuring Various Actions on Arrays
	When Capturing to a Live Capture Local Media Drive
	When Capturing to Shared External Storage

	Scaling Live Capture with Multiple Servers
	Best Practices for Connecting Multiple Capture Servers to a Vantage Domain
	Joining Capture-Only Systems
	Existing Vantage Array—Adding Live Capture Servers
	Adding Services


	Providing Capture Sources Unique Names
	Best Practices for Capture Array Design
	Capture-only System
	Capture Array—Separate Vantage Database and IIS Web Servers

	Using Web Applications in a Capture Array
	Configuring Vantage Client Applications for Multiple Servers
	Using Vantage Desktop Client Applications

	Using the Live Capture Web App to Manage Multiple Servers

	Using NetBIOS Host Names
	Correcting Connection Errors in Web Apps
	Updating the hosts File on Mac OS
	Updating the hosts File on Windows

	Clearing Browsing Data after Updating Vantage or Live Capture

	Managing your Web Apps
	Web Application Browser Requirements
	Efficient Use of Capture Web Apps
	Launching Lightspeed Live Web Applications
	Launching the Source Manager Web App
	Logging Out of Source Manager

	Changing the Vantage Domain Name

	Capturing Live Video
	Using the Live Capture Web App
	Title Bar
	Selection Panel
	Channels Preview Panel
	Channel Previews Toolbar
	Configuring Single-Channel and Custom-Ganged Recording
	Channel Controls
	Channel Options
	Viewing a Channel’s Recording History
	Display and Information Panel

	Loss of Signal Behavior
	Limited Bandwidth Behavior

	Channel Status Panel
	Filtering Job Status

	Setting Recording Confirmation Preferences
	Starting Recording Confirmation
	Stopping Recording Confirmation


	Using Triggers to Control Channel Recording
	Topics
	Using DAI Triggers
	Using Manual Triggers
	Using Recurring Segment Triggers
	CalDAV Calendar Trigger
	Using Web Service Triggers

	Recorded File Location and Format
	Selecting Output Encoders and Format
	Delivering Secondary (Proxy) Output to AWS S3
	Deleting Captured Files

	Using the Vantage Job Status Views Web App
	Displaying Vantage Job Status Views
	Using the Vantage Job Status Views Web Application
	Configuring Job Status Views Information


	Capturing Tape Media
	Pre-requisites to Using Tape Capture
	Tape Capture Overview
	Configuring a VTR Connection
	Checking VTR Connection Status
	Troubleshooting the VTR Connection


	Tape Capture Controls and Status
	Selection Panel

	Checking on Job Status
	Filtering Job Status (Far Right)
	Using Vantage Tape Workflows
	Clip Panel
	Clip Logging
	EDL File Import and Export
	Capturing a Whole Tape
	Whole Tape Capture
	Primary Output Configuration
	Secondary Output Configuration

	Timecode Break Recording
	Tapes Panel
	Clip Log Panel
	Capturing Media
	Activate Capturing
	Monitoring Capturing


	Using the Preview Player Panel
	VTR Controls and Keyboard Shortcuts


	Using the Tape Capture Web App
	Setting up for Clip Logging
	Creating and Naming Tapes
	Creating a Clip
	Configuring Clip Stitching
	Capturing Clips
	Configuring Tape Parameters that are Bound to Variables
	Setting Drop/Non-Drop Frame Characteristics
	Creating a Stitched Clip
	Recording an Entire Tape—Even if It Has Errors

	Resolving Tape Capture Error Messages
	Loss of Signal


	Creating Live and Tape Capture Workflows
	Creating Live Capture Workflows
	Creating a Live Capture Workflow
	Capture Action Overview and Configuration
	Configuring Program Settings
	Restricting Input - Frame Type and Frame Rate
	Operation When Restrict Input is Enabled
	Automatic Triggers Record When Restrict Input is Enabled

	Expected Labels
	Configuring Trigger Settings
	DAI Triggers
	Default Start Behaviors for DAI Trigger
	Default Stop Behaviors for DAI Trigger

	Manual Triggers
	Recurring Segment Triggers
	CalDAV Calendar Triggers
	Web Service Triggers

	Using the CalDAV Calendar Trigger
	What Happens When a Queued Event is Deleted

	Configuring Primary and Secondary Outputs
	Delivering Proxy Media to AWS S3 Storage

	Creating Tape Capture Workflows
	Tape Action Overview
	Inputs
	Expected Labels
	Configuring Primary and Secondary Outputs
	Settings Panel
	Time Code Burn-in Filter
	Creating a Tape Capture Workflow
	Binding Variables to Configuration Controls


	Using Paths for Vantage Storage
	Prototype Capture Workflow—Labels & Variables
	Creating and Configuring the Media Creation Capture Workflow
	Summary


	Managing Video Sources
	Overview
	Using the Source Manager Window
	Sources Panel
	Toolbar
	Source Type Icons

	Preview Panel
	Viewing Audio Levels and Muting Audio

	Audio and Text Tracks Panel
	Source Information and Statistics Panel

	User Administration
	Launching the Group Portal
	Creating a Group
	Signing In
	Creating/Updating Live Capture Users

	Configuring Capture for SD/HD | UHD SDI Sources
	Configuring Live Capture for UHD Video
	Configuring Capture to Process SD/HD Video

	Enabling QuadLink Loop Through
	Port-Paired Loop Through Assignments
	For Servers with Four 3G SDI Ports
	For Servers with Eight 3G SDI Ports


	Configuring SDI Sources
	Creating & Configuring Transport Stream Sources
	Creating & Configuring RTMP Sources
	Tagging AC3 Audio Embedded in PCM

	Creating & Configuring SRT Sources
	Creating & Configuring NDI Sources
	Creating and Configuring ST 2110 Sources
	When NMOS is Disabled...

	Managing System Settings
	Manually Configuring NMOS Registration Settings
	Using External Reference (REF) for SDI Playout

	Version Info | Help | Documents | Contact Methods
	Troubleshooting
	Can’t Start the Group Portal Web App
	Resolution


	Lightspeed Live Server Resource Requirements
	Overview
	Balancing CPU Processor Group Affinities
	Use Source Manager to Manage Affinity Settings
	Managing Affinity on C1 | C2 | C2+ Servers
	Managing Affinity on C4 | C5 Servers

	Processes & Factors Affecting Performance
	Primary Output Codec
	Secondary Output codec
	Codec/Source Input Bit Depth
	Live Capture Web App
	Determining the Time-Shift Buffer Duration
	Standard Definition (SD) Codecs
	High Definition (HD) Codecs
	UHD/4K Codecs


	Capturing Uncompressed Media Via SDI
	Maximum Concurrent Captures
	Maximum Concurrent Captures for VM-based Live Capture

	Connecting VTR Systems
	4-Port Interface Kit Components
	Installing the RS-422 Interface Box
	Connecting a VTR to the Lightspeed Live Server
	RS-422 Connector Pin Assignments
	Configuring RS-422 Port Latency Time



